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Foreword
Welcome to Advanced Editing with DaVinci Resolve 16
DaVinci Resolve 16 is the only post production solution that brings editing, color correction, 
audio post, and visual effects together in the same software application! The most exciting 
thing about DaVinci Resolve 16 is the revolutionary new Cut page, which is designed 
specifically for editors that need to work quickly and on tight deadlines. It’s an alternate 
Edit page with a streamlined interface and new tools designed to help you work faster than 
ever before.

DaVinci Resolve 16 also includes even more advanced color correction, powerful new 
editing options on the traditional Edit page, vastly improved Fairlight digital audio tools 
and even faster 2D and 3D visual effects compositing on the Fusion page. DaVinci 
Resolve 16 enables you to switch between creative tasks without having to export or 
translate files between different applications!

Best of all, DaVinci Resolve 16 is absolutely free! Plus, we’ve made sure that the free 
version of DaVinci Resolve actually has more features than any paid editing system. That’s 
because at Blackmagic Design we believe everybody should have the tools to create 
professional, Hollywood caliber content without having to spend thousands of dollars.

I hope you’ll enjoy using DaVinci Resolve 16 and we can’t wait to see the amazing work 
you produce! 

Grant Petty  
Blackmagic Design
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Getting Started
Welcome to Advanced Editing with DaVinci Resolve 16, an official Blackmagic Design 
certified training book that teaches professionals and students how to get the most out of 
editing with DaVinci Resolve 16. All you need is a Mac or Windows computer, DaVinci 
Resolve 16, and a passion to learn about editing.

This guide blends practical, hands-on exercises with the aesthetics of editing to help you 
discover new techniques for whatever editing tasks you take on. You will learn new editing 
functions, trimming styles, and multilayered timeline capabilities. You’ll also go deeply into 
audio editing and mixing in the Fairlight page to explore techniques used by professional 
audio engineers to enhance the sound design in your projects.

After completing this book, you are encouraged to take the 50-question online proficiency 
exam to receive a Certificate of Completion from Blackmagic Design. The link is located 
on the DaVinci Resolve training web page: www.blackmagicdesign.com/products​
/davinciresolve/training
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About DaVinci Resolve 16
DaVinci Resolve is the world’s fastest growing and most advanced editing software. It also 
has a long history of being the world’s most trusted application for color correction. With 
DaVinci Resolve 16, Blackmagic Design has added an alternative editing page, called the 
Cut page. Designed specifically for editors working on commercials, news and other short 
form, quick turn around projects, the Cut page is all about speed.

What you will Learn
In these lessons you’ll work with multiple projects to learn advanced, practical techniques 
used in several editing genres. You’ll acquire real-world skills that you can apply to real-
world productions.

Lessons 1 and 2
Covers basic editing techniques in the Cut and Edit Pages.

Lesson 3
Reveals some of the most powerful features in Resolve’s Media page to help you more 
efficiently set up and organize projects. One exercise uses a People Smart Bin, only 
available in DaVinci Resolve Studio.

Lesson 4 and 5
Use two different film and television genres (a dramatic dialogue scene and a documentary 
interview) to teach you advanced editing techniques and trimming styles in the Edit page.

Lesson 6
Explores all the tools and techniques for multicamera editing in the Edit page.

Lessons 7 and 8
Focus on motion graphics and visual effects that, as an editor, you will commonly be asked 
to create. By using a variety of compositing, keying and tracking tools in both the Edit page 
and the Fusion page, you will produce professional-quality opening graphics and realistic 
composites.

Lesson 9
Takes you through a sound editing, design, and mixing workflow in the Fairlight page.

Lesson 10
Shows how to add subtitles and output a project with different sound mixes based on the 
audio work you did in Lesson 9.
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System Requirements
This book teaches DaVinci Resolve 16 for macOS and Windows. If you have an older 
version of DaVinci Resolve, you must upgrade to the current version to follow along with 
the lessons. Fortunately, DaVinci Resolve 16 is a free upgrade from previous versions of 
DaVinci Resolve. Lesson 2 includes one exercise which uses DaVinci Resolve Studio.

Downloading DaVinci Resolve 16
You can download the free version of DaVinci Resolve 16 from the Blackmagic Design website:

1	 Open a web browser on your macOS, Windows, or Linux computer.

2	 In the address field of your web browser, enter  
www.blackmagicdesign.com/products/davinciresolve.

3	 On the DaVinci Resolve landing page, click the Download button when it appears.

4	 Follow the installation instructions to complete the installation.

When you have completed the software installation, follow the instructions in the following 
section, “Copying the lesson files,” to download the content for this book.

Acquiring the Lesson Files
You must download two zipped editing lesson files to acquire the media files you’ll use 
while performing the exercises in this book. After you download and save the compressed 
files to your hard disk, extract both zipped files and copy them to a single R16 Editing 
Lessons folder that you create in your Documents folder.

To Download and Install the Two Lesson Files
When you are ready to download the two lesson files, follow these steps:

1	 Connect to the Internet and navigate to:  
www.blackmagicdesign.com/dvres/editing-with-resolve15-pt1.

The download will begin immediately.

The “R16 editing lessons pt1.zip” file is 4 GB in size, and depending on your Internet 
connection, should take roughly 15 minutes to download to your computer using a 
standard broadband connection.

2	 Download the second half of the lesson files by navigating to  
www.blackmagicdesign.com/dvres/editing-with-resolve15-pt2.

The “R16 editing lessons pt2.zip” file is 5.1 GB in size and should take roughly 25 
minutes to download to your computer using a standard broadband connection.
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3	 After downloading the zip files to your computer, open your Downloads folder, and 
double-click both zip files to unzip them (if your computer doesn’t unzip the file 
automatically).

4	 In the Documents folder, create a new folder called R16 Editing Lessons.

5	 From your Downloads folder, move all the .dra archives and folders contained in the 
two downloads into the R16 Editing lessons folder.

You are now ready to begin Lesson 1, “Editing Basics.”

The Blackmagic Design Learning Series
Blackmagic Design publishes several official certification books as part of the Blackmagic 
Design Learning Series. They include:

	� The Beginner’s Guide to DaVinci Resolve 16

	� Advanced Editing with DaVinci Resolve 16

	� Color Correction with DaVinci Resolve 16

	� Fusion Visual Effects with DaVinci Resolve 16

	� Introduction to Fairlight Audio Post with DaVinci Resolve 16

	� And more to come

Whether you want to learn more advanced editing techniques, color grading, or visual 
effects, certified training has a learning path for you. 

After completing this book, you are encouraged to take a one-hour, 50-question online 
proficiency exam to receive a certificate of completion from Blackmagic Design. 
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For more information on additional books in this series and Blackmagic Design certification 
training exam, visit www.blackmagicdesign.com/products/davinciresolve/training.

by Paul Saccone and Dion Scoppettuolo

Learn how to create Hollywood caliber digital film and  
video with the world’s most advanced editing, visual effects, 
color correction and audio post production solution!

Download
DAVINCI
RESOLVE
Free!

THE BEGINNER’S GUIDE TO

by Daria Fissoun

Learn how to use Hollywood’s most powerful color  
correction and grading solution to create incredible  
cinematic looks for your own digital film and video!

Download
DAVINCI
RESOLVE
Free!

COLOR CORRECTION
WITH DAVINCI RESOLVE 16

by Mary Plummer

Learn how to create Hollywood caliber soundtracks for  
your digital film and video with the Fairlight audio recording,  
mixing and mastering tools inside of Davinci Resolve!

Download
DAVINCI
RESOLVE
Free!

FAIRLIGHT AUDIO POST
WITH DAVINCI RESOLVE 16

by Damian Allen, Tony Gallardo and Dion Scoppettuolo

Learn how to create Hollywood caliber visual effects and motion 
graphics with the world’s most advanced editing, visual effects, 
color correction and audio post production solution!

Download
DAVINCI
RESOLVE
Free!

FUSION VISUAL EFFECTS
WITH DAVINCI RESOLVE 16

Getting Certified
After completing this book, you are encouraged to take the one-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link 
to this exam is located on the DaVinci Resolve training web page. www.blackmagicdesign.
com/products/davinciresolve/training.
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Time

This lesson takes approximately 
60 minutes to complete.

Goals

Cut Page Overview	 2

Cutting the Interview Together	 3

Syncing Angles in the Cut Page	 7

Source Overwriting Different Angles	 10

Adding the B-Roll	 16

Building the Intro Sequence	 18

Tidying Up The Interview	 24

Using Source Tape to Add Cutaways	 26

Adding Graphics and Adjusting Clips	 35

Adding Music	 38

Applying Transitions and Effects	 41

Finishing the Edit	 43

Taking Advantage of Other Pages	 43

Editing faster with the DaVinci 
Resolve Editor Keyboard	 44

Lesson Review	 47

Editing is so central to cinematic storytelling 
that director Francis Ford Coppola once 
said, “The essence of cinema is editing.” 
This book explores the essence of cinema 
through the deep and powerful editing 
features found in DaVinci Resolve as 
applied to the art and craft of editing and 
storytelling. 

So, whether you are working to cut the 
latest cinematic blockbuster, a fast-turn-
around commercial spot, an episodic TV 
show or an entire web series, the tools and 
technology available to you in DaVinci 
Resolve, together with the techniques 
discussed and demonstrated throughout 
this book, will help you achieve your vision.

To begin, you will begin your editing jour-
ney in DaVinci Resolve’s Cut Page.

Lesson 1

Editing in the 
Cut Page
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Cut Page Overview
The new Cut page in DaVinci Resolve 16 is ideal for fast turnaround jobs that must be 
edited and published quickly, such as news features, video blogs, online promos, and 
educational content. It is also the fastest way to edit a multicamera interview as you will 
do in this lesson.

In designing the Cut page, Blackmagic Design developed an interface that removes 
anything that could slow you down. Every click or action on the Cut page has a direct 
result. There are no wasted clicks or optional settings to configure.

The interview you will use in this lesson was captured using two cameras. With the Cut 
page, it is amazingly fast to synchronize the two camera angles, edit between them and 
quickly add cutaways.

The Cut Page provides a slimmed-down and intuitive editing interface to allow you to focus 
on your work and cut quickly.

Media Pool Viewer
Transport 
Controls

Lower 
Timeline

Upper 
Timeline

Editing 
Functions

Timeline 
Controls

The Media Pool is where you can import and organize clips used in your project. A pop-up 
menu allows you to quickly create or switch between different bins.

The Viewer has three different modes: Source for viewing individual clips from the Media 
Pool; Source Tape for viewing the contents of the Media Pool as a virtual “tape”; and 
Timeline for reviewing your current edit.
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The Upper Timeline displays a birds-eye view of the entirety of your current timeline, which 
is useful for navigating the specific parts of your edit.

The Lower Timeline displays a zoomed-in portion of your timeline at the current playhead 
position, and is useful for performing detailed editing tasks such as trimming.

The editing buttons provide quick access to functions such as Smart Insert, Source 
Overwrite and other commonly used Cut Page functions.

The Timeline Controls provide options for enabling or disabling timeline functions such as 
the lower timeline’s fixed playhead, Snapping, track mute, etc.

Cutting the Interview Together
To begin this lesson, you’ll use a project that contains an interview recorded from two 
different angles. The interview is with a bicycle shop owner named Sasha from the shop 
Citizen Chain. You will start by restoring the archived project and editing a basic interview.

1	 Open DaVinci Resolve 16

2	 In the Project Manager, right-click and choose Restore Project Archive.



4
Le

ss
o

n
 1

 
E

d
it

in
g

 in
 t

h
e 

C
u

t 
P

ag
e

3	 Navigate to R16 Editing Lessons > Lesson 01 Cut Page > Lesson 01 Cut Page.dra and 
click Open.

The archive is restored and the project becomes available in the Project Manager.

4	 Double-click the project Lesson 01 Cut Page and, if necessary, switch to the Cut page.

This project contains one timeline and a couple of bins in the Media Pool.
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5	 Double-click the Interviews bin, then double-click each clip to open then in the Source 
viewer and review them.

Obviously, these clips are of the same interview. However, unlike most traditional 
multicamera editing, you do not have to create a special multicamera clip to begin 
editing in the Cut page. You can work with the individual clips as you see fit and cut in 
different angles later, using specific editing functions found only in the Cut Page. Using 
this method means you can choose to cut the material in whichever way makes sense 
to you as Resolve doesn’t dictate the way you work.

NOTE  You will follow a more traditional multicamera workflow in the Edit Page 
in Lesson 06 of this book. 

6	 Double-click the Interview_01_CAM01.mxf clip to open it in the viewer.

7	 In the source viewer, press I to set an in point just before Sasha says, “I was a big fan of 
Orson Welles.” (around 03:22:40:00.)

Play the clip and listen to Sasha’s serendipitous story
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8	 Press O to set an out point after Sasha says “Rosebud was a bicycle” (around 
03:23:00:00).

9	 From the viewer, drag the clip into either the upper or lower timeline or press the 
Append edit button.

The marked clip becomes the first clip of your story. The viewer switches automatically 
to show you the clip in the timeline.
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NOTE  There are no timeline zooming functions in the Cut Page. Instead, having 
the entire story always visible in the upper timeline makes it incredibly easy to 
move around, no matter how long the edit may be. The lower timeline shows a 
zoomed-in, detailed view of the current position and is useful for detailed trimming 
and refining. By default, the playhead in the lower timeline always remains in the 
center while the timeline scrolls under it unless you click the Free Playhead button. 
Editors used to the playhead function of the Edit Page may prefer this option.

Now that you have the first part of the interview in your timeline, it’s time to edit in 
the second camera angle.

Syncing Angles in the Cut Page
Currently, you have a simple story in which a shop owner explains the inspiration for his 
business’s name, but the director would like it to flow a little better. Thankfully, because 
more than one camera was used to record this interview, you can cut between the cameras 
instead of sticking with a single shot for the entire interview.

When you start cutting in different angles of the interview, accurately establishing the sync 
relationship between the multiple cameras is critical. Creating that relationship between the 
camera angles is incredibly easy, even after you’ve started editing, using the Sync Clips 
window in the Cut Page.

1	 In the Interviews bin, select Interview_01_Cam01.mxf and CMD-click (macOS) or 
CTRL-click (Windows) Interview_02_CAM.mxf, then click the sync clips button to 
display the Sync Clips window.
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The Sync Clips window displays a live multicamera sync viewer to the left and a 
standard clip viewer to the right. The timeline view shows the current sync relationship 
between the clips in the current bin and you can use various options to align the clips.

2	 Drag the red playhead in the Sync Clips window across the two clips.

As you drag, the live multicamera sync viewer displays the two camera angles in 
different viewers, one for each camera.

By default, the Sync Clips window is set to attempt to sync the selected clips by 
timecode but, because these two clips have very different timecode numbers, they 
appear separated in the timeline view.

Above the timeline, four buttons represent the four options for syncing the clips; 
timecode, audio, in point or out point. Because the clips you are using do not have 
matching timecodes, you can use the audio recorded by each camera to align the clips.

3	 Click the Audio button, and then click the Sync button to sync the clips based on the 
audio of each clip.
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After a quick analysis of the two clips, the audio waveforms are aligned, syncing the 
two clips.

TIP  You can manually adjust the syncing of the clips by disabling the sync lock 
button for the selected camera in the right-hand viewer and dragging each clip 
to the appropriate position on the sync clips window timeline. Click the play 
button under the standard viewer to review the synced clips.

4	 After reviewing and confirming the sync accuracy, click the Save Sync button in the 
lower-right corner of the window to save the sync relationship and close the window.

The clips in the bin now show a sync badge in the upper-left corner to indicate that the 
clips are synchronized.

NOTE  If you create multiple synchronizations of different clips in the same 
project, these sync badges will display different colors to show you which clips 
are synced together.

Cropped out 
bottom for fit. 
Okay?
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Source Overwriting Different Angles
The few steps you performed to synchronize the two camera angles means it is now easy 
to cut in a different camera angle at any time without manually searching for the correct 
sync point each time. To take advantage of these synced clips, you’ll use the Sync Bin.

1	 In the upper timeline, move the playhead to the start and play the interview until just 
before Sasha says “I appreciated the pun…”.

TIP  You can use the lower timeline to pinpoint the start of this line by using the 
waveforms as a guide to positioning the playhead.

2	 Above the Media Pool, click the Sync Bin tab.

The Sync Bin displays the clips based on the sync relationship that you previously 
created. The two camera angles in the bin match the current timeline location, almost 
like an automatic match frame function

3	 Drag the timeline playhead backward and forward over your program to see the 
synced camera angles update in the viewer.
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The two clips in the Sync Bin start and stop based on the current timeline playhead. 
The viewer displays a multiview of all the synced camera angles, highlighting the one 
currently used in the timeline.

4	 If necessary, reposition the timeline playhead at the start of Sasha’s line “I appreciated 
the pun….”

You will now select a new angle to edit in the timeline using a special Cut Page editing 
function called Source Overwrite.

5	 In the viewer, click camera 2, or press 2 on your keyboard, to select the second 
camera angle.

The in point of camera 2 is automatically set to match the current timeline location. The 
out point uses a default five-second duration. 

In the toolbar, click the source overwrite button.
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Source overwrite adds the new camera angle on top of the existing video track. 
Because the source overwrite is specifically designed to take full advantage of the 
synchronized clips, the angles line up perfectly and the action remains in sync. 

Now you are ready for the next source overwrite.

6	 Click the Timeline button at the top of the Viewer. 

7	 Play the timeline until after Sasha says “…by certain course of events…”.

8	 Click the Sync Bin button to view your synchronized clips, and select camera 2, or 
press 2 on your keyboard.

9	 In the toolbar, click the source overwrite button.

10	 In the lower timeline, trim the end of the new clip on track 2 so that it snaps to the end 
of the clip on track 1.

No matter whether you are dealing with two angles or ten, the beauty of the Sync Bin 
and source overwrite is that you can see all the shots at the same time in perfect sync 
and pick whichever you like best and edit in to the timeline just the portion you need.

Cropped out top 
and bottom for fit. 
Okay?
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Muting Audio on Clips
The audio from the side angle is combined with the audio from the master interview clip, 
making them much louder. Since the audio is identical, we only need to hear audio from the 
original clip on video track 1.

1	 Move to the start of the timeline.

2	 Play over the side angle clips on video track 2 and listen to the audio carefully.

The audio is significantly louder when the side angle is onscreen because the audio 
from the two tracks is combined. You can mute the entire audio track or mute just 
selected clips in the timeline.

3	 In the upper timeline, select the two side angle clips on Track 2.

4	 In the lower timeline, right-click the selected clips and choose Mute.

In the lower timeline, a mute icon appears on each of the muted clips to indicate their 
audio will not be played.

Cropped out top 
and bottom for fit. 
Okay?
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5	 Move the playhead back to the start of the timeline and play to hear the improved audio.

TIP  You can also mute the audio on a whole track if you prefer by clicking the 
mute button in the header for the appropriate timeline track.

Adding a couple more interview clips will further the story along.

6	 From the Media Pool, double-click Interview_01_CAM_01.mxf. 

7	 Type +22000 on your keyboard and press Enter to move the playhead 2 minutes and 
20 seconds from the out point.

8	 Play the interview from this point and stop playback just before Sasha says “Well, here 
at Citizen Chain…” (around 03:25:29:00).

9	 Press I on your keyboard to add the new in point.

10	 Continue playing the interview and stop after Sasha says “… other bike shops have 
refused to fix” (around 03:25:36:00).

11	 Press o to add the out point.

12	 Click the Append edit button.
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13	 Play forward until just before Sasha says “A lot of the bikes in our garages…” (around 
03:26:13:00) and add the In point.

14	 Continue to play the interview until after Sasha says “…malfunctioning and make them 
work again” (around 03:26:25:00) and set the out point.

15	 Press Shift-F12 to make the Append the clip to the timeline.

16	 In the upper timeline, move the playhead about halfway through the middle clip on 
Track 1 (after the second clip on Track 2) just after Sasha says “…challenging bikes” but 
before he says “We’ll fix older bikes…”

This is where the director wants to add another instance of the second camera angle.

17	 Click the Sync Bin button, press 2 on your keyboard to select the second camera 
angle, then click the Source Overwrite edit button.

18	 Using the lower timeline, trim the end of the new clip on Track 2 back so it snaps to the 
edit point on Track 1.

19	 Don’t forget: mute the audio of this new clip.
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20	 Switch back to the Timeline viewer and review the edit.

And that’s how easy it is to sync and edit multiple camera angles in DaVinci Resolve’s 
Cut Page!

Adding the B-Roll
To introduce and begin to flesh out this interview with Sasha, let’s use some footage of him 
arriving at the bicycle shop. 

1	 Click the Media Pool bin list button in the top left corner and select the Arriving bin to 
switch to that bin.
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2	 At the top of the Media Pool, switch to the Filmstrip View.

This bin contains four clips of Sasha arriving at the Citizen Chain bike shop.

3	 Double-click the clip Rosebud_Sticker.mxf to open the clip in the source viewer and 
move your mouse back and forth across the film strip to scrub and preview the clip.

This clip will provide a nice punchline and reinforcement to Sasha’s revelation that 
Rosebud was a bicycle.

4	 In the filmstrip, move your mouse to the point about halfway through the clips where 
there is a waveform display of the bike lock being fastened.

5	 Press I to add the in point (around 21:06:54:00).
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6	 Play the clip and add the out point a couple of seconds later after Sasha has exited 
the frame.

You will now quickly insert this clip into the timeline.

7	 Using the upper timeline as a guide, drag the clip from the viewer or Media Pool to the 
edit point on Track 1 just after the second clip on Track 2.

The Timeline opens out and the new clip is automatically inserted into the correct place! 

8	 In the upper timeline, move the playhead back to the start of the second clip on Track 2 
and preview your new edit.

Excellent! Now you’re getting a sense as to how fast and easy it can be to use the Cut Page 
for your editing.

Building the Intro Sequence
Now it’s time to build a short intro sequence for this edit to introduce Sasha and the shop 
(and also to feature a cameo from Sasha’s dog Orson). Along the way you’ll learn just how 
fast it can be to work with the Cut Page.
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1	 In the upper timeline, move your playhead near the start of the edit.

Unlike the Edit Page, in the Cut Page you don’t necessarily need to position the 
playhead exactly where you want to make your edit.

If you look in the lower timeline, you’ll notice a small triangle pointing towards the edit 
point nearest the current playhead position. This animated triangle indicates the point 
where the next edit will automatically be placed.

2	 In the Media Pool, select all the clips except the Rosebud sticker clip you’ve 
already used.

3	 Click the Smart Insert edit button.

As with the Edit Page, editing the clips directly from the Media Pool in this manner 
places the clips in the timeline in the order they are sorted in the bin. These clips 
now need trimming and reordering to make sense.
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4	 Using the upper timeline, play through the opening clip and stop as you see Sasha 
approach from behind the tree.

5	 Click the Split Clips button just above and to the left of the upper timeline.

The Split Clips command cut the clip at the position of the playhead.

6	 In either the upper or lower timeline, select the clip to the left of the new edit point and 
press Delete (Backspace) to remove the clip.

The timeline automatically ripples to accommodate the change in duration.
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7	 Play through the clip for a few seconds until Sasha is roughly level with the Citizen 
Chain shop window.

8	 In the lower timeline, right-click the top of the playhead and then click the Split Clips 
button to add another edit.

9	 Select the clip after this new edit and press Delete (Backspace) to remove the excess 
material from the timeline.
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10	 Play the next clip in your timeline and stop your playhead at the point when Sasha is 
about halfway into the frame.

11	 Press Cmd-B (macOS) or Ctrl-B (Windows) to split the clip.

12	 Select the clip to the left of the new edit and press Delete (Backspace) to remove the 
unwanted portion of the clip from the timeline.

13	 Play the remaining part of this clip until just before the camera is moved and the 
shot wobbles.
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14	 Using the lower timeline to trim the end of the clip to remove the wobble at the end of 
this shot.

TIP  You can use whichever timeline you prefer to select, remove and trim the 
clips. Remember, the two timelines are actually the same timeline with two 
different but simultaneous views of your edit. The upper timeline is most useful 
for seeing a birds-eye-view of your edit and is often easiest for moving the 
playhead to different parts of your edit; the lower timeline, with its closer view, 
is most useful for performing detailed trimming.

15	 Play the third clip, and choose your preferred method for removing the beginning of 
this shot up to the point when Sasha cycles into shot.

16	 Remove the end part of this shot after Sasha has left frame.

Now you’ll need to reorder the shots to make the edit make more sense. It’ll be easier 
to do this using the zoomed-out view of the upper timeline.
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17	 In the upper timeline, select the third clip and drag it back to the edit point between the 
first and second clips.

The clips instantly swap positions meaning the edit makes much more sense now! 
However, feel free to further refine the edit points between these opening shots until 
you are happy with the pacing of the cuts. Simply select the beginning or end of a clip 
and drag to automatically ripple trim the clips, or select the middle of the edit for a roll 
trim. No need to select a special Trim Edit Mode as in the Edit Page – the Cut Page is 
designed for fast and intuitive editing!

TIP  You can also use the keyboard shortcuts , (comma) and . (period) you’ll 
learn about in later lessons to trim the selected edits one frame at a time left or 
right respectively. Use Shift-, (comma) or Shift-. (period) to trim 5 frames. This 
can be adjusted in the DaVinci Resolve > Preferences > User > Editing section 
under “Default fast nudge length”.

Tidying Up The Interview
Now you have seen just how easy it is to edit and trim clips in the Cut Page, it’s time to tidy 
up the edited interview a little. The director just wants a few lines taken out to make the 
story a little more succinct. This is yet another job for which DaVinci Resolve’s Cut Page is 
ideally suited.

1	 In the upper timeline, play through the first interview clip and stop the playhead at the 
point just after Sasha says “I was a big fan or Orson Welles…”
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2	 Press Cmd-B (macOS) or Ctrl-B (Windows) to split the clip.

3	 Move the playhead to the beginning of the clip on Track 2. This is just before Sasha 
says “I appreciated the pun….”

4	 Again, press Cmd-B (macOS) or Ctrl-B (Windows) to split the clip again.

5	 In either the upper or lower timeline, select the clip you just split and press Delete 
(Backspace).

6	 Press / (forward slash) to review the edit. If necessary, tidy up the edit to make it 
sound natural.

7	 Press down arrow to move the playhead to the end of the clip on Track 2.

8	 Press I to add an in point to the timeline.
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9	 Play forward until just before Sasha says “And then only after….” And press O to add an 
out point.

10	 Press Delete (Backspace) to remove this portion of the timeline.

11	 Continue playing the interview and set an in point after Sasha says “only after we 
named the shop…”

12	 Set an out point just before Sasha says “we found out that Rosebud…”

13	 Press Delete (Backspace) to remove this unwanted section of the interview.

As you can see, the Cut Page automatically trims and keeps everything in sync for you as 
you are working, keeping everything simple means you can work quickly and with 
confidence as you continue to craft your story.

Using Source Tape to Add Cutaways
To dress up this interview further, you’ll use a few clips of Sasha at work in the shop over 
the later part of his interview. These types of additional clips are often called cutaways 
because you are cutting away from the primary interview to show related but different 
images. Firstly, you will import these clips directly in the Cut Page.
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1	 Using the bin list in the Media Pool, select the Master bin.

This will be where you want to add the new bin.

2	 At the top of the Media Pool, click on the Import Media Folder button. 

3	 Navigate to DaVinci Resolve > R16 Editing Lessons > Lesson 06 Cut Page > Additional 
Media > Working and click Open.

This Imports the folder as a bin and the contents inside the folder.
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4	 Open the Media Pool bin list, select the Working bin and switch to list view.

5	 In the Sort menu to the right of the Media Pool search box, ensure that you are viewing 
the media sorted by Timecode and Ascending so that earlier timecode values are 
towards the top of the list.

TIP  You can use the column headers to sort your media in List view just as you 
can do elsewhere in DaVinci Resolve. Right-clicking the column headers allow 
you to choose which metadata you’d like to view.

6	 In the upper timeline, move your playhead near the edit between the Rosebud sticker 
clip and the interview clip which starts “Well, here at Citizen Chain….” Ensure the 
animated arrow is pointing to this edit point.

Cropped out 
bottom for fit. 
Okay?
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7	 Switch the viewer to Source Tape.

Source Tape is yet another trick that the Cut Page has up its sleeve as it displays the 
contents of the selected bin as a single virtual clip arranged in the order in which the 
bin is sorted, with each clip separated by vertical white lines. This means it’s as easy as 
scrubbing through a single (albeit long) clip to review the entire contents of the bin. 

8	 Drag the playhead through the Source Tape viewer.

Notice how the clips are highlighted in the bin as you scrub over them to let you know 
which clip you’re currently viewing.
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9	 Return the playhead to the start of the viewer and click the Fast Review button.

Fast Review plays through the clips in the Source Tape viewer so you can quickly 
review the entire contents of the bin, with longer clips being played faster than shorter 
clips. As you can see from the Fast Review, there are a number of clips offering a 
multitude of choices for our cutaways.

10	 Move the playhead back over the first shot in the viewer.

11	 Play through the first clip in the viewer until you see Orson, Sasha’s dog, appear in 
shot. Press I to set an in point here.
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12	 Play through the shot until Sasha walks out of frame and press O to set the out point.

13	 Click the Place on Top edit button.

The clip is edited on a new track, starting at the nearest edit point.
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14	 Switch to the timeline and play through until just Sasha says “a lot of the bikes that are 
in our garages…”

Notice how the animated arrow designates the edit nearest the playhead as the default 
edit point. However, it’s easy to let Resolve know you don’t want the newly edited clip 
to start there.

15	 Press I to add an in point to your timeline.

A new red arrow appears on the lower timeline at the position of the in point to indicate 
that this is now the position the new clip will be added

16	 In the timeline track header, click to select Track 2.
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17	 Switch to Source Tape in the viewer and use the Next Edit button below the viewer to 
navigate to the start of the fourth clip in the bin; the clip called Bike_Pick_up.mxf.

18	 Play through the clip until just before Sasha picks up the bike and press I to set an in point.
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19	 Continue to play the clip and press O to set an out point when Sasha and the bike are 
safely out of frame.

20	 Press F12 to perform a Place On Top edit.

21	 In the Source Tape viewer, move to the next shot (Pedal_Crank_On_Stand.mxf ) and 
set an in and out point for a duration of about 3 seconds around the middle of the clip 
when the director is not talking.

22	 Press F12 to make another Place On Top edit.

23	 Press the Down Arrow key on your keyboard twice to move two clips down the 
source tape.

This is a shot of Sasha looking at the bike gears.

24	 Again, set an in and an out point for about 3 seconds somewhere near the beginning of 
this shot where Sasha is looking at the bike gears.

25	 This time, drag the clip from the viewer to the upper or lower timeline so that it snaps to 
the end of the clip on Track 2

As you can see, the Source Tape is a powerful way to quickly work through a large amount 
of material to quickly review, select and edit together the shots you need.
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Adding Graphics and Adjusting Clips
The director wants to include a graphic of the Citizen Chain bike shop by way of an 
introductory title to this video. 

1	 In the Media Pool bin list, select the Logo bin in the Media Pool.

2	 Ensure your timeline playhead is on or near the beginning of the first clip.

3	 Click the Track 1 header in either the upper or lower timeline.

4	 Select the CC-logo.png file in the Media Pool and click the Smart Insert button.
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5	 In your preferred timeline, trim the new graphic clip to 3 secs duration in the timeline.

To add some visual interest to this graphic, you will enable the dynamic zoom function 
for this clip which will apply an automated animation.

6	 Place the playhead over the first clip in your timeline and click the Tools button below 
the viewer.

The tools icon bar opens below the viewer giving you quick access to adjustments you 
can make to the selected timeline clip(s). If no clips are selected, the topmost clip at the 
playhead position is automatically selected for adjustment.

7	 Click the Dynamic Zoom button to reveal the controls.

To work with Dynamic Zoom, you first need to turn it on for the clip.
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8	 On the far left of the Dynamic Zoom controls, click the enable button to toggle the 
switch.

The Dynamic Zoom animation is applied to the graphic, but it begins slightly too close 
to the text for the director’s liking.

9	 Using the on-screen handles, adjust the size of the green starting box to make it 
slightly larger.

Finally, you will adjust the animation so it comes to a natural rest on-screen.

10	 Click the Ease Out button to adjust the ending speed of the animation.

11	 Click the Tools button to close the tools bar and review your new animated graphic
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NOTE  The Cut Page Tools contain controls for a number of different ways to adjust 
clips, including Transform, Crop, Speed, Stabilizer, Dynamic Zoom and Composite 
Modes (which also includes an opacity slider).

Further, additional controls are also available for text clips or for clips with effects 
applied, both of which give access to the Inspector from the Edit Page.

Adding Music
To add a bit more flavor to this edit, the director wants to add some music.

1	 Open the Media Pool Bin List and select the Music bin. Double-click the Awakening.
wav audio file to open it in the source viewer.

This an uplifting piece of music that will work well with the Citizen Chain footage you’ve 
been editing, but the director doesn’t want to use the opening section.
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2	 Play the music clip until the intro section finishes (around 7 seconds into the track) and 
set an in point.

3	 Drag the marked clip from the source viewer to the start of the upper timeline, but 
below all the other clips as audio always goes below video in the timeline.

The music is comically long for the current duration of this edit.

4	 In the upper timeline, place the playhead at the end of the last video clip, select the 
music track and press Cmd-B (macOS) or Ctrl-B (Windows) to split the clip.

5	 Select the unwanted portion of the audio clip and press Delete (Backspace).

6	 Return the playhead to the start of the timeline and play back the intro to see how the 
music works.

The music seems to work well, but it is way too loud!!! Check out how it’s bending 
those meters! More to the point, when Sasha start talking you can no longer hear what 
he says. You need to adjust the audio level of this clip.
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7	 In either timeline, select the audio clip and click the Tools button under the viewer.

As the selected clip is an audio-only clip, the Audio control is selected automatically. 

8	 In the timeline, play the start of the interview and use the volume slider to adjust the 
level of the music so that you can clearly hear Sasha.
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NOTE  Unlike the Edit Page, there is no indictor as to how much you are adjusting 
the audio levels by. The easiest way is to play the audio back and adjust the level 
using the audio meters and you ears as a guide. Part of the philosophy of the Cut 
Page is to allow you to concentrate on the content you’re working on rather than 
the minutia of settings and values.

Applying Transitions and Effects
No edit would be complete without some carefully placed transitions. The Cut page has all 
the same transitions that are found in the Edit page Effects Library, but it also has buttons in 
the toolbar to switch between straight cuts, cross dissolves and smooth cuts. 

NOTE  You will work with the Smooth Cut transition specifically in a later lesson on 
the Edit page.

1	 In the upper timeline, move the playhead to the start of the timeline.

2	 In the toolbar, click the cross dissolve button to add a fade-up to the opening graphic.

3	 In either timeline, select the next edit point at the end of the opening graphic and press 
Cmd-T (macOS) or Ctrl-T (Windows) to add the standard cross dissolve transition.

Cropped out 
bottom for fit. 
Okay?
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TIP  To access the full range of transitions and effects available in 
DaVinci Resolve’s Edit Page and Color Page, open the Library using the 
Transitions, Titles, and Effects buttons above the Media Pool.

4	 To fade the music out, select the edit point at the end of the music in the upper timeline 
and press Cmd-T (macOS) or Ctrl-T (Windows) to add an audio-only transition.

5	 In the lower timeline, drag the left edge of the transition to increase the transition’s 
duration to 2 seconds.

TIP  If you want to adjust the volume level of the audio so it ducks lower when 
Sasha is speaking you can split the clip, set the levels either side of the edit 
and apply an audio cross fade transition to the edit point.
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Finishing the Edit
Excellent! Now you’ve seen how the Cut Page can be used to put together even complex 
edits in an intuitive and flexible way, it’s now time for you to finish the edit.

1	 Add the final part of Sasha’s interview, starting at the point where he says “Bicycles 
have stories to tell…”

2	 Trim and tidy up the interview as you see fit.

3	 Add any lines from the second camera angle from the Sync Bin you think are necessary.

4	 Use Source Tape to view the footage in the Riding bin and add anyway cutaways you 
think are appropriate to illustrate the last part of Sasha’s interview.

5	 Finally, extend the music to cover the entire length of the edited piece.

Taking Advantage of Other Pages
Hopefully, this lesson has shown you how the Cut Page can be used to enhance your 
editing in an intuitive and efficient way. However, it is still worth remembering that the Cut 
Page is still  part of DaVinci Resolve. It acts as an alternate Edit page with a streamlined 
interface and new tools that help you work faster; but you can always switch to the Edit 
Page to use the industry-recognized editing functions there to further refine your timeline; 
or switch to the Color page to refine the look of a project; or go to the Fairlight page to mix 
surround sound. That is the power of working in DaVinci Resolve: you have all the speed to 
get jobs done faster, and you still have all the control to make it look and sound like a 
multimillion dollar Hollywood blockbuster!
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Editing faster with the DaVinci Resolve 
Editor Keyboard

The DaVinci Resolve Editor Keyboard is designed for professional editors who need to 
work faster and turn around work quickly. More than just a simple keyboard, the DaVinci 
Resolve Editor Keyboard has been designed as an alternative way to edit that’s much faster 
than using a mouse because you can simultaneously use both hands at the same time: 
your right hand controls the position in a clip or timeline, while your left hand can be setting 
in and out points and applying edits. 

Dedicated controls for editors
The DaVinci Resolve Editor Keyboard has dedicated keys for the edit modes and other 
functions on the Cut page, so you can quickly access functions such as Smart Insert, 
Append, Close Up and Place on Top.

The “F-keys” along the top of the keyboard allow you to access functions such as Sync Bin, 
inserting black clips, adding transitions, performing video-only or audio-only edits – all with 
a single key press.
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A dedicated number keypad allows you to quickly enter timecode values – and includes a 
helpful “00” key – as well as keys specifically used to sort the contents of you bins by 
timecode, camera metadata, date and time or clip name.

The integrated jog and shuttle wheel built into the keyboard enables an accurate way of 
scrubbing clips or scrolling up and down the timeline. Buttons above the wheel allow you 
to quickly switch between source tape and the timeline for playback.
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To make editing even faster, you can also use the keyboard for trimming. You can press 
and hold trim buttons below the in and out keys while using the search dial to accurately 
adjust edit points. The search dial is big, so trimming is very accurate and very fast! As you 
saw in the tutorial, the transition selection buttons have dedicated keys that let you change 
between a cut, dissolve and smooth cut, instantly. That lets you scroll down the timeline 
while adding and removing dissolves extremely fast.

Everything about the Cut page and the DaVinci Resolve Editor Keyboard have been 
designed for speed. It’s an incredibly fast way to complete an edit and post it in just a 
few minutes!
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Lesson Review
1	 In the Cut page, which editing function is used to edit in a different angle of a 

synchronized clip?

a)	 Smart insert

b)	 Overwrite

c)	 Source overwrite

2	 True or False? The Cut page has three transitions: cut, cross dissolve, and smooth cut.

3	 True or False? Once you select the trim mode in the Cut page, you can ripple trim 
any edit.

4	 True or False? Clips edited in the Edit page using Edit page-specific functions such 
as fit-to-fill or replace, do not appear in the Cut page.

5	 What piece of hardware has been designed to make working in the Cut Page 
even faster? 

a)	 The DaVinci Resolve Editor Keyboard

b)	 The DaVinci Resolve Quick Keyboard

c)	 The DaVinci Resolve Keyboard Extension
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Answers
1	 c) Source Overwrite is the only edit function in the Cut page that takes advantage of 

synchronized clips.

2	 False. The transitions browser includes all the same transitions as the Edit page. Cut, 
cross dissolve and smooth cut are the only transitions on the toolbar.

3	 False. There is no trim mode in the Cut page. When you trim any clip on Track 1, this 
will automatically ripple the timeline. Any clip trimmed on any other track will not ripple 
the timeline.

4	 False. All clips added in the Edit page or the Cut page appear in the alternate page.

5	 a) The DaVinci Resolve Editor Keyboard.
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The Cut Page is a great place to begin 
editing with its intuitive controls and direct 
approach to arranging footage on a time-
line. However, when you are ready to tackle 
something that requires a little more consid-
eration, or if you need some more refined 
or sophisticated tools, then the Edit Page 
should be the place you head to in DaVinci 
Resolve 16.

The Edit Page supports the approach to 
non-linear editing that has been bat-
tle-tested by editors around the world for 
decades. In this lesson you will learn those 
techniques so you can apply them to your 
own editing workflows. Remember, how-
ever, that the Cut Page and Edit Page are 
not mutually exclusive; you can switch back 
and forth between these pages just as 
easily as you can for any page throughout 
DaVinci Resolve 16, and take full advantage 
of each page’s individual strengths.

Lesson 2

Editing in the 
Edit Page
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NOTE  This chapter assumes you have downloaded the media for this book. If you 
are unsure, return to the Getting Started section and follow the download 
instructions in “Getting the Lesson Files”.

Setting Up a Project
Editing is often an iterative process that requires you to build a coherent story from 
disparate pieces of footage. Whilst there are many recognized workflows to putting these 
sounds and pictures together, unfortunately there is no “magic bullet” as every cut has its 
own unique considerations.

With that said, let’s start building a short trailer for an upcoming documentary entitled “Age 
of Airplanes” by Brian J. Terwilliger so you can appreciate some of the thought processes 
and happy accidents that often occur in editing suites around the world.

1	 Open DaVinci Resolve.

The first window you see will be the Project Manager. Naturally enough, this is where 
you can sort, organize, backup, import, and restore the individual DaVinci Resolve 
projects you work on.
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NOTE  If you’ve been using DaVinci Resolve, you may have a number of 
projects in the Project Manager already. Feel free to create a new folder in the 
Project Manager for the projects you’ll be using throughout this book.

You will begin this lesson by opening a project archive in which all the media was 
imported and bins were already created. In later lessons you will learn the power of 
the media page for this purpose.

2	 Right-click any empty place in the Project Manager, and choose Restore Project Archive.

3	 In the system file window that appears, navigate to R16 Editing Lesson folder, and 
select Lesson 02 Review.dra.

4	 Click Open to add the archived project to the Project Manager.

5	 In the Project Manager, open the Lesson 02 Review project.

Your new project opens in DaVinci Resolve on the page last used in the application.

6	 If necessary, click the Edit page button, and then select Workspace > Reset UI Layout 
to reset the Edit page workspace to the default configuration.

Interface Toolbar—for revealing 
and hiding the various panels  

on the Edit Page

Toolbar—for accessing 
commonly used edit 

modes and other 
timeline options

Source Viewer—for reviewing 
and marking up your unedited 

source media clips

Timeline—for structuring 
and arranging the  

edited clips

Media Pool—for 
accessing the source 

media clips for the 
selected bin(s)

Timeline Viewer—
for reviewing the 

edited media

Bin List—for 
organizing your 

source media clips

Before you begin editing with the clips in this project, you’ll make a new bin where you 
will keep your edited timelines.
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7	 In the bin list, select the Master bin. Choose File > New Bin, and name the new 
bin Timelines.

This quick Edit page review lesson only requires these four bins, but there’s nothing 
stopping you from creating as many or as few bins that you think you’ll need to be organized. 
Feel free to review the footage and create as any additional bins as you require. You can 
also create bins within bins too by making sure you’ve got an existing bin selected before 
you choose the option to make a new bin.

Creating the First Assemble
Someone once said that the hardest part of writing a book is starting the first chapter. 
Indeed, the same is true for editing; but with sounds and moving pictures rather than 
words on a page. Placing those first few clips into an empty timeline can be quite daunting. 
However, once you have begun assembling the footage you can being to see what’s 
working, what doesn’t work, and what might be coaxed into working with a bit of effort 
on your part as the editor.

To start this process you’ll need a timeline.
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1	 Select the Timelines bin, and choose File > New Timeline, or press Command-N 
(macOS) or Control-N (Windows)

2	 In the Timeline Name field in the New Timeline window, type Age of Airplanes Trailer. 
Leave all the other options at their defaults and click Create.

A new timeline is created in the selected bin and additional controls appear in the 
timeline window.

NOTE  For this introductory lesson you don’t need to be concerned with the 
number of timeline tracks or the audio track type. In later lessons you will learn 
how to configure your audio and track types based on whether you are 
working with mono or stereo clips.

3	 Select the Interviews bin. If required, click the sort menu, and choose to sort the clips 
by Clip Name in Ascending order.

4	 Double-click the clip 01_Shoot the real world to open it in the source viewer. 
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5	 Play the clip from the beginning to the end.

In reality we probably don’t want to use the whole of this clip, but we can choose to 
remove the unwanted parts of this later. There are never really any right or wrong ways 
to edit; just more or less efficient ways.

6	 Drag the clip from the source viewer to the timeline viewer.

A series of editing overlays appear detailing the different types of edits available to 
you in DaVinci Resolve. Seasoned editors probably recognize many of these options 
from other NLEs, though some are specific to DaVinci Resolve. The default is Overwrite.
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7	 With the Overwrite edit overlay highlighted, release the mouse.

Your first clip is edited into the timeline.

8	 Play the clip back in the timeline and stop after Brian says the line “… shoot the real world.”

This is where you’ll make your next edit.

Controlling Playback

One of the import parts of learning to edit is effectively controlling the playback 
of you video. While you could use the transport controls underneath the source 
or timeline viewers, keyboard shortcuts are much more effective. DaVinci 
Resolve’s default keyboard layout supports all the usual shortcuts for playback 
professional editors around the world will recognize. For example, you can use 
the Spacebar to start and stop playback and the Left and Right Arrow keys to 
move forward and back one frame at a time. More experienced users will be 
happy to know that the J, K and L keys also control playback at different speeds. 
To explore DaVinci Resolve’s keyboard layout in more detail you can choose 
DaVinci Resolve > Keyboard Customization.
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9	 In the Interviews bin, double-click 02_possible to shoot it to open it in the 
source monitor.

Play this clip through from the start. You only want to use a part of this clip. When 
working with clips with audio like this, it’s useful to see a representation of the audio 
waveform along with the video in the source viewer.

10	 In the source viewer’s options menu, select “Show Zoomed Audio Waveform.”

How cool is that? Now as you scrub or play through this clip you can see from the 
waveform where he starts and stops speaking. Nice!
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11	 Play the clip from the start once more and then stop playback just before Brian says “If 
it was possible to shoot it, we wanted to go shoot it…” (at around 01:01:11:00).

NOTE  Throughout this book timecode references are used as guidelines for 
where the authors believe the edits work best. However, please feel free to 
explore the footage and use different locations if you feel there are better 
choices. Editing is, after all, a subjective as much as a creative endeavor.

12	 Press I to set an in point at this location.

13	 Play the clip through and stop after Brian says “… everything was real” (at about 
01:01:23:20).

14	 Press O to set an out point at this location.

15	 In the timeline toolbar, click the Overwrite Clip button, or press F10.
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NOTE  If you are using DaVinci Resolve on macOS you may need to configure 
your keyboard settings in System Preferences to “Use F1, F2, etc. keys as 
standard function keys” to use the default editing shortcuts. Alternatively, 
you can use the fn key with any F-key to override the macOS shortcuts.

The second interview clip is edited into the timeline starting at the position of the 
timeline playhead and using only the portion marked between the in and out points 
in the source. The end of the first clip has been overwritten by the new clip. 

16	 Press Up Arrow on your keyboard to move your timeline playhead back to the edit 
between the two interview clips.

17	 Press / (slash) to review the edit.

The edit is successful enough, but it’s a pretty nasty jump cut. You’ll need to add some 
more footage around this interview to flesh out the story.

Three-point Editing

With a few notable exceptions, every edit you perform is generally referred to as 
a three-point edit. This means that DaVinci Resolve is calculating what you want 
to be edited and where you want it edited. In the previous example, the in and out 
points you marked in the source were the first two points required; the third point 
was the position of the playhead in the timeline. When you edited the first interview 
clip into the timeline you were also using three-point editing; even though you 
hadn’t set any in or out points, the software used the clip in the source viewer from 
the beginning (the implied in point) to the end (the implied out point) and placed it 
at the beginning of the timeline, not because it was the first clip but because that 
was where the playhead was. Simple, eh? Throughout these exercises try to work 
out the rules of three-point editing that Resolve is following and how the in and out 
points (real or implied) are being used to complete the edits. In later lessons you’ll 
also be making some four-point edits and edits that use in and out points in 
different ways!
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Insert Edits
Ok, time to add some B-Roll footage to bring Brian’s passion for airplanes alive.

1	 In the Master bin, double-click the 02_A380_TAKEOFF.mov clip to load it in to the 
source viewer. Play the clip from the start to review the footage.

2	 Set an in point a second or so before the plane’s wheels begin to lift off the runway 
(around 01:00:07:00).

3	 Set an out point once the tail of the plane has left the frame.



60
Le

ss
o

n
 2

 
E

d
it

in
g

 in
 t

h
e 

E
d

it
 P

ag
e

4	 Making sure your timeline playhead is still on the edit point between the two interview 
clips, drag the clip to the Insert overlay in the timeline viewer.

The clip is added in between the two interview clips in the timeline, but has been 
inserted between them rather than overwriting the clip after the playhead.

5	 Move the timeline playhead back to the edit between 01_Shoot the real world.mov 
and 02_A380_TAKEOFF.mov. This will be the location for your next edit.

NOTE  Using the Up and Down Arrow keys are fast ways of moving between 
the different edit points in your timeline. If you prefer, you can always drag the 
timeline playhead and it will snap to the nearest edit point so long as your 
Snapping option is enabled. Press N to toggle snapping on or off.
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6	 Double-click 01_A380_TAXI.mov from the Master bin in the Media Pool.

Play the clip through to review. This is a nice overhead shot of the same type of plane 
as you’ve just edited into the timeline, but the audio is a little distracting.

7	 In the timeline, click the red outlined A1 Destination Control for the track Audio 1.

These destination controls allow you to specify which parts of the source audio or 
video are going to be edited into the timeline. By disabling the A1 control you will no 
longer automatically edit the audio from the source clip.

8	 Click the Insert Clip button in the timeline toolbar, or press F9 to insert the new clip 
(sans audio) into the timeline.

Cool. That’s looking a little more interesting. You’ll now insert a clip to split an existing clip.

9	 In the timeline, play through the second interview clip and stop after Brian says, “If it 
was possible to shoot it, we wanted to go shoot it.”

This will be the location for your next edit.
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10	 In the Media Pool double-click 10_MALDIVES.mov and review the clip in the 
source viewer.

11	 Set an in point as you see the shadow of the plane begin to pass across the coral.

12	 In the source viewer type +300 and press Enter to jump the playhead forward 
3 seconds.

13	 Press O to set the out point.

14	 Press F9 to insert the clip into the timeline at the playhead position.

Did you see how this edit has inserted the marked source clip by splitting the 
existing interview clip’s audio and video, even though we only had video to edit? 
This happened because the auto select control for the Audio 1 track is automatically 
enabled. You’ll learn more about the auto select controls in the later lessons.
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Removing the Excess
Ok, your edit is looking pretty good, but you’re now at the stage where you’re probably 
thinking it may benefit from a little bit of trimming to remove some of the unwanted portions 
of the footage.

1	 Move the timeline playhead to the start of the middle interview clip and press 
Command-= (equals sign) in macOS or Control-= (equals sign) in Windows once or 
twice to zoom in better on this clip.

2	 Option-click (macOS) or Alt-click (Windows) the video portion of the clip 
02_possible to shoot it.mov in the timeline.

Do you notice the small chain icons on the video and audio of this clip? That means the 
two parts of this clip are linked. This can be useful if you wanted to remove or move 
both parts of this clip (meaning it would be quite difficult to move them out of sync with 
each other for example). By using the Option key (macOS) or Alt key (Windows) you’re 
momentarily overriding the linking to select just the video portion of the clip.

NOTE  If you’re selecting both parts of the clip with the Option key (macOS) or 
the Alt key (Windows) make sure the Link Selection function is currently active. 

3	 Right-click the selected video clip, and select Ripple Delete from the shortcut menu, 
or press Shift-Delete (Backspace).

The video portion of the clip is removed and the remaining audio tucks nicely under 
the preceding shot of the A380 taking off.
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Did you notice what else happened in the timeline? Because you performed a ripple 
delete, it meant you didn’t leave a gap and the rest of the footage in the timeline 
moved up. More to the point, the audio and video in the last interview clip remained in 
sync. Again, this is due to the auto select control being enabled on all tracks by default.

NOTE  If you want to see what would happen with the auto select control 
looking out for you, undo the last step and disable the auto select control for 
the Audio 1 track and repeat the last few steps. Remember to re-enable auto 
select for Audio 1 afterwards.

Another way to remove sections of clips from your timeline is using in and out points.

4	 Play through the third interview clip on the timeline.

You’re going to remove the line “…stay at that location longer…” as it’s a little repetitive 
and unnecessary.

5	 Play through the last clip on the timeline and set an in point just before Brian says  
“… stay…” (around 01:00:28:100).

6	 Add an out point after he says “…longer…” (around 01:00:29:05).

7	 Press Shift-Delete (Backspace) to ripple delete the portion between the in and out points.

8	 Press / (slash) to preview the new edit.

Great. That’s tidied up that part of the timeline, now you’ll turn your attention to the 
first clip.
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Trim Edit Mode
1	 Press Shift-Z to zoom back out from your timeline.

2	 Press the Home Key to move the playhead back to the beginning of the timeline.

3	 Press Shift-Z to return to the previous zoom level.

4	 Play through the first clip.

Obviously there’s some unwanted portion of his interview we need to trim off at the 
beginning here.

5	 Place your timeline playhead just before Brian says “In this film…” (at about 
01:00:03:00).

6	 Press T to enter trim edit mode.

The Trim Edit Mode toolbar button is highlighted.

7	 Click the beginning of the first clip, and drag the edit to the right until it snaps to 
your playhead.

TIP  If snapping isn’t enabled, just press N to quickly enable it during the 
trimming operation.

8	 Press A to return to selection edit mode.

Notice that because the audio and video of this clip are linked, you’re trimming both 
parts of the clip together and because you are in trim edit mode you’re automatically 
rippling the timeline; all clips in the timeline on all auto select-enabled tracks after the 
selected edit are being rippled to maintain their sync’ed relationships.
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Adding More Tracks
Now that you’ve started refining the timeline more, you’ll possibly want to add the music 
and then build in the final pictures.

1	 Move your playhead back to the beginning of the timeline.

2	 Select the Audio bin and locate the clip Music Score for Trailer.mov.

3	 Drag this clip directly from the bin to the Place On Top overlay in the timeline viewer.

4	 Press Shift-Z to show the entire timeline.

Despite its name, the Place on Top edit has actually added a new audio track below 
your existing audio tracks. The Place on Top edit will actually place the edited clip into 
the first available empty track in your timeline, working its way upwards through the 
video tracks, or downwards through the audio tracks. If it can’t find an empty timeline 
track for the duration of the source clip, then a new track is created to accommodate 
the new clip. Place on Top is useful for adding B-Roll to interviews or titles as you 
will see later.

You’ll need to attenuate (lower) the level of the music clip otherwise you won’t hear 
the interview audio.

5	 Use the volume overlay line on the Music Score for Trailer audio clip to lower the clip’s 
volume by about -18db.
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6	 Move your timeline playhead to the edit point between the last two interview clips.

7	 From the Master bin, double click the clip 08_SOUTH_POLE_DC3_.mov to open it 
into the source viewer.

8	 Press F10 to overwrite the whole of this clip at the playhead position, overwriting the 
video of Brian’s final interview clip in the process and solving the problem of that jump 
cut at the same time.

9	 Select the clip 07_KENYA.mov in the Master bin and drag across to the Append at End 
timeline viewer overlay.
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The Append at End edit will use the end of the last clip on the targeted track as the 
implied in point in the timeline, irrespective of where the timeline’s playhead is. It may 
not seem like it, but this is still a three-point edit.

10	 From the Master bin, select 06_MILKYWAY.mov and use the timeline viewer overlays 
to perform an Append at End edit.

11	 Double-click 05_BAY_AREA_LIGHTS.mov to open the clip in the source viewer then 
press Shift-F12 to perform an Append at End edit.

12	 Press Shift-Z to show the whole timeline.

Trimming to Duration
You now need to trim the extra pictures to bring your edit to time.

1	 Place your timeline playhead at the start of 08_SOUTH_POLE_DC3_.mov and press 
Comand-= (equals sign) in macOS or Control-= (equals sign) in Windows once or twice 
to zoom in

2	 Press T to enter trim edit mode.

3	 Select the beginning of the 08_SOUTH_POLE_DC3_.mov clip and begin to drag to 
the right to trim the clip.
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Whoa! Do you see what’s happening? You’re trimming the beginning of the clip forward 
but the interview audio is being rippled backwards!

4	 Press Command-Z (macOS) or Control-Z (Windows) to undo the last step.

5	 Click the auto select control for the Audio 1 track to deselect it.

6	 Repeat the trim operation in Step 3 to trim the clip but not move the Interview audio. 
Trim the clip so the grey duration tooltip reads about 3 secs.

7	 Press the Down Arrow key to move to the next edit at the start of the 07_KENYA.mov clip.

8	 Trim the beginning of this shot until the tail of the yellow plane is in shot and the clip is 
about 4 seconds long.

Another way to change the duration of clips and make them visually more interesting 
is to adjust the speed at which the clip plays back at.

9	 Right-click the 06_MILKYWAY.mov clip, and choose Change Clip Speed.
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10	 In the Change Clip Speed dialogue box, type 225 in the Speed % box and select the 
Ripple Sequence option.

The 06_MILKYWAY.mov clip is sped up and the trailing shot is rippled back in the 
timeline with its change of duration.

11	 Play through the rest of the timeline until the final beat of the music.

12	 Place the timeline playhead on the final beat of the music score (at 01:00:40:00).

13	 In the Titles bin, double-click the 11_MOVIE_CREDITS.mov clip to open it in the source 
viewer.
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14	 Press F10 to perform an overwrite edit.

15	 Press Shift-Z to view your entire timeline.

Before going much further, it’s always a good idea to periodically save a copy of the 
timeline you’re currently working on.

16	 In the Timelines bin, select the Age of Airplanes Trailer timeline you’re working on, 
and choose Edit > Duplicate TImeline.

A copy of your timeline appears in the same bin.

NOTE  You can now continue working on the currently loaded timeline, 
knowing you have a backup of your work to this point. Many editors often 
like to rename the duplicated timeline so they know what they are looking 
at in the bin.

17	 Press Home and play your timeline to review your edit so far.

Excellent. You’ve built a fairly sophisticated trailer. However, there’s still a few things to do 
before the director will be happy.
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Finessing the Edit
With a backup copy of your timeline in your bin, it’s now time to start finessing the edit 
further. You’ll begin by adding some sound effects to the b-roll footage to give it more 
of an impact.

1	 Right-click anywhere in the timeline track headers, and choose Add Tracks.

2	 In the Add Tracks dialogue box, change the number of video tracks to 0 and the 
number of audio tracks to 2. Ensure the Insert Position for the new audio tracks is set 
to Below Audio 1, and set the track type to stereo. Click Add Tracks.

The additional audio tracks are added as specified.
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3	 Position your timeline playhead anywhere over the second clip 01_A380_TAXI.mov 
and press X.

In DaVinci Resolve, X does not mark the spot, but rather marks the timeline clip under 
the playhead on the lowest active auto selected track.

4	 In the Audio bin, double-click SFX – jet taxi.wav to open it in the source viewer.

5	 In the destination controls in the timeline, drag the red outlined A1 control to A2.

This tells Resolve you want to edit the next clip into this track.

6	 Press F10 to perform an overwrite edit.
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You have just completed a three-point edit, but this time you set the duration of the edit 
by using in and out points in the timeline. No in or out points were set in the source, so 
the implied in point was used; that is, from the start of the clip.

7	 Move the timeline playhead over the clip 08_SOUTH_POLE_DC3_.mov and press X 
to mark the clip.

8	 Open SFX-Prop.wav in the Audio bin in the Media Pool.

9	 With your source viewer playhead at the start of this clip, type +200 in the source 
viewer, and press I to set an in point.

10	 Press F10 to perform an overwrite edit.
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This time, because you added an in point to the source clip, Resolve used this point 
when editing the clip into the timeline.

11	 Ensure your playhead is over the next clip in the timeline, 07_KENYA.mov.

12	 Press X to mark the clip.

13	 In the Audio bin, open SFX – Distant prop plane.wav into the source viewer.

14	 Set an in point roughly 3 seconds from the start of this clip.

15	 Click the A3 destination control in the timeline track controls.

16	 Press F10 to perform an overwrite edit.

Backtiming Edits
Another editing technique that’s often used and builds on the concept of the three-point 
edit is the backtimed edit. Backtiming an edit means you specify where you want a shot to 
end by just adding an out point rather than an in point.

1	 Place your timeline playhead over the third clip 02_A380_TAKEOFF.mov and press X 
to mark the clip.

2	 In the Audio bin, open the clip SFX – Jet take off.wav into the source viewer.

3	 Play through the clip until the sound of the jet starts to fade away (around 01:00:19:00).
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4	 Press O to add an out point.

NOTE  For backtimed edits to work you only need an out point. If necessary, 
you can remove an in point by pressing Option-I (macOS) or Alt-I (Windows).

5	 Press F10 to make an overwrite edit.

This time the out point you set in the source viewer has specified where the new clip 
should stop. Pretty neat, yeah?
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Using Replace Edits
Another technique you can use to your advantage very effectively is the replace edit. The 
replace edit is slightly different from the three-point edits you’ve been using throughout 
this lesson in that you’re not required to set any in or out points. Instead, the replace edit 
uses the position of the timeline and source playheads to align the edits.

1	 Move the timeline playhead over the clip 10_MALDIVES.mov just before you see the 
wings come into shot.

2	 Open the clip SFX – Overhead.wav in the audio bin.

This is a simple sound effect file with a prominent waveform.

3	 In the source viewer, position the playhead over the highest point of the waveform.
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4	 In the timeline, click the destination control to A2.

5	 Click the Replace Clip button or press F11.

6	 Press / (slash) to preview the edit.

Quite effective, isn’t it? You’ll work with replace edits again in much greater detail in a 
later lesson.

Audio Mixing Basics
Now you’ve got some sound effects in your edit the whole timeline has seemed to come 
alive and just goes to show the importance of sound. You’ll work with audio much more 
throughout later lessons, however even at this stage it’s likely that you’ll need to take on 
some basic audio duties, at the very least so the director gets a sense of what the edit will 
eventually sound like.

1	 Press A to ensure you’re working in selection mode and then select all the interview 
clips on the Audio 1 track.
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2	 Click the Inspector button in the upper-right corner of the interface to open the 
Inspector.

3	 Drag the Clip Volume slider to raise the level of all of these clips by about 6db.

That sorts the main levels out for Brian’s dialogue clips, but there’s a bit of a spike at 
the beginning of the first clip.

4	 Zoom in to the beginning of the first clip.

5	 Option-click (macOS) or Alt-click (Windows) the volume curve line to add a keyframe 
after the spike. Repeat to add a second keyframe just after the first.

6	 Lower the part of the audio curve before the first keyframe so the peak is about the 
same height as the other peaks in the clip (a change of about -5db).

7	 Press Shift-Z to zoom back out and see the whole timeline.
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Displaying the Audio Meters

You can see your audio levels in the Edit page by clicking the Mixer button in the 
upper-right corner of the interface. You can then choose to show just the meters by 
clicking in the Mixer’s Options menu (the button with three dots) and choosing 
Meters. Doing so displays the combined levels for the timeline’s currently selected 
main bus. You’ll learn more about setting mains and other buses in the audio 
mixing lesson.

Mixing the Sound Effects
Now it’s time to turn your attention to the sound effects you added earlier. First, you’ll 
want to adjust the levels and then apply fades to the beginnings and ends of each clip. 
Fortunately, DaVinci Resolve has a quick way to bypass such repetitive tasks.

1	 Adjust the level of the first audio clip on the Audio 2 track, the SFX – Jet Taxi.wav clip, 
by about -8db.

2	 Use the fade controls at the head and tail of the clip to apply a short fade in and out 
to the clip.

3	 Select the clip in the timeline, and choose Edit > Copy, or press Command-C (macOS) 
or Control-C (Windows).

4	 Select all the other audio clips on the Audio 2 and Audio 3 tracks.

5	 Choose Edit > Paste Attributes, or Press Option-V (macOS) or Alt-V (Windows).
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6	 In the Paste Attributes dialogue box, select the box for Volume in the Audio Attributes, 
and click Apply.

The Paste Attributes command pastes the volume settings, including the fade handles, to 
each of the selected clips. You may still want to go through the clips yourself later to check 
that they are the right level, but this is a great timesaver.

Adding Transitions
You should always add transitions to your projects with great care. Transitions must be 
inserted with a consideration of the story you are telling and not used if they detract from 
that story. As a wise man once said, “With great power, comes great responsibility.”

That said, transitions are a good way to show a change of location or time that might be 
a bit too abrupt for your audience if left with just a straight cut.

1	 Select the edit point between 02_A380_TAKEOFF.mov and 10_MALDIVES.mov.
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2	 Press Command-T (macOS) or Control-T (Windows) to add the default cross 
dissolve transition.

3	 Press / (slash) to preview the transition.

You’ll find additional controls for your transitions in the Inspector

4	 If necessary, zoom in on the transition in the timeline and select it. 

5	 In the Inspector, change the Video Transition Style to “Edge Wipe”, change the Angle 
to about -80, and change the Duration to 12 frames.

6	 Check the Feather box and increase the border to around 100.

7	 Finally, press / (slash) to preview the transition and channel your inner George Lucas.
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NOTE  You can access more transition presets by clicking the Effects 
Library button from the upper-left corner of the interface and selecting the Video 
Transitions category.

Carry on Cutting
Congratulations! You should now have a more rounded understanding of the basic editing 
toolset within DaVinci Resolve. However, before you move to the next lesson you might 
want to put your new skills to the test as there’s still a few things you can do to finesse this 
edit. Try and accomplish these tasks on your own. Don’t forget, you should duplicate your 
timeline to create a backup version before you make any major changes! Good luck!

1	 Trim each of the sound effect clips on Audio 2 and Audio 3 so that there’s more overlap 
as one sound effect fades out and the other fades in.

2	 Add keyframes to the music score clip on Audio 4 so that the volume rises after Brian’s 
last line.

3	 Use the razor edit mode to cut up Brian’s last line and position it further down the 
timeline to create more pacing for his dialogue.

Lesson Review
1	 True or False? DaVinci Resolve automatically saves all new projects to your 

computer’s Desktop.

2	 What element is most often used to organize imported clips in DaVinci Resolve?

a)	 Folders

b)	 Thumbnails

c)	 Bins

3	 What types of edits can you perform using the toolbar buttons above the timeline?

a)	 Overwrite 

b)	 Insert 

c)	 Append at End

4	 True or False? DaVinci Resolve only allows you to manually add one video or audio 
track at a time.

5	 True or False? You can change only the type of transition applied to an edit by 
accessing the various transitions from the Effects Library.
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Answers
1	 False. All new projects are saved into the currently active database.

2	 Bins are most commonly used to organize imported clips in DaVinci Resolve.

3	 a) and b) The toolbar has buttons for performing overwrite, insert, and replace edits. 
Append at End edits can be performed using the timeline viewer overlays, the 
Edit > Append at End of Timeline menu option, or by pressing Shift-F12.

4	 False. You can add as many video and audio tracks as you require by choosing the 
Add Tracks option after right-clicking in the timeline track headers.

5	 False. Transitions can be changed in the Inspector as well as from the Effects Library.
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While DaVinci Resolve is a superior editing, 
audio mixing, visual effects, and color 
grading system, it can also play a key role 
on set before a single edit is made. In this 
lesson, you’ll focus on some of the incredi-
bly powerful yet lesser-known, and often 
overlooked, Resolve functions that will help 
during production as you organize and 
optimize high-resolution, camera-original 
media, and generally prepare everything 
for your edit. 

Lesson 3

Managing Dailies 
and Edit Prep
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Backing Up Source Files
The most important asset of any project is the camera-original media. It is irreplaceable, 
and if corrupted in any way, the alternatives can be painful. So, it makes sense that the very 
first thing you must do is to back up that original media.

1	 Open DaVinci Resolve and, in the Project Manager, create a new project. Name your 
project Editing Lesson03.

You’ll use this empty project to back up content from disk image file which you will use 
to simulate plugging in a drive containing new media. However, you could just as easily 
use a C-Fast or SD card from a camera, or any other data storage device such as a 
USB drive.

NOTE  To complete the next few steps in this exercise, you will need to have 
approximately 2.5 GB of available storage on your system.

2	 At the bottom of the interface,click the Media page button, or press Shift-2.

The Media page is the most efficient page for importing and organizing media, syncing 
clips, and adding metadata. It is also where you can back up camera-original media 
using the clone tool.

3	 To display the clone tool, click the Clone tool button in the upper-left of the toolbar.

A new window opens between the Media Storage browser and the viewer which you 
can use to create a backup of media cards, folders, or even an entire drive of content.

4	 At the bottom of the Clone tool panel, click the Add Job button.
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Each item you want to clone or back up is considered a job. You can add as many jobs 
as you like and then create clones of content all at once. You add content by dragging 
a folder, a disk image, or camera card content from the Media Storage browser into the 
Clone tool panel.

5	 Open a new Finder window (macOS) or Explorer window (Windows), and navigate to  
R16 Editing Lessons > Lesson 03 Edit Prep. Double-click the R16_Editing_Lesson03.iso 
file to open it.

This ISO file is a disk image that will appear on your system as a virtual hard drive. You 
have just simulated plugging in an external source, such as a hard drive or camera 
media card.

6	 Return to DaVinci Resolve.

In the list of media storage locations, a new source called Lesson03_Media is 
now available.

7	 Drag Lesson 03 Media into the Clone tool panel’s source area.

Each job requires at least one destination for the cloned media; however, you can add 
multiple destinations to create multiple backups at once.

8	 In the Media Storage browser, navigate to the “R16 Editing Lessons > Lesson 03 Edit 
Prep” folder, and drag the “Backup Destination” folder into the Clone tool panel’s 
destination area.

TIP  You can also right-click a folder in any media storage location and choose 
“Set as Clone Source” or “Add as Clone Destinations.”
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9	 In the upper-right corner of the clone tool panel, in the options menu, choose Checksum 
Type > MD5.

A checksum is a way to detect and prevent errors that can occur during the copy 
operation. Several checksum methods are available, but MD5 checksum has become 
the industry standard, and studios that require checksums with media offload on set 
will typically require it.

10	 Click the Clone button at the bottom of the Clone tool panel to begin the backup. 
During this time, you can continue using Resolve. 

11	 When the copy is complete, a green complete label appears on the job in the Clone tool. 

12	 In your operating system’s interface, navigate to the R16 Editing Lessons > Lesson 03 
Edit Prep > Backup destination folder. 

In addition to containing the entire contents of the disk image, the backup destination 
includes a MD5 checksum text document that reports any errors as a result of the 
checksum verification.
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13	 Return to Resolve, and in the toolbar, click the Clone tool button to close the panel.

14	 In the Media storage locations, right-click the Lesson 03 Media location, and choose 
Unmount Drive to unmount the drive from your system, thereby allowing it to be 
removed safely.

NOTE  For Windows users, if the disk image does not unmount using the above 
method, you can always right-click the mounted disk image and choose Eject.

Cloning your camera-original content is so essential that it is worth putting DaVinci Resolve 
on set, so a backup can be performed before the set is struck and everyone goes home. In 
so doing, you can clone and check the media; and if something is wrong, you will know to 
reshoot right away with the least impact on schedules and budgets.
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Customizing New Projects
After you have backed up all your content, configuring the project can be made easier if 
you have created presets for the most common project settings that you need.

Rather than checking your project settings each time you create a project, you can 
configure options in the Project Settings window and save those as your defaults. Then, 
every time you open a new project, DaVinci Resolve will default to those settings. Plus, you 
can also load these presets into existing projects.

1	 Choose File > Project settings, or press Shift-9 to open the Project Settings window.

2	 In the Master settings, set the “Timeline resolution” to “1280 x 720 HD 720P”, 
and ensure that the “Timeline frame rate” is set to 24 frames per second.

3	 Click the Presets category.

4	 In the Presets panel, click the Save button to save the changes to the current project.
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5	 With the Current Project preset still selected, click “Save as”. Enter the new preset 
name as Lesson 03 Preset, and click OK.

Your settings for this project are now saved. To quickly apply them to any project 
in this database, you can select the preset, and click Load.

If you want every new project to open using a specific configuration, you can save 
any preset into the guest default config setting.

6	 Right-click the Lesson 03 Preset, and choose Save as User Default Config.

The settings of this preset are applied to the guest default config preset. Now, every 
new project you create will use those settings.

7	 Click back on the Current Project setting, and close the Settings window.
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TIP  You can also transfer settings from any project to the current project in the 
Project Manager. To do so, press Shift-1 to open the Project Manager, right-click 
any project, and choose “Load Project settings to Current Project”. A dialog box 
asks you to confirm replacing your current project’s settings. To do so, click “Load 
Project settings”.

Project presets allow you to easily create, manage, and switch between presets to enable 
the various project resolutions, frame rates, and other settings that you might need to work 
with. Project presets can save nearly every parameter and setting across all panels in the 
Project Settings window; however, only the “guest default config” is used as the default for 
new projects.

Syncing Dailies
Now you’ll import the dailies into your project and begin organizing the media by syncing 
any audio and video clips that were recorded on separate devices. Some productions 
record audio on dedicated digital audio devices to capture the highest quality audio, or 
when it’s not practical or desirable to record audio directly to a camera. When the files 
come in from the day’s shoot, you’ll need to sync the separate audio and video clips. In 
some cases, you can auto sync these using timecodes found on both clips, or by 
comparing camera-recorded audio with the separate audio clips. In some instances, 
you may not be so lucky and you will need to manually sync your clips.

1	 In the Media Storage browser, navigate to R16 Editing Lessons > Lesson 03 Edit Prep> 
Backup destination.

This was the destination location you set in the Clone tool when copying the disk 
image in the previous exercise.

2	 Select all three folders. Right-click any of the folders, and choose “Add folder and 
SubFolders into Media Pool (Create Bins)”.

3	 In the Media Pool, switch to list view, and click the Clip Name header to sort the bin 
in ascending order. (The arrow will point up.)
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4	 In the bin list, click the Video clips bin, and then Cmd-click (macOS) or Ctrl-click 
(Windows) the Audio Clips bin to display the contents of both bins in the Media Pool. 

5	 Double-click CLIP0001.mov.

Play through the interview with Sasha in the viewer.

This clip has poor audio, possibly because it was recorded using the on-camera 
microphone.
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6	 Double-click Audio0001.wav, and play through this clip in the viewer.

This clip contains the correct audio for Sasha’s interview.

7	 In the Media Pool, select CLIP0001.mov and Audio0001.wav, right-click either file, 
and choose Auto-sync Audio > Based on Waveform.

8	 From the recent clips pop-up menu at the top of the viewer, choose CLIP0001.mov, 
and play it to hear the newly synchronized picture and sound.

TIP  If you have many clips to sync in this manner, you can select multiple audio 
and video clips, right-click one of them, and choose Auto-sync Audio > Based on 
Waveform to let Resolve work its magic and sync them all automatically.

Resolve automatically matches the waveforms of the two pieces of audio to correctly 
sync the production audio with the video clip.
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Syncing Manually 
The previous example worked well, but sometimes automatic operations don’t work 
as smoothly.

1	 Double-click CLIP0002.mov to open it in the viewer, and play through the clip.

Because no audio was recorded with this clip, you have no audio waveform with which 
to auto-sync the clip.

2	 In the Audio panel, click the Waveform tab to prepare to display the audio waveform 
of a selected clip.

3	 In the Media Pool, select Audio0002.wav. The waveform viewer will update to show 
the audio waveform of this clip.

You will need to manually sync these two clips. To do so, you need to position the 
playheads for the video clip and the audio clip where you think the clips align.

4	 In the viewer, drag the jog bar through the clip until you see Sasha clap his hands.

5	 Press the Left and Right Arrow keys to position the playhead on the exact frame where 
his hands are together at 03:30:31:19.
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6	 In the Audio panel, drag the jog bar until you see the first waveform peak that indicates 
the hand clap at 03:30:31:17.

7	 Press the Left and Right Arrow keys to position the audio panel playhead on the audio 
peak of the hand clap.

TIP  Audio scrubbing is a useful feature when trying to identify a particular 
location on an audio clip. Choose Timeline > Audio Scrubbing, or press Shift-S, 
to toggle it on and off.

8	 At the bottom of the audio panel, click the Link/Unlink Audio button.

The transport controls beneath the audio window disappear; and the clips are now 
linked. Let’s make sure that the sound and picture are lined up correctly.

9	 Move the playhead to the beginning of CLIP0002.mov, and click play to verify the 
picture and sound are in sync.
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TIP  If you’re not entirely happy with your results, clicking the Link/Unlink Audio 
button again will unlink the clips and allow you to readjust the sync relationship.

While it is much easier to use Resolve’s auto sync feature to sync clips based on their 
timecodes or audio waveforms, being able to manually sync clips is also useful if the audio 
has a transient audio signal that you can visually locate in the video. That’s why most 
dual-system setups use clapperboards to help in this process.

Modifying Clip Audio Channels
The next step in your edit prep process is to ensure that the audio in the project is 
configured correctly. You can do that in the Clip attributes window.

1	 In the Media Pool, click the CLIP0003.mov clip to select it.

2	 Shift-click CLIP0012.mov to also select it and all the video clips in-between.

Even though one clip doesn’t have audio, you can simultaneously modify those clips 
that do have audio in the Clip attributes window. 

3	 Right-click any of the selected clips, and choose Clip Attributes.

In the Clip Attributes window, you can configure various aspects of how clips are 
displayed, played, and heard.
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4	 Click the Audio tab.

In the Audio tab, you may change the number of tracks used when editing the clip into 
the timeline, the configuration of the individual channels within those tracks and 
whether those channels are used or muted. In this case, you’re working with stereo 
clips; but because this audio was recorded in-camera, it makes sense to configure 
these as mono clips.

NOTE  You can individually configure multiple tracks with different configurations 
for each clip, depending on the audio formats supplied to you and how clips 
will be used throughout the edit.

5	 In the Format column pop-up menu, choose Mono to reconfigure the current audio 
track as mono, and set the Source Channel to Embedded Channel 1.
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6	 In the uppermost Format pop-up menu, choose Mono. Click Add to insert another 
mono track, and change its Source Channel to Embedded Channel 2.

7	 Click OK to save the setting and close the window.

These clips are all now correctly configured with two tracks of mono audio.

TIP  To remove an audio track and its configuration from any clip, move your mouse 
pointer over the track, and click the trash can icon that appears to the right.

Clip attributes encompass several useful configuration features, but you’ll want to configure 
most of them before you edit a clip into a timeline. Once clips are placed into a timeline, any 
changes you make to the clips attributes in the Media Pool will affect only new edits. Existing 
edits in any timeline conform to the clip attributes in place at the time the edit was made. You 
can adjust these within the timeline by right-clicking the clip, and choosing Clip Attributes.

Configuring Metadata Presets
As useful as metadata is, it can become overwhelming. Resolve has several metadata 
categories you can use to reduce metadata to a manageable subset of the whole. 
However, you can customize metadata presets to display only the information you most 
need or want to see.

1	 Choose DaVinci Resolve > Preferences, or press Cmd-, (comma) in macOS or 
Ctrl‑, (comma) in Windows.

2	 In the preferences window, click the User tab, and select the Metadata category to 
the left.

In the Metadata presets pane, you can create, modify, and delete custom metadata presets.
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3	 Click the New button to create a new metadata preset, and name it My Metadata Preset. 
Click OK.

In the lower-half of the Metadata pane, under Metadata options, you’ll see all the metadata 
you might add to the preset.

4	 Select the checkboxes for Description, Keywords, Scene, and Shot.

5	 At the upper-right of the Metadata options, click Save to save your changes to the preset.

6	 Click Save at the bottom of the preferences window to save and close the 
preferences panel.

7	 In the Media Pool, select one or more clips; and if necessary, click the Metadata 
button to open the Metadata editor to the right of the interface.
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8	 Click the options menu, and choose the new My Metadata Preset. Click the sort menu, 
and choose All Groups. 

TIP  Your preset will appear blank in the Metadata editor unless it is set to 
show all groups or a subset that contains all the fields of your preset.

Using this preset, fields for the four selected metadata items appear in the metadata 
editor. Currently, the fields are empty for all the clips in the Media Pool; you could enter 
this information manually, or if the information exists outside of DaVinci Resolve, you 
could import it.

Importing Metadata
You have many ways to populate your clips with metadata. Some may be entered on the 
camera during production, although metadata is rarely a priority for the camera operator or 
an assistant. You can enter it manually, which very few people want (or have the time) to do. 
Or, you can assign someone on set to be responsible for entering metadata in a simple 
CSV (comma-separated values) format. Many smart slate apps now store metadata such 
as shot, scene take, and more. You can then import that data into Resolve using the CSV 
format and save yourself hours of work in the cutting room.

1	 Choose File > Import Metadata to > Media Pool.
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2	 In the file dialog, navigate to R16 Editing Lessons > Lesson 03 Edit Prep. Select 
CC-metadata.csv, and click Open.

The Metadata Import dialog allows you to choose how you want Resolve to match the 
clips with additional metadata. In this case, you can match clips based on their file 
names and timecodes.

3	 Deselect the “Match using clip start and end Timecode” check box.

4	 Click OK to import the metadata.

The metadata is imported and added to the clips based on matching file names. 

5	 Verify the added information by clicking a few of the clips and viewing their metadata 
in the Metadata editor.

Your clips now include scene, shot, description and keyword information. This metadata 
will help as you organize and rename the clips to something more useful than the cryptic 
file names given to them by the camera.
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Renaming Clips with Metadata
Clip names from a camera, or almost any capture device, are often an alphanumeric string 
that typically includes the date and time that the clip was made. They are not always the 
most descriptive names and often need to be changed for editing purposes. Entering clip 
names manually is one way to address this, but it is not the only way (or even the most 
efficient way) to rename them.

Variables are references to other metadata that exist on the clip such as scene, take, and 
shot number—socalled because variables are not the same for each clip. You can enter a 
variable into the clip name and Resolve will reference the correct information for each clip 
(provided the information is present). For example, you can use the metadata you’ve just 
entered to change the generic names of the clips in your Video clips bin to more 
descriptive names.

1	 Select the Video Clips bin, and press Cmd-A (macOS) or Ctrl-A (Windows) to select all 
the video clips in the bin.

2	 Right-click any of the selected clips, and choose Clip Attributes.

3	 In the Clip Attributes window, select the Name tab.

4	 In the Clip Name field, type a % (percentage sign).

Entering % indicates that you are about to enter a variable. When you enter that %, a list 
of variables appears.

5	 Press K to begin typing, and enter key to see all of the variables that start with a “k.”

6	 In the pop-up menu, click Keywords to add it to the Clip Name field.
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7	 Press the Spacebar to add a space after this variable. Type %des and choose Description.

You can combine text that you enter with preset variables to create a more descriptive 
clip name. For instance, you can type a space to separate each variable, and add the 
word “shot” before each shot number.

8	 Enter a space after the description variable, type shot, and enter another space.

9	 Type %sh to display all the variables with an “sh,” and in the pop-up menu, choose 
Shot to add it into the Clip Name field.
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10	 Click OK to close the window and apply the clip name variables.

The clip names now show a combination of the keywords, descriptions, and shot 
numbers for each clip.

If you have the metadata attached to your clips, you should use it. Naming clips with 
variables can save hours of manual typing and provide clear, descriptive names that 
you can match with other documents in a production like camera logs and script notes.

Searching with Metadata
You also can use this metadata to find clips quickly and easily. Being able to find the 
material you want or need as rapidly as possible means you can more effectively focus 
on the story and the flow of your edit.

1	 Select the Video Clips bin.

2	 At the top of the Media Pool, click the magnifying glass button to reveal the search field.

By default, the search criteria for the selected bin is set to search across a clip’s file name.

3	 In the “Filter by” pop-up to the right of the search field, choose All fields.

Resolve will search across all the available metadata fields.
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4	 In the search bar, enter ext to display all the exterior shots that have EXT as a keyword.

5	 In the search bar, highlight ext, and enter Sasha to reveal the two shots that have 
Sasha entered into their description fields.

6	 Clear the search bar by clicking the x to the right to return to the full list of media in the 
Video Clips bin.

Resolve’s powerful and responsive search feature lets you leverage the flexibility of metadata 
to easily find Media Pool clips in even the largest project.

Using Automatic Smart Bins
One of the advantages of adding metadata to your clips in Resolve 16 is that you can use it 
to create Smart Bins. Keywords, scene, and shot metadata, in particular, are automatically 
used to create a series of Smart Bins. Now that you have keywords and scene metadata 
imported and applied to clips in this project, you can use them to quickly find relevant 
material for your edit.

1	 In the Smart Bins area of the Media Pool, click the disclosure arrow for the Keywords 
Smart Bin folder to view the list of Smart Bins.
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These Smart Bins were automatically created based on the keywords currently applied 
to each clip in this project.

2	 Select the INT Smart Bin. Notice that this Smart Bin contains two clips that contain the 
INT keyword, CLIP0003.mov and CLIP0012.mov.

3	 Select the Store Smart Bin.

This Smart Bin contains a total of five clips, two of which are the same two clips as the 
INT Smart Bin.

4	 In the main menu, choose DaVinci Resolve> Preferences.

5	 In the preferences window, click the User tab, and then click the Editing category on 
the left side of the window.

The editing preferences allow you to display other automatic smart bins beyond Keywords.

6	 Select the “Automatic Smart bin for Scene Metadata” checkbox, and close the 
preferences window.

Three scene Smart Bins are displayed under the keyword smart bins.

As you can see, coupled with the power of metadata, Resolve has some flexible and detailed 
searching functions; so, you should always be confident you’ll be able to find your media. 
One word of caution, however, is that a search is only as good as the quality of the available 
metadata. Sometimes a simple spelling mistake can thwart all of a search engine’s benefits.
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Creating Smart Bins for People

NOTE  Smart Bins for People is only available in DaVinci Resolve Studio. If you are 
using the free version of DaVinci Resolve, you may read over the exercise but you 
will not be able to perform the steps. You can begin following the steps with next 
section titled Creating Power Bins.

Now that you have Smart Bins for keywords and scenes, you may also want to know which 
characters or people are in those scenes. DaVinci Resolve neural engine can detect human 
faces in a shot and recognize that same face when it appears in other shots.

To find people in clips, you begin by analyzing the clips in a bin.

1	 Select the Video Clips bin, and press Cmd-A (macOS) or Ctrl-A (Windows) to select all 
the video clips in the bin.

2	 Right-click any of the selected clips, and choose “Analyze Clips for People.”

The neural engine analyzes each clip looking for faces and then tries to identify other 
clips with the same face. When the analysis is completed, a People management 
window displays the results of the analysis.

The sidebar to the left shows bins created based on the analysis. The uppermost 
People bin displays each unique face. You can name each found face to create a Smart 
Bin for that individual.

3	 Click, pause briefly, and then click again underneath the first thumbnail to edit the 
name. Type Sasha as the person’s name.

In the People bin, individual bins collect all the clips with a recognized individual. 
Naming the clip in the People bin as Sasha has created a Sasha bin.
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4	 In the sidebar, select the Sasha bin to display all of the clips in which Sasha is recognized.

If incorrect clips are added to bins, right-clicking that clip will display options for 
correcting any issues. 

5	 In the sidebar, select the Person 2 bin to display the image on the tee-shirt as a 
detected face.

6	 Right-click the clip in the bin, and choose Remove to eliminate the tee-shirt from 
recognition.

The Other bin collects clips in which faces were detected but not recognized as 
belonging to an identified person. You can use this bin to correctly identify these clips 
with the appropriate name.

7	 Select the Other bin.

8	 Select Clip0006 and Clip0004, right click either of the selected clips, and choose 
Tag as > Sasha.

The two clips are moved to the Sasha bin, leaving the tee-shirt face clip as an 
unrecognized person.

9	 In the lower-right of the window, click the Close button to confirm all of your changes.

The names of each recognized person is added to the People field in the Shot and 
Scene metadata category. However, a more convenient option is to enable the display 
of People Smart Bins.

10	 Choose DaVinci Resolve > Preferences, and at the top of the window, click the User tab.

11	 In the Editing category, select the checkbox for Automatic Smart Bins for People metadata.

12	 Close the Preferences window.
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13	 Between the Keywords and Scene Smart Bins, click the disclosure arrow for People to 
display the Sasha Smart Bin.

All of the clips that contain a recognizable face of Sasha now appear in a single bin. If you 
need to modify a People Smart Bin, you can reopen the People window at any time by 
choosing Workspace > People. Alternatively, you could edit People keywords directly in 
the Metadata editor.

TIP  You can reset all faces by clicking the People window’s Option menu and 
choosing Reset Face Database.

Creating Power Bins
Bins and Smart Bins are great organizational tools to use within a project. The Power Bin 
is a third bin type that can assist you with organization. Unlike regular bins or Smart Bins 
that exist only within the current project, Power Bins appear in every project you create 
within a database. They are useful for storing elements you want to reuse across multiple 
projects such as graphics, titles, sound effects or music files.

1	 Choose View > Show Power Bins.

Power Bins are displayed in the Media Pool above the Smart Bins.
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2	 Select the Power Bin’s Master bin, and press Shift-Cmd-N (macOS) or Shift-Ctrl-N 
(Windows) to add a new Power Bin. Name the bin Logo.

3	 Select the Graphics bin that’s currently in your project.

This bin contains a file called CC-logo.tif.

4	 Drag CC-logo.tif to the Logo Power Bin.

Because Power Bins appear in every project you create, this image file will be available 
for any project you have in your current database.

NOTE  Multicam, compound clips, Fusion clips, and timelines cannot be placed 
in Power Bins.

The next time you find yourself with a series of projects that share elements such as sound 
effects, graphics, or common video elements, Power Bins can be a powerful tool to save 
you time copying clips into different projects.

Optimizing Clips for Editing
One of the last steps you might choose to do before you begin editing in earnest is to 
consider optimizing high-resolution media. Working with camera-original content is ideal 
when color grading but it can slow you down if it over-taxes the hardware you’re working on. 
As you are trying out different shots, trimming and adjusting clips, you need a proper feel for 
the pacing of a scene and the changes you’re making. A computer that isn’t able to process 
media efficiently at its current resolution can result in a frustrating editing experience.

If you plan to edit and color grade on the same computer, Resolve includes a convenient 
method for creating lower-resolution clips while retaining a relationship with the camera 
originals. Generating optimized media enables the speed you want when editing, yet leaves 
you only one click away from the camera-original media when you need it for color grading.
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1	 In the Scene 5 Smart Bin, select SF Bay Sunset Shot 15.

This clip is at 4000 x 2160 resolution and uses the Apple ProRes 4444 XQ codec. It is 
considerably larger than the other clips, and may therefore slow down your computer 
as you edit. You’d be well advised to generate optimized media for this clip. Before you 
do so, however you’ll want to configure the resolution and codec to be used to create 
the optimized file.

2	 Choose File > Project settings, or press Shift-9, and choose the Master settings category.

The Optimized Media and Render Cache area of the Master settings pane includes 
options for selecting the resolution and compression codec of the optimized media.

3	 Click the Optimized Media Resolution pop-up menu to view its options.

You can choose to scale down the clip by a specific percentage or allow the automatic 
setting to make the decision for you. Choose Automatically scales down only those 
clips that are larger than the timeline resolution. Such clips are scaled down to the 
current timeline resolution or as closely as possible to the original resolution. Clips at 
the timeline resolution or lower are not scaled.

4	 Choose Quarter.

Using this setting will create an optimized version of this file that is 1000 x 540 resolution.

5	 In the Optimized Media Format pop-up menu, choose ProRes 422 Proxy (macOS) or 
DNxHR LB (Windows).
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These two compression formats are low bandwidth, so they will provide better 
performance as you edit. 

Now you can return to the Media Pool and generate optimized media for the clip.

6	 Click Save to close the Project Settings window.

7	 With SF Bay Sunset shot 015 still selected, right-click the clip, and choose Generate 
Optimized Media.

The creation of the optimized file begins and a progress bar indicates how long it will 
take to process the clip. Once finished, the new media is stored on your cache disk in 
the first location set in the Media Storage panel of System Preferences.

Identifying Optimized Media
With a simple project such as you have here, it is easy to remember which clips you have 
optimized and which you haven’t. However, in a real-world project with dozens of bins and 
hundreds of clips, you’ll need a way to quickly identify optimized clips.

1	 Select the Scene 5 Smart Bin. Review the columns of the clips bin, and locate the 
resolution and codec columns.

For this optimized clip, the columns still display the camera-original resolution and 
codec. Remember, the optimized media did not replace the camera-original files. They 
still exist on your hard drive and are linked to these clips. So, Resolve continues to 
display the camera-original parameters.

TIP  To delete optimized media for an entire project, choose Playback > Delete 
Optimized Media.
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2	 Right-click any column heading in the bin, and in the list of column options, select 
Optimized Media.

The Optimized Media column displays None in the columns of clips that have no optimized 
media, whereas it displays the optimized resolution for clips that have been optimized. 

3	 Double click the SF Bay Sunset shot 015 clip to load it into the viewer.

You can easily switch between the optimized media and the original files in the 
playback menu. 

4	 Place the playhead near the middle of this clip so you can see a silhouetted profile of 
the cyclist.
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5	 Use your mouse scroll wheel to zoom in on the image to around 300%, or in the upper-
left corner of the viewer, click the magnification pop-up menu, and choose 300%.

6	 Hold down your middle mouse button and drag to reposition the image in the viewer 
until you can see the edge of the cyclist’s silhouette against the brighter background.

7	 Choose Playback > Use Optimized Media If Available to deselect the option.
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You should notice the compression artefacts disappear around the edges of the cyclist 
when you switch between the optimized media and the original clip. Let’s switch back 
to observe how the clip appears less sharp. 

8	 Choose Playback > Use Optimized Media If Available.

9	 In the magnification pop-up menu, choose Fit to return to viewing the entire frame in 
the viewer.

DaVinci Resolve displays one of the two files based on the menu choice. Choosing 
Optimized Media will help you work faster during the edit because Resolve won’t have to 
process the full image resolution, but you can quickly and freely switch to the high-
resolution image for grading or other purposes. 

Each project starts with a phase of importing and organizing footage. The features covered 
in this lesson highlight how DaVinci Resolve can benefit your post-production workflow 
before you even step into the cutting room.

Now you’ve seen some of the organizational aspects of working with Resolve, let’s look 
at some of the more advanced techniques you can employ during editing. 



117

Le
ss

o
n

 R
ev

ie
w

Lesson Review
1	 When using the clone tool, what is the default checksum type?

a)	 None

b)	 SHA 512

c)	 MD5

2	 True or False? You can save a preset of your current project settings for future 
project configuration.

3	 What methods can you use to auto sync sound to video files in the Media page?

a)	 Waveform

b)	 Timecode

c)	 Markers

4	 Which type of bin can you access across different projects in the same database?

a)	 Smart Bins

b)	 Super Bins

c)	 Power Bins

5	 True or False? Optimized media replaces your original media files.
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Answers
1	 c) MD5

2	 True. Project presets are saved in the Presets panel of the Project settings.

3	 a) Waveform and b. Timecode.

4	 c) Power Bins.

5	 False. Optimized Media is generated and stored in the first location set in the Media 
storage panel in DaVinci Resolve > Preferences, and is used when Playback > Use 
Optimized Media if Available is enabled.
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Editing a dialogue scene is often done by 
establishing the location and cutting 
between shots as they would play out in 
real time. Commonly known as continuity 
editing, this technique is centered around 
cutting between two (or more) shots, alter-
nating back-and-forth between each 
character as their dialogue and reactions 
warrant. In this lesson, you’ll apply this 
continuity technique to a scripted scene. 
You’ll start with one of the most firmly 
established conventions in cinema—the 
shot/reverse-shot—and see how DaVinci 
Resolve editing, match framing, and trim-
ming tools can speed up this classic 
editing style.

Lesson 4

Cutting a Dialogue 
Scene
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Selecting Your Best Takes
Editing is a series of choices. Your first choice is often to sort through the daily collection of 
clips and single out the best takes. After that, you can start to block out the scene.

Watching each take and choosing those parts that feature the best performances is often 
the most time-consuming part of your entire editing process, but it is also a critical step in 
becoming familiar with the available content available and identifying which shots might 
and might not work. In the Edit page, creating subclips is one way to help identify the best 
selections, or selects, within each clip. A subclip is a totally new instance of a clip that you 
create from a selection within a longer clip. By creating subclips of your content, you can 
avoid repeatedly sifting through long clips looking for a particular bit you remember. If you 
make subclips while locating the good bits within clips, you’ll instantly be able to find 
them again.

NOTE  When working in Resolve, you often have a choice of many routes to the 
same result. The workflows described in this book have proven to be creative, 
efficient, and flexible for each task. They also emulate workflows that many editors 
use on a regular basis. Ultimately, however, your preferred workflows will emerge 
from your own methods and experiences.

1	 In the Project Manager, right-click and choose Restore Project Archive. Navigate to 
R16 Editing Lessons > Editing Lesson 04. Click Open to restore the archive into your 
Project Manager.

2	 Open the project, and click the Edit page button, if necessary.

3	 In the Media Pool bin list, select the “Dailies day 02” bin. 

4	 Drag all three clips in this bin into the source viewer.

By dragging these clips into the source viewer at the same time, you can access 
them using the recent clips drop down menu at the top of the viewer. Doing so 
provides an easy way to switch between the last 10 clips you loaded in the source 
viewer without searching for them in the Media Pool.
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5	 If it’s not already open in the viewer, select 02_Dr_Sarah Close Up_.mov in the 
recent clips pop-up menu to load it into the source viewer.

This clip starts with a clapper and takes a good 20 seconds to get going. Instead of 
watching or scrubbing through the unusable range each time you return to this clip, you 
can make new subclips based on in and out points that you set.
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6	 Scrub through the clip until just before the woman enters from the left at around 

01:00:35:00.

7	 Play the take until she turns her head toward the camera and stop playback.

The director has decided that the bald male actor is not making the cut, but you 
can still use the remaining portion of the take. 

8	 In the source viewer, type 46. (period) on the keypad, and press Enter to move 
the playhead to 01:00:46:00. 
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This location is far enough into the clip to cut out most of the bald actor and makes 
for a good starting point for your subclip.

9	 Press I to mark an in point that identifies the start of your subclip. 

10	 Play the clip until you hear the director yell, “Cut,” at around 01:01:10:00, and mark 
an out point.

11	 To make a subclip based on these in and out points, choose Mark > Create SubClip, 
or press Option-B (macOS) or Alt-B (Windows).

In the Media Pool, in list view, look at the contents of the Dailies day 02 bin. You can 
see that a new clip is underneath its parent clip. Notice that the word “subclip” is 
appended to the file name. You might find it useful to keep these subclips in a separate 
bin so you don’t confuse them with the original source clips.
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12	 Select the Master bin, then choose File > New Bin, or press Shift-Cmd-N (macOS) or 

Shift-Ctrl-N (Windows) to create a new bin. Name this bin Subclips.

13	 Select the Dailies day 02 bin. Drag the 02_DrSarah_Close_Up_.mov subclip to 
the Subclips bin, and select the Subclips bin to see its contents.

14	 In the source viewer recent clips drop down menu, choose 04_DrSarah_Wide​
_Take 1_.mov to open it in the source viewer.

15	 Play the clip from the beginning and mark an in point when the bald actor begins 
to walk away at around 01:02:55:00.

16	 Press L twice to fast forward to the end of the clip where the director yells, “Cut” 
at around 01:03:50:00, and mark an out point.
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17	 Press Option-B (macOS) or Alt-B (Windows) to create another subclip in your currently 
selected Subclips bin.

18	 In the source viewer recent clips pop-up menu, choose 04_Wide_DrSarah​
_Take 2_.mov.

19	 Again, because this is a second take of the wide shot, play the clip from the beginning, 
and mark an in point when the bald actor begins to walk away.

20	 Press L twice to fast forward to the end of the clip where the director yells, “Cut,” and 
mark an out point.

21	 This time, drag the marked clip from the source viewer back into the Subclips bin in 
the Media Pool.

The new subclip is added to the bin.

Although a subclip is totally independent of its source clip, it does differ from placing a 
duration marker to identify a portion of a clip, which is a technique you may already be 
familiar with. Unlike ranges identified by duration markers, you can organize subclips 
into their own bins, load them into the source viewer, add metadata, and edit them into 
the timeline using any of the editing functions in Resolve. In effect, you’re treating them 
exactly like any other source clip.

TIP  You can convert existing in and out points into duration markers by 
choosing Mark > Convert In and Out to Duration Marker, or convert existing 
duration markers to in and out points by choosing Mark > Convert Duration 
Marker to In and Out.

However, remember that when you edit using a duration marker to identify a portion of 
a source clip, you still have handles available on either side of the marker after it is 
placed in the timeline. By default, a subclip has no handles beyond the initial in and out 
points you used to create it.
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Modifying Subclips
To simulate handles in a subclip, it’s useful to set your initial in and out points a little before 
and after the portion you want to subclip, thereby leaving a little bit of wiggle room when 
you later trim the clips.

However, when you find that you need a few extra frames extra not included in your 
subclip, you can always extend the boundaries of that subclip.

1	 Double-click the 04_Wide_DrSarah_Take 2_.mov Subclip to load it into the source 
viewer and see the full extent of the subclip you created in the previous steps.

2	 In the Media Pool, right-click the 04_Wide_DrSarah_Take2_.mov Subclip, and choose 
Edit Subclip.

In the dialog that appears, you can adjust the subclip’s start and end values or remove 
the limits of the subclip entirely.

3	 Change the New Subclip Start time to 10 seconds earlier, and click Update. 

The source viewer updates the positions of the in and out points to reflect this change, 
and the bald-headed man is once more included in this subclip.

Editing with Continuity
One method to use when cutting dialogue is to first identify which take is the master shot, a 
clip that represents a complete good take in terms of dialogue and action. Ideally, this clip 
can form the backbone of the scene. You can then replace part of that master shot with 
close-ups and reaction shots that build both time and space continuity.

TIP  When you don’t have one shot that works as a master shot, you can assemble 
a very rough cut that effectively blocks out the scene and represents a clear idea 
of the target.
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In the following exercise, a quick master shot timeline was created for you.

1	 In the timelines bin, double-click the “01 Edit Start” timeline to open it in the timeline viewer.

This timeline will act as the master shot for this scene. Let’s play it to see how the scene 
should unfold. 

2	 Play the timeline from start to end.

This master shot focuses on the FBI agents, so it is up to you to add reverse angle 
shots of the doctor. Some editors call the next step “removing the air;” but, more 
precisely, it consists of eliminating unnatural intonations or pauses in the dialogue 
when you cut between reverse angles.

3	 In the timeline, navigate to the cut point between the first two clips, and mark an 
in point.

4	 Play the clip until the FBI agent says the doctor’s name, and you hear her off-screen 
response, “Yeah?” Mark an out point just before the agent speaks again, around 
01:00:11:20.

5	 In the Subclips bin, double-click 02_DrSarah_Close Up_.mov Subclip to open it in the 
source viewer.

Let’s start by marking an out point because it will be easier to locate.
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6	 Play the clip until the doctor turns her head, and mark an out point just after she says, 

“Ah yes?”

You need just a bit of this clip to show the party scene and introduce the lead female 
character.

7	 In the source viewer, type -3. (minus sign, 3,period), and press Enter to move the 
playhead back three seconds.

Because this dialog is just incidental chit-chat before the doctor turns, you can place 
an in point here.

8	 Press I to mark an in point.

Unfortunately, you have a slight timing problem here: all four marked points are well 
placed, but the resulting durations of your two selections differ. You can preview the 
edit using the preview marks.

9	 Choose View > Show Preview Marks.

The preview marks display a virtual outpoint in the timeline ruler to indicate where 
the source clip’s out point will land. 
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10	 Press F10, or click the Overwrite Clip button above the timeline.

Performing an overwrite edit limits the edit based on the shorter source clip and leaves 
a long pause as the FBI agent walks into frame. If you were to proceed with this edit, 
you would have to trim the pause to correct for the continuity of the scene.

11	 Choose Edit > Undo, or press Cmd-Z (macOS) or Ctrl-Z (PC)

Fortunately, Resolve has a unique edit called ripple overwrite that will overwrite the 
source clip and appropriately trim the timeline with just one click. The ripple overwrite 
replaces a selection in the timeline with a clip of a different length and does so without 
opening a gap or overwriting the adjacent clip .

12	 Choose Edit > Ripple Overwrite or press Shift-F10 to perform the ripple overwrite edit.

In the timeline, play over the edit to verify that you have successfully overwritten the 
unwanted part of the clip with a shot that introduces the doctor. This time, the frames 
between the preview mark and the timeline’s out point were automatically removed by the 
ripple overwrite edit.

You’ve just used a continuity editing style by alternating shots between the doctor and the 
FBI agents. These shot/reverse shot sequences create a sense of space by matching the 
characters’ eyelines along the axis of action (that is, the 180-degree line). The FBI agents are 
looking to the left at the doctor, and in her shot, the doctor is looking to the right at the agents.
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Match Frame with an Offset
Let’s try another example of continuity editing by cutting in another reaction shot of the 
doctor. This time you’ll use Resolve’s match frame feature to keep the source clip and 
timeline in sync, making it easier to cut in reverse angles.

1	 In the timeline, position the playhead at the end of 02_DrSarah_Close Up_.mov Subclip.

2	 Play the timeline for roughly 10 seconds until you hear the off-screen doctor, say, 
“I’ll catch up with you later.”

You need a reaction from the doctor to indicate that the FBI is showing up at her party, 
and you want to end the reaction shot in time to cut back to the FBI agents to get their 
impatient reactions. 

3	 Position the timeline playhead after the FBI agent says, “We need you to come with us right 
away” and before the doctor says, “Umm.”, roughly three to four seconds from the last cut.

4	 Press I to mark an in point in the timeline.

At this point you can turn your attention to the source clip that you want to cut in. 
Because the dialogue is the same on both the doctor’s close-up in the source viewer 
and the FBI agent’s shot in the timeline, you want to pick up the source clip dialogue in 
a spot that roughly matches your timeline playhead location. Resolve has a very nice 
match frame feature to do just that.
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5	 Without moving the timeline playhead, in the timeline, Option-double-click (macOS) 
or Alt-double-click (Windows) anywhere on the previous 02_DrSarah_Close Up_​
.mov Subclip.

The 02_DrSarah_Close Up_.mov Subclip is loaded in the viewer with the previously 
marked in and out points used to edit the clip into the timeline. 

The playhead in the source viewer is offset from the out point by the same three to four 
seconds that you moved the timeline playhead. This is where the doctor starts to react 
to the FBI and her assistant stops speaking. It’s a good place for your in point.

6	 Press I to mark an in point in the source viewer. 

Let’s place the out point after the friend asks if the doctor is OK, and the doctor turns away.
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7	 Play the clip in the source viewer, and mark an out point just after the doctor turns her 

head, but before she says, “Yeah, yeah,” at around 01:01:02:18. 

This time, a preview mark appears in the timeline showing us the implied outpoint. 

8	 Play forward in the timeline, and set an out point just after the doctor’s assistant asks, 
“Is everything ok, Sarah?” but before the doctor starts to reply.

9	 Press Shift-F10 to perform a ripple overwrite edit. 

Now you have placed your shot/reverse shot to move this dialogue scene forward. 
Let’s review the edits.

10	 Press the Home key, and play the timeline to review your edits. 

This type of shot/reverse shot juxtaposition is the most common technique used to initially 
block out your scene. That’s why the ability to keep the same offsets between source and 
timeline using the modified match frame feature is a major time saver.
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Auditioning Multiple Takes
When cutting dialogue, you can easily fall into the trap of cutting based solely on words. 
But dialogue editing is trickier than that. You must not only pay attention to the words; but 
also, the eyes, the mouths, and the body language of the performers. All of these 
performance elements are essential to establishing the emotion of a scene. So, even 
though your cut may maintain dialogue continuity, you might want to search out alternate 
takes that feature superior performance elements.

Comparing different takes often means repetitively revising your timeline. DaVinci Resolve 
makes this process a lot easier with the take selector.

1	 In the timeline, position the playhead at the second shot in your timeline, the 
02_Dr_Sarah_CloseUp.mov Subclip.

The director feels that this shot doesn’t effectively introduce the party and wonders 
how the wide shot might look in its place.

2	 In the Subclips bin, double-click the 04_Dr Sarah_Wide_Take 1_mov Subclip to open 
it in the source viewer.

3	 Play the first half of the subclip to review it and refamiliarize yourself with the take.
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4	 Mark an in point just before the FBI agent walks into shot at around 01:02:59:00.

5	 Mark an out point when the Doctor turns and says, “Yeah,” at around 01:03:03:00.

To audition this take in the timeline without actually replacing the current close-up shot, 
you can use Resolve’s Take Selector.

6	 In the timeline, right-click 02_Dr_Sarah_close up, and choose Take Selector.

The Take Selector acts as a container for multiple clips. While you’ll see only one of 
those clips when you play the timeline, you can switch between the clips at any time.
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7	 From the source viewer, drag the 04_Dr Sarah_Wide_Take 1.mov Subclip onto the 
Take Selector clip in the timeline.

TIP  The rest of the timeline is inactive when the take selector is in use.

The Take Selector now shows the two clips stacked on top of each other. You can add 
as many takes as you want to audition.

8	 In the Subclips bin, double-click the 04_DrSarah_Wide_Take 2_.mov Subclip to open 
it in the source viewer.

9	 Mark an in point at roughly the same part of the shot as in the previous take, just before the 
FBI agent walks into shot; and mark an out point when the doctor turns and says, “Yeah?”

10	 From the source viewer, drag the 04_DrSarah_Wide_Take 2_.mov Subclip onto the 
Take Selector clip in the timeline.
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TIP  You can also drag the clip from its bin in the Media Pool directly into the 
Take Selector.

Now all three takes are visible in the Take Selector. The initial clip is still the active take, 
but you can change that by clicking the clip you want to view in the timeline.

TIP  The currently selected take in the take selector is actually the clip with the 
dullest brightness, thereby matching the other clips in the timeline.

11	 In the Take Selector, click the middle clip in the stack to view it in the timeline.

12	 Press the / (slash) key to play over the new take.

The new clip conforms to the duration of the original clip in the timeline. However, in 
the Take Selector stack, you can see that the new take is longer than the original clip. 
When you select a take that is shorter or longer than the original clip, you can ripple 
the timeline to adjust to the new take’s length.

13	 In the upper-right corner of the Take Selector, click the Ripple button.

The timeline adjusts to fit the longer take.

14	 Move the playhead to the start of the clip, and click play to review the rippled timeline.

15	 In the Take Selector, click the upper clip to view it in the timeline.

16	 Move the playhead to the start of clip, and play to review this take.

The director believes that the middle wide-angle take introduces the party scene most 
effectively, so you’ll make the new take a permanent part of the timeline.

17	 In the Take Selector, click the middle clip to choose that take.
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18	 In the upper-left corner of the Take Selector, click the close button to collapse the Take 
Selector stack.

19	 Right-click the clip, and choose Finalize Take.

Finalizing the take removes the Take Selector and all of the alternate takes from the 
timeline. However, you don’t necessarily have to finalize the take. You can leave the 
alternate takes within the Take Selector to review again later. If you choose not to finalize 
the take, you can reopen the Take Selector stack by double-clicking the Take Selector icon 
in the lower-left corner of the clip in the timeline.

Going beyond the straight cut
A straight cut, with which audio and video start and end simultaneously, can be quite 
abrupt and a little jarring. A split edit, often referred to as an L-cut or J-cut because of the 
implied shape it creates in the edit, delays either the audio or video cut of a clip. Staggering 
the cuts in this way can create a more natural transition between shots.

J Cut L Cut

The most common split edit is the J-cut with which you first introduce the sound of the next 
shot and then cut to the picture a beat or two later. This is the way that most of us perceive 
the world around us. For example, when you hear a car horn in the street, you look for the 
source of that sound a fraction of a second later. An L-cut leads with the image and then 
cuts in the audio. It is often used when you want to show a character’s reaction to 
something happening or being said.

In Resolve, you have multiple ways to create J- and L-cuts. Let’s look at a J-cut split edit in 
which you hear upcoming clip audio first, and then see the picture.
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Extending an Edit
To begin a series of trimming exercises, you will use a timeline with a few edits already 
made. This first exercise focuses on a quick and, common way to create a split edit using 
the playhead as a guide to extend the video or audio of a clip.

1	 In the timelines bin, double-click the 02 Trim Start timeline to load it into the timeline 
window.

This timeline is a continuation of all the editing you performed in this lesson. It includes 
a few additional cuts that you can use to practice some advanced trimming techniques.

2	 In the timeline, select the cut at the first white marker at the second and third clips in the 
timeline, the 04_ Dr Sarah_ Wide. mov Subclip and 05_Wide_ Agents_ Take 1_.mov.

This is the end of the Take Selector clip that you recently changed. Selecting the cut 
prepares it for a rolling trim with the green highlight on both sides of the cut.

3	 Press the / (slash) key to review this edit.

As the FBI agent introduces himself, it might be better to extend the Dr.’s clip so you 
can see her reaction. You can do so by positioning the playhead where you want the 
new video cut to occur.

4	 In the timeline, drag the playhead to the frame where the male FBI agent begins to turn 
his head to introduce his partner.
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To move just the video edit and not the audio, you must unlink the audio and video 
segments. You can do so by disabling the link button in the toolbar, or with a modifier 
click in the timeline.

5	 Hold the Option-click (macOS) or Alt-click (Windows) the video cut that you want to extend.

Option/Alt-clicking is a temporary method for disabling the Link button for a single 
click. Now you have the video selected as a rolling trim and you are ready to extend 
the cut to the playhead location.

6	 Choose Trim > Extend Edit, or press E.

The extend edit moves the selected video edit point to the position of your playhead in 
the timeline. In this case, you perform an instant rolling trim and create a split edit.

7	 Press / (slash) to review the new split edit.

That edit now feels very natural in that you see the doctor react to the FBI agent’s 
introduction, while the FBI agent’s line of dialogue motivates the picture cut a second 
or so later. Let’s use an extend on the other end of the FBI clip.

8	 Press the Down Arrow key to move to the second white marker at the end of the 
FBI shot.

9	 Press the / (slash) key to review the edit.

Let’s trim this cut so you see her reaction sooner.

10	 Position the playhead right after the FBI agent says, “We need you to come with us,” 
but before he continues saying, “Right away.”
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11	 Option-click (macOS) or Alt-click (Windows) the video cut that you want to extend.

The video is selected as a rolling trim and you are ready to extend the cut to the 
playhead location.

12	 Choose Trim > Extend Edit, or press E.

The extend edit moves the selected edit point to the position of your playhead in 
the timeline.

13	 Press / (slash) to review the new split edit.

Creating simple split edits using extend is a quick and straightforward editing 
technique that is used all the time; not just in dialogue scenes such as this, but in 
editing across all genres.

Trimming On-the-Fly
The extend edit is a fast trimming style that works with ripple trims as well as rolling trims. 
It’s even faster than you have currently experienced because it can be performed as you 
play the timeline. Let’s explore this by working on the next cut in the timeline. 

1	 Press the Down Arrow twice to move to the third white marker between 
02_Dr_Sarah_Close_Up.mov Subclip and 05_Wide_Agents_Take 1_.mov.

2	 Press the / (slash) key to review the edit.

This transition has a line that is repeated in both the outgoing and incoming clips. Let’s 
remove the line where the doctor says, “Yeah, yeah,” from the outgoing clip, and leave 
the impatient FBI reaction shot as it is. Doing so requires a single-sided ripple trim, so 
you’ll need to switch to trim mode, and then move the cut selection to the outgoing 
side. You can do all that using keyboard shortcuts for added speed.

3	 Press the T key to select the trim mode.

4	 Press the U key to change the trim selection from a rolling trim to a single-sided 
ripple trim. 

The U key is a three-way toggle that cycles through the trim selection states: rolling 
trim, single-sided ripple trim from the incoming clip, and single-sided ripple trim for the 
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outgoing clip. Currently, the incoming side is selected, but pressing the U key again still 
selects the outgoing side of the cut.

5	 Press the U key a second time to select the incoming side of the cut.

6	 Under the timeline viewer, click the loop button, or press Cmd-/ (slash) in macOS or 
Ctrl-/ (slash) in Windows.

With loop play activated, Resolve continuously plays whichever playback option you 
choose. To loop play over the trim point, let’s play the selection.

7	 To review the edit, press / (slash) to loop play the selection.

8	 While looping in the timeline, press the E key to mark a new out point after the doctor 
turns to face her friend, but before she says, “Yeah, yeah.”
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9	 Let the selection loop play a few times and modify the edit by pressing either , (comma) 

to remove a single frame from the tail or . (period) to add a single frame to the tail.

10	 When you feel the edit is right, press Spacebar to stop playback.

The rhythmic beats of your audio and the associated sound edits contribute 
significantly to the pacing and mood of a scene. Trimming on-the-fly is one way to 
realize the most natural and organic feel with that rhythm.

Let’s continue practicing trimming on-the-fly with this cut. You’ll bring the video cut 
back a bit to see a little more of the FBI agent’s reaction, and make the selection in the 
timeline using keyboard shortcuts.

11	 Press U to cycle the selection until both sides of the cut are selected, as indicated by 
the green highlight.

12	 Press Option-U (macOS) or Alt-U (Windows) to select only the video track for trimming.

Just as pressing the U key toggles the side of the cut to trim, pressing Option/Alt-U 
toggles through the tracks to trim.

13	 To loop playback, press / (slash).

14	 After the doctor says, “Sure,” press the E key to roll the video edit back a second or so 
to create an L-cut.

15	 Let the selection loop a few more times and modify the edit by pressing either , 
(comma) to roll the edit back one frame or . (period) to roll it forward one frame.

16	 Press the Spacebar when you have finished perfecting your edit.

17	 In the toolbar, select the selection tool, or press A.

By this point, you should be well aware that J- and L-cuts are all about keeping the edit 
flowing seamlessly. Offsetting the audio or video cuts from each other even slightly 
allows you to keep the dialogue moving forward while giving the audience a peek at 
the reaction of other characters, thereby helping to knit the whole edit together.
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Putting Yourself to the Test
OK, let’s see how well you do on your own with just a few simple instructions. The next two 
white markers in the timeline are cuts that also need refinement. Using the keyboard shortcut 
methods you just learned, see if you can make smooth split edits with these two cuts.

Here are some simple instructions to follow:

1	 Move the playhead down to the fourth white marker.

2	 Press the V key to select the cut.

3	 Review this edit.

4	 Use keyboard shortcuts to select the video track and extend the FBI agents after the 
doctor says, “My help?”

5	 Use keyboard shortcuts to move to the next edit.

6	 Review this edit.

This edit requires two changes:
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7	 Ripple trim the incoming FBI agent shot to remove the audio of the doctor speaking.

8	 Extend the incoming doctor shot after the FBI agent says, “OK.”

Enabling Dynamic Edit Mode
Extending a cut on the fly is just one way to trim while playing over an edit. You can also 
trim dynamically using the familiar JKL keys you have probably used to play forward and 
backward through the timeline.

1	 Drag the playhead down to the sixth white marker.

2	 Press the V key to select the nearest cut.

3	 Review this edit.

For this cut, the director wants to remove the first two lines of the FBI agent. The director 
would like to start when the FBI agent takes a step forward and says, “I need you to tell 
me everything about the Syncs.” 

4	 Press the U key until the incoming FBI side of the edit is selected.
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5	 Press T to enable trim edit mode, if necessary.

6	 In the toolbar, click the dynamic edit mode button, or press W

The dynamic edit mode can give you a feel similar to the “live trim” rhythm you 
experienced when trimming on the fly. However, enabling dynamic edit mode may give 
you a bit more trim control because you can use the JKL keyboard shortcuts.

7	 Press the K and L keys together to begin trimming slowly forward until the FBI agent 
finishes his second line, “Because it is happening.”

Pressing the K and L keys together trims while playing half-speed forward. 

When dynamic edit mode is enabled, the Spacebar triggers the Play Around Current 
Selection command. 

8	 Press Spacebar to review the edit.

All of the trimming functions you are used to, such as slip and slide, are available to you 
in dynamic edit mode. 

9	 Press the Down Arrow to move to the last cut in the timeline.

To make this ending shot more dramatic and lead the audience into the next scene, 
let’s move the last shot of the sync robot so it appears over the FBI agent saying, “We 
need to know everything.” One way to do so is to slide the last clip back over the FBI 
agent video. You can easily do so using keyboard shortcuts to select the entire clip, 
and then slide it back using dynamic edit mode.

10	 Press Shift-V to select the entire clip instead of just the cut point.

When a clip is selected. the toolbar button for the dynamic edit mode changes to show 
you whether you’re in slip or slide mode.
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11	 Tap the S key until the dynamic edit mode button in the toolbar becomes a slide icon.

12	 Press the J and K keys together to slide the last clip back until the FBI agent begins to 
say, “We need to know everything.” If you go too far back, press the K and L keys to 
slide the clip forward.

13	 Press Spacebar to review the edit.

14	 When you are done with the change, press the W key to disable dynamic edit mode, 
and press the A key to return to the selection tool.

While this lesson has been about editing dialogue, its underlying theme is continuity. 
Continuity editing involves matching screen direction, position, and temporal relations from 
shot to shot. The extend edit, trimming on-the-fly, applying ripple overwrite editing, and 
using the take selector are just a few of the many Resolve features that support this single 
most important principle of editing.
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Lesson Review
1	 What methods can you use to create a subclip from a marked duration of a clip in the 

Edit page?

a)	 Drag the clip from the source viewer to the Media Pool.

b)	 Press Option-B (macOS) or Alt-B (Windows).

c)	 In the Source Viewer Options menu, choose Make Subclip.

2	 What do the preview marks on the timeline indicate?

a)	 They show where you can add markers.

b)	 They help determine where clips will be placed when making a three-point edits.

c)	 They show where text and graphics will align on the timeline viewer.

3	 True or False? Ripple Overwrite is a three-point edit.

4	 True or False? To extend a cut on-the-fly while playing you must enable Dynamic 
Edit mode.

5	 True or False? All clips in the take selector should have the same duration.
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Answers
1	 a) and b) You can create subclips by choosing Mark > Create Subclip, and right-clicking 

the Source Viewer jog bar; then choose Create Subclip, press Option-B (macOS) or 
Alt-B (Windows), or drag the subclip from the source viewer into the Media Pool.

2	 b) Preview marks help you determine where clips will be placed whenever you execute 
a three-point edit.

3	 False. Ripple overwrite is a four-point edit that you use when the duration of the 
marked source clip is different from the duration marked in the timeline, and when 
you want the timeline to ripple to accommodate the difference in duration.

4	 False. To use JKL keys to trim, you must enable dynamic edit mode. Extend edit while 
playing is always available.

5	 False. The Take Selector can contain clips of different durations. When switching 
between these clips, you can enable the ripple take button in the upper-right corner 
(to the left of the trash can button).
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Being able to get the very best out of your 
interview subject takes a lot of practice and 
a good ear for the spoken word.

When cutting interviews, it’s common to 
create the best-sounding interview and 
almost completely disregard the visuals until 
that first rough cut is done. This cut is called 
a radio edit because it is similar to editing an 
audio-only interview. Once you have the 
interview audio cut properly, you can turn 
your attention to the video edits, often 
referred to as the paint because you are 
illustrating, or “painting,” your interview with 
appropriate pictures from your b-roll rushes.

In this lesson, you’ll use advanced audio 
and video trimming and other workflow 
features in DaVinci Resolve to finish an 
engaging one-minute promotional piece 
for a vegan restaurant.

Lesson 5

Making A Radio Edit
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Examining Audio in a Radio Edit
Let’s begin by opening a project with most of the radio edit already cut, but including some 
clips in which the audio hasn’t been examined for clarity. You’ll play the clips, and then 
begin to identify and remove the small stutters and stray “umms” to get the best statement 
from your interview subject.

1	 In the Project Manager, right-click and choose Restore Project Archive. Navigate to 
R16 Editing Lessons > Editing lesson 05. 

2	 Open the the project from the Project Manager, and click the Edit page button, 
if necessary.

3	 In the Media Pool, select the Timelines bin, and double-click the “01 Radio Edit start” 
timeline to open it in the timeline window.

This part of an interview with Miss Rachel, chef at the vegan restaurant, consists of 
three short sound bites.

4	 Play the timeline to hear the three clips.

When creating a radio edit, you want to remove any large or small bits of audio that 
may detract from the message. These three clips, include a number of places where 
her words could be tightened to improve her conversational flow. You’ll be looking at 
different techniques you can use to remove parts of this interview. As always, you’ll 
need to consider which techniques work best for you.

5	 Play the first orange clip again and stop playback when you hear the first time that the 
interview subject says, “Umm,” around two seconds from the beginning.
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6	 Using the Timeline View Options menu, expand the size of the audio track so you can 
clearly see the waveform. You may also want to zoom into the location of the playhead 
by pressing Cmd-= (equals sign) in macOS or Ctrl-= (equals sign) in Windows a couple 
of times. Now you should be able to clearly identify the problematic “Umm.”

7	 Press the B key to switch to razor edit mode. Click just before and just after she 
says, “Umm.”
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Doing so has isolated the “Umm” into a separate clip. The dotted lines on the edit 
points represent through edits; that is, edits that are visible on the timeline but playback 
smoothly because no frames have been removed from either side of the cut. The edits 
were also added to both the audio and video parts of the clip because the timeline-
linked selection was active.

TIP  To remove an unwanted through edit, in the timeline, place your playhead 
after the through edit, and choose Timeline > Join Clips, or press Option-\ 
(backslash) in macOS or Alt-\ (backslash) in Windows.

8	 Return to Selection mode by pressing A. Select the “Umm” clip, and press Shift-Delete 
(or Backspace) to perform a ripple delete.

9	 With your playhead over the new edit point, press / (slash) to play the edit.

You’re aiming to have this audio edit be as inconspicuous as possible. When you play 
around the current edit, try listening to the cut without watching the picture. Does it 
sound as if an edit is there? If it does, you’ll need to do a little finessing, which you’ll be 
looking at soon.

TIP  When you perform an edit, you can’t know how successful it’s going to 
be until you playback your timeline. It’s highly doubtful that things will be 
perfect straightaway (though happy editing accidents have been known to 
occur). In reality, most edits you’ll perform will always need to be improved 
with a few trims here and there.

10	 Continue playing what is now the second orange interview clip until you hear the next 
problem where she says, “We’re taking dishes and flavors.” She stutters and says the 
word “and” twice. It’s a simple task to tidy this up.

11	 Press the JKL keys to play forward and backward over the clip, finally positioning the 
playhead just before the first “and”.

TIP  Remember that you can jog the playhead back and forth by holding down 
the K key and tapping the L or J key. It’s also useful to have audio scrubbing 
turned on so you can hear the starts or ends of words. Choose Timeline > 
Audio Scrubbing, or press Shift-S, to toggle audio scrubbing on and off.

12	 Press Shift-V to select the clip under the playhead.
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13	 Press Cmd-B (macOS) or Ctrl-B (Windows) to add a through edit to the selected clips.

TIP  Pressing this keyboard shortcut adds an edit point to a selected clip or 
clips at the playhead position. It’s a little more precise than clicking to add a 
cut in razor edit mode.

14	 Jog forward until the playhead is located before she says the second “and.” 
Press Cmd-B (macOS) or Ctrl-B (Windows) again to add a second through edit.

15	 Move your playhead over the isolated “and” in the timeline. Press Shift-V to ensure that 
the clip is selected, and press Shift-Delete (or backspace) to ripple delete the clip.

16	 Press / (slash) to play around the new edit.

Again, try listening to the edit without looking at the jump cut you’ve just created. 
Remember, you’re trying to create a natural-sounding interview that won’t distract 
the audience. Don’t worry if the current edit is not as smooth as you would like; 
you’ll finesse it soon.
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17	 Keep playing through the interview. The next portion you’re going to remove is the 
“Umm” just after she says “textures.” This time you’re going to place timeline in and out 
points to remove this unwanted portion of the interview.

18	 In the timeline, place your playhead at the start of the “Umm,” and press I to add an 
in point.

19	 Jog the playhead forward six or seven frames until you hear her start to say, “and really 
making them.” Press O to set an out point just before she says, “and.”

TIP  Because Resolve’s playhead is inclusive of the current frame, in points are 
always added to the head of the frame and out points are added to the tail of 
the frame. When adding out points, it’s often useful to find the frame you want 
to keep (usually at the start of the next word) and then move the playhead one 
frame back before adding the out point. By doing so, you’ll be sure to keep the 
frame you wanted.

You’ve now set in and out points around the portion of the interview you want to remove. 

20	 Press Shift-Delete (or backspace) to ripple delete the contents between the in and 
out points in the timeline.

21	 Press / (slash) to preview your new edit.

For a little extra credit, the director has also asked if you could tidy up the end of the 
orange clip; she doesn’t like the interviewee’s use of the word “palatable” to describe 
the food. This is a slightly more subjective cut; but when trying to put together the best 
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description of the food at the restaurant, it may be desirable to aim higher than simply 
“palatable.” Do you think you’d be able to edit out the words “palatable and” so that 
she simply says, “making them delicious”?

Trimming using Keyboard Shortcuts
Resolve 16 has very complete roll, ripple, slip, and slide trim commands that you can 
perform using the mouse. However, when you’re making small, subtle changes to an 
edit—often adding or removing single frames—it’s useful to perform most of your trimming 
using keyboard commands. In doing so, you’ll exercise the most precise control over each 
of your edits. Learning how to get the best from Resolve’s trimming options is an important 
step in choosing the best technique for any given situation. 

As in the previous lesson you’ll exclusively use keyboard shortcuts to move and select the 
cut points you need to trim.

1	 Position the playhead at the start of the orange clips.

2	 Press the Down Arrow to go to the first cut in that clip.

3	 Press / (slash) to preview the edit.

Listen closely to the audio edit you created in the previous steps. Does it sound like a 
natural, continual part of her speech pattern? Identifying how to adjust the edit 
effectively, whether to add or remove frames from either the outgoing or incoming 
clips, is a skill that will only come with practice.

4	 Press T to enter trim mode.

5	 Press V to select the cut for trimming. Then press the U key until only the outgoing (left) 
side of the cut is selected for ripple trimming.
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TIP  Press V to select the edit point nearest the playhead on the highest auto 
select-enabled track; and press U to toggle between the trim operations for 
the currently selected editing mode.

6	 Press , (comma) to trim the selected edit one frame to the left or . (period) to trim it 
one frame to the right.

TIP  Because you’re concentrating on the audio in these clips, it’s useful to 
keep an eye on the clip waveforms to see if you’re adding or removing parts 
of words.

7	 If necessary, press U twice to change the trim to the head of the incoming shot, 
and press , (comma) or . (period) to add or remove frames.
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8	 Press / (slash) to play around the cut point and check your trim decision.

TIP  Press Shift-, (comma) or Shift-. (period) to perform a nudge operation that 
trims multiple frames at once. The default value is five frames, but you can 
change this value by going to DaVinci Resolve > Preferences, selecting User 
Settings, and adjusting the Pre-Roll and Post-Roll times in the Editing panel.

Continue to refine the edit until you are happy with the results. Then you can move 
on to the next cut.

9	 Press the Down Arrow to go to the next cut in your timeline. This edit is selected in 
the direction you last had the previous edit selected.

10	 Press / (slash) to play around the cut point and to determine what you need to trim.

11	 Decide if the edit needs to be refined or not, and press U to change to the appropriate 
trimming operation.

12	 Press the , (comma) or . (period) keys to refine the edit, adding or removing frames from 
either the tail of the outgoing clip or the head of the incoming clip. 

13	 Press / (slash) to review your trim. 

When the audio edit sounds good, move on to the next cut. 

14	 Press the Down Arrow to go to the next cut in that clip.

15	 Press / (slash) to play around the cut point and identify what you need to trim.

16	 Press U to toggle the edit direction, and press , (comma) and/or . (period) to refine 
the edit.

17	 Press / (slash) to review your trimming.

18	 When you have finished, press A to exit trim mode and return to the selection tool.
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You have refined a small part of this interview using various techniques to remove 
unwanted parts of what the subject says and refining the rest into a succinct description of 
her business. When chipping away at a longer cut with the goal of making it shorter, these 
keyboard-oriented trim commands enable you to see and hear a trim as you make it which 
can be invaluable!

Feel free to keep on practicing on the two additional orange clips in this timeline.

Editing Subframe Audio
While video trimming is limited to a project’s framerate (24 fps in this project), audio is 
captured using tens of thousands of samples each second. DaVinci Resolve includes the 
ability to edit audio at this subframe level which enables a much more detailed ability to 
trim. Access to subframe audio editing means that you can separate subtle syllables or 
words that are slurred and make them sound clean and clearer. Let’s use subframe audio 
editing to smooth some of the dialogue in the last of your three clips.

1	 	Place the playhead over the start of the last orange clip in the timeline.

2	 Play over the clip.

Listen carefully and you’ll hear her say, “Cutting things out...ahh, when in reality”. That 
long “ahh” runs right into the word “when.” You’ll be able to see this clearly if you zoom 
in tightly around this area of the clip.

3	 Position the playhead when the chef begins to say, “When in reality.”

4	 In the toolbar, use the magnification slider to zoom in all the way.
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5	 Drag back and forth over the words “Ahh, when in reality.”

6	 To remove the word “Ahh,” mark an in and out point around the word “Ahh.”

The in and out points must adhere to a frame boundary so you can never clearly mark 
just the word “Ahh” without getting some of the word “when” that comes after it.

7	 Choose Mark > Clear marks to remove the in and out points.

8	 To access subframe audio editing, press N to disable snapping and press Shift-Cmd-L 
(macOS) or Shift-Ctrl-L (Windows) to turn off linked selection.

9	 Enable the selection tool by pressing A.

10	 Position the playhead just before the word “Ahh,” and use the blade tool to create a 
through edit in the audio track.
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11	 Switch to the selection tool, and trim the audio to remove the word “Ahh.” You will need 
to trim between four and five frames.

The tool tip will hold on numbers for a while as you drag, because the portion of 
the audio you are trimming is within the duration of a video frame.

12	 Press / (slash) to play around the selected cut and hear your cleaner edit.

13	 When you are happy with your trimming, reenable snapping and linked selection in 
the timeline.

Now that you’ve trimmed the audio in your project at the subframe level, you’ve learned 
how to apply a greater degree of audio control. 

Continue refining this timeline, practicing the techniques you’ve learned so far in this 
lesson. When your radio edit is finished, you’re ready to add the paint, or b-roll, to cover 
holes and visual jump cuts. That said, you can still apply plenty of tricks to help massage 
the footage into the exact shape you want and make your story as engaging as possible.

Using Stacked Timelines
You can use this cleaned up radio edit in the much longer interview you already edited. To 
edit one timeline as a source into another timeline, it’s often easier to see more than one 
timeline at the same time. The Edit page timeline can be divided into tabs or stacked with 
one timeline on top of another.

1	 Press Shift-Z to see the entire timeline.

2	 Select the Timeline View Options menu, and choose the first option to enable 
stacked timelines.
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When the stacked timelines button is enabled in the Timeline View Options, an add 
timeline button appears in the far-right corner of the timeline window.

3	 In the upper-right corner of the timeline, click the new stacked timeline button.

A second timeline window appears below your original radio edit timeline.

4	 In the lower timeline window, from the Select Timeline pop-up menu on the empty 
timeline tab, choose the “02 with B Roll” timeline.

TIP  You can open more tabs by clicking the + (plus sign) button to the right of 
your timeline tabs, and close existing tabs by clicking the X next to the name of 
each tabbed timeline. You can also drag timeline tabs horizontally to change 
their order.

5	 Play through the bottom timeline to view the full interview.

You’ll insert a portion of your radio edit interview into this longer interview. Let’s first 
position the playhead in the longer interview where you will insert the radio edit.

6	 In the longer interview, move the playhead between the navy-colored and the violet-
colored clips near the end of the timeline.

Now, you’ll focus on selecting the portion of the radio edit interview you want to insert.
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7	 In the uppermost radio edit timeline, position the playhead at the start, and mark an 
in point.

8	 Play the radio edit to about midway, when you hear the chef say, “It’s kind of coming to 
a new level.”

9	 Mark an out point after the word “level,” but before the chef says the next word.

10	 With the area of the radio edit selected, choose Edit > Copy, or press Cmd-C (macOS) 
or Ctrl-C (Windows).

11	 Click the With B-Roll tab to activate the lower timeline.

12	 Disable the Auto Select button on video track 2 and on as audio tracks 2 and 3 so 
the B-Roll, music, and sound effect tracks are not rippled down the timeline from the 
inserted new clips.

13	 Choose Edit > Paste Insert, or press Cmd-Shift-V (macOS) or Ctrl-Shift-V (Windows).

The copied portion of the radio edit is inserted at the playhead position in the full 
interview timeline. You can now close up the stacked timelines and continue editing 
with the longer interview.

14	 Open the timeline view options menu, and click the stacked timelines button again to 
return to a single timeline view.
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Editing from a Source Timeline

Another technique favored by many editors is to open the timeline of rushes in the 
Edit page source viewer, mark the appropriate part of the footage, and edit as 
normal using overwrite, insert, and so on. You can also see the source timeline by 
choosing Timeline > Swap Timeline and Source Viewer.

By utilizing Resolve’s tabbed and stacked timeline views, you can easily edit the contents 
between different timelines. By using this technique, you have created separate versions of 
these clips in your new timeline that you can trim and adjust without disrupting or changing 
your original edits.

Decomposing Timelines
Another way to edit one timeline into another is by dragging from the Media Pool directly 
into the timeline window. When editing in this manner, you create a compound clip that 
appears as a single source clip in the timeline.

1	 From the Timelines bin, drag the 03 Titles timeline to the end of the “02 with B Roll” 
timeline in the window.

This title timeline includes three separate titles but appears as a single compound clip 
when added to an existing timeline. A compound clip can make it easier to manipulate, 
add effects to, color correct, and move multiple clips in a timeline because it is treated 
as a single source clip.

2	 Play over the newly added titles in the timeline.

You can reveal all the edits in a compound clip by decomposing it.
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3	 In the timeline, right-click the 03 titles compound clip, and choose Decompose in Place.

The compound clip is removed and the three original titles are displayed. Although 
compound clips provide some convenience by treating multiple clips as one, having 
the titles independent in the timeline allows you to better fit them to the end of the 
music. Currently, the titles are longer than the end of the music. You can trim multiple 
clips simultaneously, thereby making it easier to fit a program to a required time limit.

4	 In the toolbar, click the trim edit mode button, or press T.

5	 Drag a selection rectangle around the three title clips in the timeline.

6	 Press the U key twice until the tail or end of each title is selected for trimming.
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7	 Drag any of the green trim handles until the last title lines up with the end of the music.

Editing one timelines into another is one way of creating compound clips. We’ll look at 
creating compound clips more fully in a future lesson. They can be invaluable when it 
comes to timeline compositing and animation.

Creating Variable Speed Changes
Changing the speed within a clip can grab the audience’s attention by turning what can be an 
ordinary clip into something that makes people sit up and take notice. That is especially true 
on the somewhat pedestrian food shots. In Resolve, you’ll find many advanced controls to 
manipulate the playback speed of clips. One of these tools, the retime controls, enables you 
to apply multiple speed changes to the same clip without splitting the clip into multiple cuts. 
Such speed changes are commonly known as speed ramps. To explore these techniques, 
you’ll use the 02 With B-Roll timeline you added to in the previous lesson.

1	 Make sure you ended the previous exercise with the 02 With B-Roll timeline loaded in 
the timeline window.

2	 Choose Workspace > Reset UI Layout to reset the timeline to its default size.

3	 Play the timeline to review the edit.

Notice how the new b-roll clips illustrate what Miss Rachel is talking about, as well as 
hiding most of the jump cuts and gaps created during the radio edit. Note also the 
sound of the restaurant added on the Audio 2 track (with the music having been 
dropped to Audio 3) to fill in the sound gaps between the interview clips.
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4	 In the timeline, go to the yellow clip on the B-Roll track, which starts at around 01:00:35:00.

This shot of the barbecued seitan would be nicer if it slowed down as the plate came 
closer. Right now, the entire shot moves too fast.

5	 Press Cmd-+ (plus sign) in macOS or Ctrl-+ (plus sign) in Windows to zoom into the clip 
on the timeline.

6	 Right-click the clip and choose Retime Controls, or press Cmd-R (macOS) or Ctrl-R 
(Windows).

A blue bar appears along the top of the clip with the speed percentage of the clip 
displayed underneath the video thumbnails.
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7	 Place the playhead about halfway into the duration of the clip.

This is the location where you would like to start slowing down the clip playback. You 
do so by adding a speed point at the playhead location.

8	 Along the bottom of the clip, click the disclosure arrow to the right of the speed 
percentage display, and choose Add Speed Point.

The speed point divides the clip into two sections, with each section now having its 
own playback speed. You can set the speed in the menu you used to set this speed 
point. Let’s increase the speed slightly for the first half of the clip, and then slow it down 
for the second half.

9	 Click the disclosure arrow for the segment on the left and choose Change Speed > 200%.
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10	 Position your mouse pointer on the right edge of the Speed Change bar, and when the 
pointer changes to a double arrow, can drag the edge of the clip to the point where 
she laughs. Doing so reduces the speed even further and better covers the jump cut.

11	 Play over the speed change to view the results.

Being able to manipulate the speed at different points in a clip is a simple yet powerful 
device. However, like most things in editing, you rarely set it and forget it. You will more 
likely want to make changes to the speed and how it appears.

Modifying Speed and Quality
You can modify the position of speed points and the playback speed of each section by 
dragging the speed point. Each speed point has two handles. Dragging the upper handle 
speeds up or slows down the section to the left, whereas dragging the lower handle 
changes the frame on which speed point occurs.

Changes playback speed without changing 
frame where speed change occurs.

Changes frame where speed change 
occurs without changing speed.

On this clip, if you want the speed change to occur when the plate is a bit more fully 
onscreen, you can drag the lower handle. 

1	 Drag the lower handle to the right until the plate is more fully in the frame. 
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Notice that the speeds of both sections on either side of the speed point did not 
change speed. Only the location of the speed point has changed. If you wish to 
increase the playback speed of the first half of the clip, you can drag the upper handle

2	 Drag the upper handle to the left until the speed display at the bottom of the clip is 
around 300%. 

Changing the speed for the first half of the clip as well as the location of the speed 
point has changed the clip’s overall duration. You’ll need to change the speed of the 
second half of the clip to extend it over the next clip on video track 1. The last segment 
does not have a speed point, but you can change the speed of the segment using the 
speed bar at the top of the clip.

3	 As you did previously, drag the speed bar corner to the left until the clip is extended to 
cover the clip on video track 1 and the speed of the second half is around 20%

4	 Play over the clip to review your changes. 

5	 Press Cmd-R (macOS) or Ctrl-R (Windows), or right-click the clip and choose Retime 
Controls, to close the retime controls. 

6	 Press A to change to the selection tool.

You now have an eye-catching shot that feels more contemporary and engaging than 
the straight food shot you had. Unfortunately, the slow parts of the footage now appear 
a little stuttery because Resolve has to repeat frames to create that speed change.

7	 Select the clip in the timeline, and open the Inspector. In the Retime and Scaling controls, 
change Retime Process from Project Settings to Optical Flow.

TIP  The Motion Estimation menu includes a more advanced option called 
Speed Warp that  can improve optical flow on shots with criss-crossing objects 
such as cars, pickett fences, and shots of walking and running legs.
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8	 Finally, to smooth the transition between to the two speed sections, right-click the clip 
in the timeline, and choose Retime Curve, or press Shift-C. 

The retime curve opens in the timeline below the clip.

9	 In the retime curve, select the retime keyframe, and click the Bézier control. Drag the 
handles out to adjust the amount of smoothing applied to the speed change.

10	 Finally, press Shift-C or Right click the clip, and choose Retime Controls, or press 
Cmd-R (macOS) or Ctrl-R (Windows) to hide the retime controls.

This food shot in your timeline is now much more dynamic and exciting. You’ve also easily 
manipulated a moving shot to increase its impact and help cover the jump cuts in the 
interview edit.

Using Smooth Cut
Another way to hide a jump cut from your viewer is to use the Smooth Cut transition. 

1	 In the timeline, place your playhead over the edit between the first and second 
interview clips, just after the lower-third title has faded away (at around 01:00:09:00). 
Press / (slash) to preview the cut.

This is a classic jump cut that distracts from the story about the merits of this 
vegan restaurant.

2	 In the upper-left of the interface, click the Effects Library button to open your 
Effects Library.
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3	 Click the Video Transitions group, and in the Dissolve category, locate Smooth Cut.

4	 Drag the Smooth Cut transition to the edit point between the first and second interview 
clips so it’s centered across the edit.

5	 Set the duration of the transition to four frames by either dragging the edges of the 
transition in the timeline, or typing 4 in the Duration Frames field of the Inspector. 

You should see that Resolve successfully manages to blend the two sides of the jump cut 
into what appears to be a single take. 

Remember, though, that you should use this transition with great care; you don’t want to 
change or misrepresent the meaning of something your interviewee said through your 
editing, no matter how subtly!

Working with Advanced Transition Tools
Transitions in Resolve are very straightforward to use. But they also allow you to go much 
deeper into transition customization than you might have thought possible. Resolve has a 
built-in curve editor for transitions that enables you to customize the acceleration of any 
transition animation. Let’s create one for your radio edit.
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1	 Go to the lime green clip on the V2 B-Roll track at around 01:00:30:00.

This is the shot of macaroni and cheese in the middle of your timeline.

2	 Play over the cross dissolve transition at the end of this clip.

The transition works well, but the incoming shot takes a few frames before the camera 
motion settles down. If you ease out on the transition, it will fade into the incoming shot 
more slowly, thereby reducing the impact of the camera movement at the start of the clip. 
You can address this by creating a custom ease-out using the transition curve editor.

3	 Select the transition, and in the lower-right corner of the transition, click the diamond 
icon to open the keyframe editor.

TIP  If you can’t see the diamond icon on your transition, zoom further in 
to your timeline.

If you just wanted to move a keyframe earlier or later, you could use this editor. 
However, to create a custom acceleration curve, you must use the curve editor.
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4	 On the right side of the keyframe editor that appears below the clip, click the curve 
editor icon to open the transition curve editor. 

Instead of making numeric adjustments to your transition in the Inspector, you change 
the slope of the curve in this curve editor to change the transition acceleration. The 
default linear transition is a diagonal line from the lower-left to the upper-right. 
However, you can flatten that line’s slope to slow the transition speed. To slow down 
the curve at the start, you can add a control point along the line and decrease the 
slope between the initial control point on the left and the new control point you add.

5	 Option-click (macOS) or Alt-click (Windows) about one-third of the way along the 
diagonal line to create a control point.
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6	 Drag down the new control point until the Transition Curve tool tip reads 0.10.

This setting indicates that at this keyframe, the transition will be only 10% complete.

7	 Press / (slash) to play around the selected transition and view the results.

If the acceleration isn’t hiding enough of the slow camera start at the beginning of the 
clip, you can move the control point horizontally to change the timing.

8	 In the keyframe editor track, drag the control point to the right until it is almost in the 
middle of the clip to lengthen the slow acceleration.
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9	 Press / (slash) to play around the selected transition.

Although you delayed the acceleration, a very linear transition remains between the 
control points. You can smooth these transitions using the interpolation buttons at the 
top of the curve editor.

10	 Select the center control point that you added. It turns red.

11	 Click the second interpolation button from the left to create an ease-in/ease-out 
interpolation for the control point and to display Bézier handles that will allow you to 
perform further refinement. 

Because the Bézier handles are almost completely horizontal when added, they will 
create a pause in the transition, holding it for just a moment. However, that’s not what 
you want so you’ll need to adjust the handle to accentuate the slow acceleration at the 
start of the clip.
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12	 Drag the right Bézier handle slightly up and to the right to create a smoother curve.

13	 Press / (slash) to play around the selected transition.

14	 If you are happy with the results, you can close the curve editor by clicking the curve 
editor button in the upper-right corner of the graph. Then, click the diamond shaped 
keyframe editor button in the lower-right corner of the transition icon in the timeline to 
close the keyframe editor.

Custom transitions such as this are most often used in very specific situations, but you can 
also save them as presets if you anticipate the need to reuse a custom curve transition in 
the future.
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Lesson Review
1	 What is known as a “radio edit”?

a)	 When your edit will be used on radio as well as television

b)	 A cut-down version of your film used by reviewers

c)	 A technique of concentrating on the audio before editing the visuals

2	 Where can you find the option to show stacked timelines?

a)	 Drag one timeline on top of another to display two timeline windows.

b)	 The timeline view options menu

c)	 There is no option to show stacked timelines.

3	 Where are the retime process options located?

a)	 In the Motion menu of the main menu bar

b)	 In the Inspector

c)	 By double-clicking a clip

4	 What transition could be used to make short jump cuts less noticeable?

a)	 Smooth wipe

b)	 Smooth dissolve

c)	 Smooth cut

5	 How can you access the advanced transition controls?

a)	 Right-click the transition in the timeline, and choose Advanced Transition Controls

b)	 Click the Transition’s keyframe button, and click the curve editor button

c)	 Click the transition’s curve editor button in the Inspector.



178
Le

ss
o

n
 5

 
M

ak
in

g
 A

 R
ad

io
 E

d
it

Answers
1	 c) A “radio edit” is created when you focus on editing the audio of an interview to make 

it sound smooth and natural before turning your attention to the covering visuals. 

2	 b) The timeline view options menu

3	 b) In the Inspector

4	 c) Smooth cut is a special-purpose transition designed to make short jump cuts less 
noticeable by using optical flow processing to automatically morph a subject between 
to positions across the duration of the transition.

5	 b) To reveal the Transition Curve editor, click the keyframe diamond in the lower-
right corner of the transition to display the Keyframe Editor, and then click the curve 
editor button.
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Multiple cameras running simultaneously 
are used for many types of productions 
including, music videos, and reality 
programming.

The Cut page enables one way to edit 
multicamera productions while the Edit 
page uses a more traditional setup.

Both pages allow you to initially synchro-
nize multiple clips and then easily manage 
and edit between camera angles without 
any further concern about sync issues. 
However, the Edit page provides a bit more 
flexibility when it comes to naming and 
ordering camera angles, as well as enabling 
switching and even color grading.

In this lesson, you will explore the power of 
multicamera functionality in the Edit page, 
and learn how to solve some common 
challenges.

Lesson 6

Editing a Multicamera 
Music Video
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Starting a Multicam Project
To start this lesson, you’re going to concentrate on a simple multicamera edit for the 
beginning of a music video. You will then explore more in-depth features of multicam 
editing in the Edit page.

From the very beginning of a project, accurately establishing the sync relationship between 
multiple camera angles is critical to a successful multicamera edit, so let’s look at the 
various ways you achieve this in Resolve.

1	 In the Project Manager, right-click and choose Restore Project Archive. Navigate to R16 
Editing Lessons > Lesson 06 Multicam.dra, choose open, and then open the project in 
the Edit page.

2	 In the Media Pool, select the Timelines bin, and press Cmd-N (macOS) or Ctrl-N 
(Windows) to create a new timeline. Name this timeline Simple Music Video.

Next, you need to sync the clips that you want to work with in the multicam edit.

3	 In the 01 JBR Angles bin, select the three video clips, and choose Create New 
Multicam Clip Using Selected Clips.

The New Multicam Clip window opens in which you can select how Resolve will 
synchronize the clips and create the multicam clip.

TIP  You can create multicam clips using selected bins by selecting the bin 
name in the bin list.

4	 In the New Multicam Clip window, name your multicam Simple Music Multicam.
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5	 Change the Angle Sync to Sound.

Selecting Sound synchronizes the clips based on their audio content as references, 
similar to the way you synced dual system clips in Lesson 1.

6	 Change the Angle Name to Clip Name.

NOTE  The Angle Name option dictates the order in which the angles are 
sorted. When you choose Sequential, Resolve labels the angles and sorts them 
as Angle 1, Angle 2, and so on, based on their starting timecode values. 
Choosing Clip Name sorts the clip names in ascending alphanumeric order and 
labels the angles. Similarly, choosing Metadata - Angle or Metadata -Camera 
sorts the clips based on information in their respective metadata fields.

7	 Click Create to create the multicam clip.

Resolve analyzes the clips’ audio and creates a new multicam clip in the selected bin called 
01 JBR Angles. A new bin also appears, Original Clips, that contains the individual camera 
source clips. 

Editing Multicamera in the Edit Page
The fun aspect of working with a multicamera edit in the Edit page is that you can cut 
between the different cameras in real time as if you were sitting in the live studio in front of 
a switcher. Often, this real-time technique will save you hours because you’re able to cut 
the material in the time it takes to play the timeline.
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1	 Double-click the Simple Music Multicam clip to open it in the source viewer.

Each clip appears in a quadrant of the source viewer. The multicam source viewer 
organizes the angles from left to right and from top to bottom. So, in this 2x2 multicam 
layout, angle 1 will appear in the upper-left window and angle 4 will appear in the 
lower-right window. Notice that the angles’ names have inherited the original clips’ names. 

2	 In the source viewer options menu, ensure that “Video and Audio” is selected.

Because CAM 01, in the upper-right quadrant of the viewer, is selected by default, that 
is the angle that you will hear when you begin playing the clip.

3	 Set an in point just as the close-up of the drummer appears in the upper-right quadrant 
(at 01:00:01:05).
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4	 Perform an overwrite edit to edit this clip into the empty timeline.

5	 Press Shift-Z, if necessary, to view the whole clip, and press Home to return the 
playhead to the start of the timeline.

In the timeline, only CAM 01 is displayed because that is the active camera. To switch 
camera angles and keep the source viewer in sync with the timeline clip, you need to 
enable multicam mode.

6	 In the source viewer mode pop-up menu, choose Multicam to display the 
multicam viewer.

Enabling multicam mode replaces the transport controls under the viewer with multicam-
related controls. Transport controls are no longer necessary because moving the 
timeline playhead will move the source clips so they maintain their sync relationships.

7	 Drag the timeline playhead back and forth to see how the source clip moves at the 
same rate.

In the source viewer below the multicam clip, three buttons control which parts of this 
multicam clip cut when you switch angle: video, video and sound, or only sound.

8	 Click the video button to the left to edit only the video of this multicam clip.

Now for the fun part…

9	 With the playhead at the start of the timeline, click play, and begin clicking each of the 
video clips in the source viewer to cut between the angles of the multicam clip. You will 
see the edit points appear in the timeline as you cut between the angles. Keep going 
until the angles run out and you reach the end of the timeline.

TIP  You can also press the 1, 2, and 3 keys along the top of your keyboard to 
cut between the angles in real time.

10	 Return the playhead to the start of the timeline, and click play to review your 
multicamera masterpiece.
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This first attempt at a real time multicamera edit is probably not going to result in a perfect edit. 
It’s very rare that you would cut to the exact angle at exactly the right time on your first try.

Instead, think of this as your rough cut. You’ll now need to refine the edit.

Adjusting a Multicamera Edit
Now that you have completed your rough cut, when you review it you’ll may notice two 
common issues: you’ve made a cut at the wrong time, or you cut to the wrong angle.

Even worse, it could be both issues!

Fear not. You’re not directing live television here; this is post-production so you can change 
your mind before anyone has seen your previous “creative choices.” Solving the first issue 
where you cut at the wrong time is easy. You already know how to change an existing cut 
point by simply performing a rolling trim using any one of several techniques.

The second issue, where you use the wrong angle, is just as easy to fix by switching angles 
in the source viewer.

TIP  When working with a multicamera edit, you need to be very mindful of the sync 
between the angles. For this reason, it’s probably not advisable to begin rippling, 
slipping, or sliding shots until you are confident you have mastered those edits.

1	 In the timeline, play your multicam edit until you see a shot you want to change, and 
stop playback.

As the edit plays, the source viewer will also update because in multicam mode the 
source viewer is automatically ganged to the timeline playhead position.

2	 In the multicam viewer, Option-click (macOS) or Alt-click (Windows) a different image to 
switch the active angle to the new angle. 
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When you’re switching the active angle, the mouse pointer changes to a replace edit icon.

It’s just as easy to add further cuts to your multicam edit too.

3	 In the timeline, move the playhead to the middle of one of the multicam clips, and in the 
source viewer, click any other angle.

A new edit point appears at the playhead position in the timeline and changes the rest 
of the multicam clip after the cut to the new active angle.

TIP  Pressing the number keys at the top of your keyboard (1, 2, 3, and so on) 
makes a cut at the playhead position in the timeline. Holding down Option in 
macOS or Alt in Windows and pressing a number key switches the multicam 
clip angle at the playhead position in the timeline. You can perform either of 
these operations during playback or when the playhead is stationary.

Excellent. Now that you’ve got a real taste of how much fun multicamera editing is, and how 
it works in Resolve, it’s time to look at a more complex editing challenge.

Complex Multicamera Editing
Editing a multicamera clip with three or four angles is very enjoyable and relatively 
straightforward. Things become much more challenging when dealing with multicamera 
shoots that used more cameras.

Understanding some of the issues that you may encounter during a complex multicamera 
edit is essential to learning how you can begin to solve these problems.

1	 Select the Timelines bin, and press Cmd-N (macOS) or Ctrl-N (Windows) to create a 
new timeline. Name this timeline Complex Multicam.

Again, this new timeline replaces the previous timeline in the timeline window.
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2	 Select the 01 JBR Angles bin, and Cmd-click (macOS) or Ctrl-click (Windows) the 

02 More Angles bin.

3	 Press Cmd-A (macOS) or Ctrl-A (Windows) to select all the clips in these bins.

4	 Hold down Cmd (macOS) or Ctrl (Windows) and deselect the MUSIC.wav and 
Simple Music Multicam clips.

5	 Right-click the selected clip, and choose New Multicam Clip Using Selected Clips.

6	 In the window that opens, change the name of the multicam clip to Miserable Girl.

7	 Set the Angle Sync to Sound.

Although synchronizing clips using sound is a great method, you can also synchronize 
clips using timecode, in points, out points, or clip markers. These other methods are 
useful when, for whatever reason, the source clips were recorded without sound or 
with poor-quality reference audio

8	 Set the Angle Name to Clip Name.
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9	 Select “Detect clips from same camera.”

Doing so ensures that Resolve will look at the metadata for each clip and see if any of 
the clips share a camera number or name. When they do, those clips are treated as a 
single angle in the multicam clip and sorted based on timecode.

TIP  The camera number metadata is located in the Shot & Scene category of 
the metadata panel.

10	 For this example, deselect “Move Source Clips to ‘Original Clips’ Bin” to leave the 
source clips where they are, and click Create.

The Miserable Girl multicam clip is created and placed in the uppermost selected bin.

TIP  If you can’t easily find your multicam clips, this project already includes a 
Multicam Clips Smart Bin
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11	 Double-click the Miserable Girl multicam clip to load it into the source viewer.

12	 In the source viewer, set an in point just before the music starts at 01:00:02:05, and 
overwrite the clip into the Complex Multicam timeline.

It is important to edit the multicam clip into the timeline prior to switching to the 
multicam source viewer because that viewer is designed specifically to work when 
multicam clips are already edited in the timeline.

13	 Press Shift-Z and then press Home to return the playhead to the start of the timeline.

14	 In the source viewer mode pop-up menu, choose Multicam.

15	 Play through the timeline, keeping an eye on the source viewer to check the sync of 
all clips.

TIP  Black frames are shown at the start and end of some clips because all of 
the cameras started and stopped recording at slightly different times.

Because the clip name sorting organizes clips alphabetically, CAM 01 is the first clip in the 
list and is used in the timeline as the default picture and sound reference.
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Renaming Tracks
Although the multicamera clip appears as one segment in the timeline, it is actually a type 
of container timeline, which is very similar to a compound clip. You will work more with 
compound clips in Lesson 07; but for now, it’s useful to know that you can open a multicam 
clip in its own timeline when you need to make changes, such as altering an angle name.

You can use the timeline header to rename angles to be more descriptive and helpful. 
However, renaming is available only when you expand the track view in the Timeline View 
Options menu.

1	 In the Timeline View Option pop-up menu, select Stacked Timelines.

The timelines you worked on across this project now open as individual tabs.

2	 In the timeline, right-click the Miserable Girl clip, and choose “Open in Timeline.”

The multicam clip opens in its own tabbed timeline and you can see how Resolve has 
structured and organized it. The organization is simple: any content on the video 1 track 
is displayed in the multicam viewer as angle 1. If content is present on video 2, it is 
displayed as angle 2, and so on. The same naming convention applies to the audio 
clips. Notice that the track names follow the names of the original clips.
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3	 In the timeline header for the V2 track, click the name CAM_02_Pt1.

4	 Rename the track to CAM_02.

5	 Click the timeline tab for the Complex Multicam timeline, and in the multicam viewer, 
verify that the name of the second angle is updated as CAM_02.

Being able to rename angles/tracks is just one of the many reasons you may need to open 
the multicam clip and view the contents. Adding new angles, rearranging the order the 
angles display in the multicam viewer, and even color grading tracks instead of individual 
edits are just a few of the invaluable functions.

Rearranging Angles in the Viewer
When viewing the order of angles in the multicam viewer, you may deem some angles less 
important and some more important. Sometimes these superfluous or less-important 
angles clutter your screen and distract you from selecting the angles you actually want.

You can limit the number of angles displayed in the viewer using the multicam display 
drop down menu.

1	 In the lower-right of the source viewer, click the multicam display pop-up menu.

You can choose how many angles are displayed by selecting one of the grid options.

2	 Choose 3x3 to display three rows of three columns for a total of nine angles in the viewer.
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TIP  Limiting the number of displayed angles can also improve playback 
performance on slower computers.

The source viewer organizes the angles into pages to provide access to the additional 
camera angles.

3	 Click the right page control arrow to display additional angles.

This page displays angle CAM_10, a nice shot of the lead guitarist. You might want this 
important close-up shot on the first page, so let’s relocate that angle in the track order.

4	 In the timeline, click the Miserable Girl tab.

5	 Scroll up to locate the CAM_10 track, right-click the timeline header, and choose Move 
Track Down.

Doing so swaps the CAM_10 and CAM_9 angles in the track order, which should also 
move the guitarist onto the first page.

6	 Click the Complex Multicam tab to return to the main timeline.

In the source viewer you’ll see that CAM_10 has switched places with Cam_09.

Adding New Angles
Another reason you may need to open a multicam clip in its own timeline is to add 
additional angles that you were not able to add when you created the multicam clip. For 
example, you may have created the original multicam clip using sync’d timecodes, but had 
one clip that didn’t have the proper timecode. In a situation like this, it’s useful to know that 
you can manually add angles after the multicam clip has already been created.

1	 In the timeline, click the timeline tab for the Miserable Girl multicam clip timeline.
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2	 Click the Timeline View Options button, and select the rightmost video view option. 

Press Shift-Z to fit the entire timeline in the window.

This arrangement collapses all the tracks to a small size, leaving you the maximum 
amount of space to move tracks around in the timeline.

3	 In the Media Pool, select the 03 JBR Extra Angle bin.

4	 Open the New Angle.mov clip into the source viewer.

This clip is a low-angle shot of the entire stage that is missing from the original 
multicamera angles.
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5	 Position the jog bar at the start of the source clip, and press Shift-Down Arrow to jump 
to the blue marker. Press I to add an in point.

This marker was placed at the start of the music for you. Having it in place makes it 
quicker to sync this angle with the multicamera clip.

6	 In the Miserable Girl multicam clip timeline, position the playhead at the start of the 
music at 01:00:02:07. 

7	 Press Option-Cmd-1 (macOS) or Alt-Ctrl-1 (Windows) to disable the A1 source control, or 
disable the source control for A1 in the timeline track headers.

8	 Press F12 to perform a place on top edit, and edit the clip in track v11 (the lowest free 
track) so this clip starts at the correct position.

A new angle is added to the multicam clip. You can use the standard slip and slide 
trimming tools, as necessary, to refine the sync relationship of this clip with the music.

NOTE  While a place on top edit will normally create new video and audio tracks 
as necessary, in this case, an empty V11 track was already in the timeline. V11 was 
empty because Angle 11 in this multicam clip is used for the music track which 
has no video. By manually adding the new video-only angle to the  empty V11 
track, both clips now display as the 11th camera angle in the viewer.

9	 In the timeline, close the Miserable Girl tab. You have finished changing your multicam 
clip for now.

10	 In the source mode pop-up menu, re-enable the multicam viewer.
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11	 Click the Timeline View Options button, expand the audio track and click the button to 

enable audio waveforms. Choose other timeline view options to suit yourself.

Ok, back to the fun bit. It’s time for you to do some more multicam editing!

12	 Return the playhead to the start of this timeline.

13	 Click play, and start editing!

When you have played to the end of this multicam clip, go back through your edit and 
refine it by rolling the edit points, switching existing angles, and adding new cuts. Don’t 
forget the two additional angles on the second page in the multicam viewer!

Once you have completed editing and refining the multicam edit, flattening a multicam 
clip in the timeline removes all the additional angles, and leaves the active angle in its 
place as a normal timeline clip.

14	 Click in the timeline window and press Cmd-A (macOS) or Ctrl-A (Windows) to select all 
the edits in the timeline.

15	 Right-click any of the selected edits, and choose Flatten Multicam clip.

When editing multicamera projects and playing back in real-time, you are really trying to 
assess the rhythms and themes of the music and capture those characteristics as you are 
cutting. Sometimes you might cut a multicam clip in three or four ways to experiment with 
various pacing strategies and later decide which one is showing the most love; but as with 
all editing, each cut requires constant revisiting and reworking to ensure that your audience 
is watching the best possible results.
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Lesson Review
1	 What options do you have for synchronizing angles in a multicam clip from video clips 

without sound?

a)	 Use in or out points

b)	 Use markers

c)	 Use timecode

2	 What is the maximum number of angles you can view simultaneously in a multicam clip?

a)	 16

b)	 18

c)	 28

3	 What modifier key is held down to switch the entire multicam clip to another angle 
instead of adding a new edit point?

a)	 Command (macOS) or Control (Windows)

b)	 Option (macOS) or Alt (Windows)

c)	 Shift

4	 True or False? You cannot change the order of angles, add additional angles to an 
existing multicam clip, or change the current order of the angles.

5	 True or False? When you choose to flatten a multicam clip, you lose all the other 
synchronized angles.
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Answers
1	 a), b), and c) You can choose to synchronize angles using in points, out points, 

timecode, or markers instead of sound.

2	 a) 16. You can have multiple pages of more angles, but the maximum number of angles 
you can view in any one page is 16 (4x4).

3	 b) Option-click (macOS) or Alt-click (Windows) an angle to switch the existing angle.

4	 False. Right-click a multicam clip, and choose Open in Timeline to adjust an existing 
multicam clip.

5	 True. Flattening a multicam clip removes all the unused angles and leaves only the clip 
that was used in the active angle in the timeline.
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Multilayered promotional videos or promos, 
combine video, audio, motion graphics, and 
text into a seamless animated short video. 
While creativity and imagination make 
every promo unique, the ultimate goal is 
always about conveying the message. You 
can apply the layering, graphic, and anima-
tion techniques you learn in this lesson to 
commercials in which you need quickly to 
persuade viewers to engage with a busi-
ness. These techniques also come into play 
when creating educational content that 
needs to explain difficult or complicated 
concepts in an easy-to-understand way.

This lesson will introduce the compositing 
and animation features available to you in 
DaVinci Resolve 16’s Edit page. These days, 
editors often need to build composites and 
apply some level of keyframe animation, 
either as previz (previsualization) for motion 
graphics or as the final content.

Lesson 7

Editing a Multilayer 
Promo
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Setting Up the Project 
To ensure the clarity of your multilayered promo, you must have a vision for the project 
before you even begin. Unless you fully define what you need to communicate, it is tough 
to choose the right approach.

The goal for this promo is to create a simple multilayered, thirty-second promotional video 
for a documentary on Rhino conservation.

1	 In the Project Manager, right-click and choose Restore Project Archive. Navigate to R16 
Editing Lesson > Lesson 07 Multilayer.dra folder, and choose Open.

2	 Open the project and click the Edit page button, if necessary.

3	 Choose Workspace > Reset UI Layout to reset the interface to its default setting.

4	 From the timelines bin, double-click the 01 start timeline, and play it.

This timeline uses two clips and a title that form the foundation of your 30-second promo. 
You’ll work on both these clips to enhance their appearance, and even enhance the rifle 
sound you hear in the gap between the two clips.

To create this multilayered promo, you’ll begin by adding new timeline layers and a couple 
of clips.

Editing To Different Video Tracks
So often in promos, you want multiple pictures to appear onscreen at the same time. To do 
so, they must be layered vertically on different tracks in the timeline. For your next few 
edits, you’ll stack up clips that work well together onscreen to evoke a dramatic reaction.

Creatively, the director wants one shot of a ranger firing a rifle and one shot of a rhino on 
screen as the conservationist talks about rhinos.
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1	 In the Media Pool master bin, double-click the rifle clip to load it into the source viewer.

At one point in this clip, the rifle fires a shot. You want to make sure you do not include 
that part of the clip because you already have the sound of the rifle occurring later in 
the gap between the two existing clips. The easiest to avoid the rifle sound in this clip 
is to view the audio waveform.

2	 In the options menu above the source viewer, choose Show Full Clip Audio Waveform.

By examining the audio waveform overlay, you can quickly locate the firing of the gun 
because the rifle sound is the only sound in this clip.

3	 In the source viewer, drag the playhead directly before the frame where the rifle fires.

Because you want to avoid the image of the rifle shooting, you’ll back up the playhead 
by one second to set the input.

4	 On your keyboard type -1. (period) and press Enter to move the playhead back one 
second. Then mark an out point.

Now you’ll mark the duration based on the first clip in the timeline.
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5	 In the timeline, move the playhead in the center of the first clip, and press X to mark in 

and out points around the clip.

To edit in the new clip and layer it above the Interview clip, you can use the video 
2 track. You’ll patch the video from the source clip onto video 2 track.

6	 Press Option-2 (macOS) or Alt-2 (Windows) to patch the source video to video 2 in 
the timeline.

Because you do not want the rifle clip to be heard, you’ll disable the audio.

7	 In the timeline, in the audio 2 track header, click the A1 destination track to disable the 
audio from the source clip.

With the duration correctly marked and the right tracks targeted, you are ready to 
perform the edit.

8	 Press F10 to perform an overwrite edit.

Video track 2 now contains the rifle clip without any audio. You need to add one more 
video clip of a rhino.
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Editing with Fit to Fill
Fit to fill is a four-point edit in which both the source clip and timeline have in and out points. 
When these two selections have different durations, DaVinci Resolve can automatically 
calculate the rate of speed adjustment required to make the marked duration of the source 
clip fit into the marked duration of the timeline. This automatic speed change is helpful in 
promos where you want a particular action to happen within a musical beat or within a 
specific voice over section.

1	 Move the playhead back to the start of the timeline, then press X to mark the in and out 
points for the next clip. 

2	 In the media pool, double-click the Rhino clip to load it into the source viewer.

This clip contains in and out points that mark a 20-second duration. Let’s look at the 
marked area.

3	 Press Opt-/ (slash) on macOS or Alt-/ (slash) on Windows to play from the in to the out 
point before returning the playhead to its current frame.

The rhino in this shot moves very slowly. You are going to speed up the shot because 
you want to fit the full action of the rhino into the 10-second duration you just marked 
on the timeline.

4	 In the timeline track header, make sure the A1 destination control is still disabled so you 
edit only the video track. Because no other video tracks are available, you’ll need to 
add new video track.

5	 In the timeline header, right-click the Video 2 track header, and choose Add Track.

A new video 3 track is added above video 2. Now you’ll patch the video from the 
source clip onto video 3 track.
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6	 Press Option-3 (macOS) or Alt-3 (Windows) to patch the source video to video 3 in 

the timeline

7	 Press Shift-F11 to perform a fit to fill edit.

The new clip is added to the timeline and sped up to fit the 20-second source clip into 
the 10-second timeline region.

8	 Return to the start of the Rhino clip in the timeline and watch the edit.

Rather than overwriting a clip and then using the retime controls to set the speed, if you 
know the duration you want to use of the source clip, and the duration in the timeline, a fit 
to fill edit can save you a few unnecessary steps.

Scaling and Positioning Clips
Currently, each clip fills the entire frame, the one on top hiding the tracks below it. Using 
the onscreen scale and position controls, you can place the rhino and ranger clips, so they 
are visible as picture-in-picture effects.

1	 Move the timeline played over the middle of the rhino clip, and click the Rhino clip to 
select it. 

You’ll use the onscreen controls to scale and position this Rhino clip as a picture-in-
picture located in the lower right of the frame.

2	 In the lower-left corner of the timeline viewer, click the transform button to show the 
onscreen wireframe controls in the viewer. 



203

S
ca

lin
g

 a
n

d
 P

o
si

ti
o

n
in

g
 C

lip
s

3	 Drag any of the wireframe’s corner control handles to scale down the image and locate 
it in the lower-right quadrant of the frame.

You’ll make the Rifle clip the same size but positioned in the upper right quadrant of 
the frame. The easiest way to match size is to copy and paste the attributes.

4	 Make sure Rhino is still selected in the timeline, then choose Edit > Copy or press 
Cmd-C (macOS) or Ctrl-C (Windows).

5	 Select Rifle in the timeline, and choose Edit > Paste Attributes, or press Option-V 
(macOS) or Alt-V (Windows).

The paste attributes command opens a window where you can select the attributes 
you want to apply to the selected clip.

6	 In the Paste Attributes window, select the zoom checkbox to activate the scale x and 
scale y parameters.

7	 At the bottom of the window, click apply.

Rifle is scaled down to the exact size of the Rhino clip, however it remains in its 
centered location. You can position it by dragging it in the viewer.
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8	 Drag Rifle to the upper-right quadrant, aligned with the Rhino clip.

Scaling the two picture-in-picture (PIP) clips allows you to see the background interview. If 
you want to animate the picture in picture clip or add an effect to them, it can be easier to 
do that if you collapse them into a compound clip.

Working with a Compound Clip
You’ll want to animate these two picture-in-picture (PIP) clips on and off screen. Of course, 
while you could animate each clip individually in your timeline, the process would be much 
easier if you could treat both layers as one. By doing so, you could animate just a single 
element rather than having to manipulate each different layer. By collapsing all your tracks 
into a single compound clip, you enjoy the ease of managing a single clip while retaining 
access to all your edits.

1	 Select both the Rhino and the Rifle clips in the timeline.

2	 Right-click one of the clips, and choose New Compound Clip. A dialog appears asking 
you to name the compound clip. 

3	 Name the compound clip PIP comp, and click Create.



205

W
o

rk
in

g
 w

it
h

 a
 C

o
m

p
o

u
n

d
 C

lip

Both video clips collapse into a compound clip that is added to the current bin in the 
Media Pool. Compound clips are treated just like regular source clips. They have 
names and appear in the current bin.

However, the compound clip is not a mixdown of your video and audio clips. It is a 
container of all your edits, which you can still access at any time.

TIP   Deleting a compound clip from a bin deletes it from any timeline into 
which it was edited, just as with a normal source clip.

Animating a Compound Clip
Animating in DaVinci Resolve may be familiar to you if you have used keyframe animation in 
another application. Once you enabled keyframing in the Inspector, you can reposition or 
scale clips in the inspector, timeline, or directly in the viewer.

1	 Move to the start of the timeline.

This is where you will create the first keyframe to begin your animation.

2	 In the timeline, select the compound clip, and open the Inspector.

3	 Drag right in the position X number field until the clips are out of the frame off to the 
right, or type 640 in the position X number field, and press Enter.

4	 To the right of the position parameters, click the keyframe button.

A keyframe is added to the X and Y position parameters in the transform category. To 
finish your animation, you now need to move to the frame where you want the two clips 
to land in the frame.

5	 With nothing selected in the timeline, type 24, and press Enter.

The playhead moves 1 second forward. This is where you will place the “landing” keyframe.

6	 In the timeline, select the compound clip.
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7	 Drag left in the position X data field until the two clips are fully in the frame, or type 0 in 

the number field, and press Enter.

8	 Move to the beginning of the timeline, and press Spacebar to play the results.

The animation is a little rigid. To make the landing smoother, you can adjust the 
acceleration in either the Inspector or the viewer.

9	 Move back to the beginning of the timeline.

10	 In the Inspector, right-click the red keyframe on the Position parameter, and choose 
Ease Out.

The ease out option causes the animation to slowly begin and then accelerate. You 
can do the opposite on the landing keyframe by setting an ease in option.

11	 In the Inspector, click the go to next keyframe button to move the playhead to the next 
active keyframe.

12	 Again in the Inspector, right-click the red keyframe on the Position parameter, and 
choose Ease In.

13	 Move to the beginning of the timeline, and press Spacebar to play the results.

The animation could still be smoother. To change the amount of smoothness applied to 
the animation, you can adjust it in the viewer.

14	 Move to the last keyframe you added to the compound clip.

15	 At the bottom of the timeline viewer, make sure the transform onscreen control button 
is still enabled.

When you apply position keyframes to a clip, you can display a motion path in the 
viewer. At the current keyframe position, the viewer shows two handles on the motion 
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path. The larger outer handle allows you to modify the shape or curvature of the path. 
The smaller middle handle controls the acceleration of the animation.

16	 Drag the middle control all the way to the right, bringing it closer to the keyframe.

Moving the middle handle toward the keyframe increases the amount of smoothness 
applied to the animation.

17	 Move to the beginning of the timeline, and press Spacebar to play the results.

The result is a much smoother, more natural movement to your animation. 

Adding effects to a Compound Clip
The compound clip acts and functions just like a regular clip. You can add transitions and 
ResolveFX to a compound clip just as you would any other clip.

1	 Select the head end of the compound clip as if you were going to select it for trimming.

You’ll add a fade-in and a fade-out to this compound clip. You can add both 
simultaneously by selecting multiple cut points.

2	 Hold down the Cmd key (macOS) or Ctrl key (Windows), and then select the tail end of 
the compound clip.

3	 From the timeline menu, choose Add Transition, or press Cmd-T (macOS) or  
Ctrl-T (Windows).

The cross fades are added to both ends of the compound clip.
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4	 Move the playhead to the start of the timeline, and press Spacebar to play the results.

To make the picture-in-picture effect stand out a bit more, you’ll add a soft drop 
shadow to the two clips by applying a ResolveFX to the compound clip.

5	 Click the Effects Library button in the upper-left corner of the Resolve window.

6	 In the Effects Library panel, in the sidebar, select OpenFX, and scroll down to the 
ResolveFX Stylize category.

7	 From the Effects Library, drag the Drop Shadow effect to the PIP compound clip in 
the timeline.

The two clips nested in the compound clip now have a soft drop shadow applied that 
makes them stand out more from the background.
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Opening a Compound Clip
The compound clip makes it easier to apply effects and animations to all the clips 
contained within that compound clip. However, what if you only want to modify one clip in 
the compound clip? To change any of the components of a compound clip, you must open 
it and make the individual clip changes.

1	 Select the compound clip in the timeline, and then right-click, and choose Open 
in Timeline.

Selecting Open in Timeline when a compound clip is selected displays the contents of 
the compound clip in the timeline window.

2	 In the timeline, select the Rifle clip.

This shot has a bit of a shaky handheld camera style that you would like to reduce.

3	 Open the Inspector, and double click the Stabilization header to display the 
stabilization controls.

4	 Click the Stabilize button.

The stabilization is the same analysis process that you used in the Cut page. After the 
brief analysis, you can play the results.

5	 Play the clip to see the results.

Just as in the Cut page, using the default stabilization setting retained the overall 
natural camera movement while smoothing out the motion. Let’s look at the 
unstabilized clip to refresh your memory of the original shot.
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6	 Click the switch to the left of the name to disable the stabilization, and play the clip. 

Enable stabilization when done reviewing. 

With the stabilization done, it’s time to return to the full timeline. You can return to the 
compound clip using the path control in the lower-left corner of the timeline.

7	 In the lower-left corner of the timeline window, double-click the timeline name. 

Because the compound clip in the timeline has changed, the associated compound clip in 
the bin was also updated. Compound clips saved to a bin have a live link to the compound 
clip edited in the timeline, therefore inheriting all the same changes.

Adjusting Multiple Clips
Compound clips provide one way to make changes to multiple clips. Adjustment clips are 
another method. Using an adjustment clip, you can apply effects to multiple clips in the 
timeline without collapsing them into a compound clip. The adjustment clip does not 
include content of its own. When you edit it onto a timeline track, any effects or 
adjustments applied to the adjustment clip are passed on to all clips located on the timeline 
tracks underneath it.

1	 In the Effects Library, from the Effects category, drag the adjustment clip onto video 
track 3, above the compound clip and interview.
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2	 Trim the end of the adjustment clip until it covers the entire second clip on video track 1 
in the timeline.

3	 In the Effects Library, select OpenFX, and scroll to the ResolveFX Styles category.

4	 Drag the Vignette filter from the Effects Library onto the adjustment clip in the timeline.

The vignette adds a customizable dark shading around the edges of the frame that 
suggests lens imperfections.

5	 Select the adjustment clip, and at the top of the Inspector, click the OpenFX tab to view 
the vignette controls.

6	 Increase the size to around .700 and the anamorphism to 2.5 so the vignette is not as 
pronounced around the frame.

The effect applies to all the clips on tracks below the adjustment clip. But you are not 
just limited to effects from the Effects Library. You can also use an adjustment clip to 
color grade a series of clips in the Color page.
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7	 Click the Color page button to switch to the Color page.

The Color page has the adjustment clip selected in the mini timeline. Any adjustment 
you make in the Color page applies to the selected adjustment clip and to all the clips 
on lower tracks. Let’s give the promo a more antique look overall by making the 
highlights warmer and the shadows cooler.

8	 Using the Lift color wheel, add a blue tint to the shadows, and use the Gain color wheel 
to add an orange tint to the highlights.

9	 Under the color wheels in the shared adjustments, increase the contrast between 
1.10 and 1.20.

10	 Click back to the Edit page, and play the timeline to see the results.

If you are unsure about any of the changes made on an adjustment clip, disabling the clip, 
or muting the track the adjustment clip is on, displays the original clips again.

Blending Layers with Composite Modes
Let’s work a bit on the second clip and the title in this timeline. If you apply a soft glow to 
the video clip, it may make the title and video blend a bit more nicely. Resolve doesn’t 
include a soft glow effect in the Edit page, but it is easy enough to make one using a 
Gaussian blur and a duplicated video clip. To duplicate the video clip, you’ll add a new layer 
between the video clip and the title.
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1	 Right-click the video 2 track header, and choose Add Tracks.

The Add Tracks dialog allows you to choose where new tracks are inserted.

2	 In the Add Tracks dialog that opens, set the audio to 0 so you do not create additional 
audio tracks; and in the video tracks section, set the Insert Position pop-up menu to 
Above Video 1.

3	 Click Create to insert a new video track.

Now you can duplicate the herding clip onto the new empty track.

4	 Option-Shift-drag (macOS) or Alt-Shift-drag (Windows) the herding clip in the timeline 
to the empty track directly above it.

Holding down the modifier keys while dragging duplicates the clip and restricts it from 
moving left or right. So, you end up with a copy placed directly above the original.

5	 Select the top herding clip in the timeline.

You can blend two images in the timeline by lowering opacity of the upper layer or 
setting the upper layer to use a specific composite mode. Composite modes use 
simple mathematical operations to blend the pixels of a clip on a higher track with a clip 
on a lower track. 

You can categorize composite modes based on the way the math impacts the two clips.

	� Darken colors: Darken and multiply

	� Lighten colors: Add, lighten, and screen

	� Increase color Contrast: hardlight, overlay, and softlight

	� Cancel out colors: Subtract (a simple version of difference)

	� Invert colors: Difference (similar to subtract but with negative results)

The most commonly used composite modes tend to be multiply for darkening, screen 
for lightening, and overlay or softlight for increasing contrast. Because you want to 
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create a soft glow, you want highlights to appear brighter and with a glow around them. 
The screen apply mode is ideal for this type of composite.

6	 In the Inspector, set the composite mode to screen.

7	 In the Effects Library, select OpenFX; and from the ResolveFX Blur category, drag the 
Gaussian blur on to the lower herding clip on video track 1.

8	 Select the lower herding clip on video track 1 and at the top of the inspector click the 
OpenFX tab to reveal the controls for the Gaussian blur.

9	 Increase the horizontal and vertical strength to around .600 to create a wider glow.
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That combination of the screen composite mode and the Gaussian blur creates a soft, 
dreamy glow effect that works well with the title. With the video done for your promo, the 
last task it to enhance the audio.

Using FairlightFX in the Edit Page
Audio is often a forgotten aspect when making a video. But the audio in your edit can have 
a strong impact on a promo. DaVinci Resolve’s incredibly powerful Fairlight page enables 
you to perform professional digital audio mixing and sound design. However, some of that 
power can be accessed within the Edit page, similar to the way you used the ResolveFX to 
add a vignette.

1	 In the Effects Library, click the Fairlight FX category, and drag the Echo effect onto the 
Rifle Sound on Audio 3.

As soon as you apply the effect to the audio clip, the echo window opens and displays 
controls for customizing the effect.

It would be a dramatic point in this promo if you made the rifle shot echo a few times as 
the herding clip comes onscreen.

2	 Lower the delay to 0 and the feedback to 50.

3	 Click in the upper-left corner of the echo window to close it.

4	 Move the playhead to the middle of the first clip, and play the timeline to hear the echo 
effect you added to the rifle sound.

The echo lasts only for the length of the clip. To extend the echo, the clip must be longer.
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5	 Trim the end of the Rifle Sound clip so it has a duration of three seconds.

6	 Play the audio clip again to hear the extended echo effect.

Editing multilayered promos is so full of creative possibilities that it can be tempting to add 
elements, effects, and animation just for the sake of watching them on the screen. 
However, unnecessary elements can often increase confusion when they should bring 
clarity to your message.

As a result, when you create a motion graphics animation for promos, think through every 
visual element and the way it moves. Make sure that each creative and technique choice 
benefits the overall communication of the project. By doing so, you should be able to 
create a more appealing design and maximize its impact.
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Lesson Review
1	 What will happen to a four-second source clip edited into a two-second marked section 

of the timeline using a fit-to-fill edit?

a)	 Only the first two seconds will be used in the timeline.

b)	 The clip will be retimed to 50 percent of its original speed.

c)	 The clip will be retimed to 200 percent of its original speed.

2	 True or False? To display scaling and positioning controls in the viewer, you need only 
to select the clip in the timeline.

3	 True or False? To create a compound clip, set in and out points around the clips in the 
timeline, and choose Clip > New Compound Clip.

4	 True or False? Making changes to the contents of a compound clip in the timeline 
changes the same compound clip that is saved in the bin.

5	 True or False? Adjustment clips affect only one video track located directly above the 
adjustment clip.
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Answers
1	 c). The clip will be retimed to 200 percent of its original speed.

2	 False. To display scaling and positioning controls in the viewer, you must enable the 
transform onscreen controls button.

3	 False. To create a compound clip, you must select the clips in the timeline, right click 
them, and choose New Compound Clip.

4	 True. Making changes to the contents of a compound clip in the timeline changes the 
same compound clip which is saved in the bin.

5	 False. Adjustment clips affect all video tracks located directly under the adjustment clip.
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Fusion is an advanced compositing 
application built directly into the DaVinci 
Resolve interface. Editors can use Fusion to 
create custom titles and credit sequences, 
insert missing elements into a scene, and 
cover-up continuity issues.

As Fusion is located directly in DaVinci 
Resolve, switching between editing, grad-
ing, audio mixing, and compositing is a 
seamless process. It is no longer necessary 
to transcode or pre-render media. Instead, 
you click the page you need to immediately 
switch to the necessary toolset. The 
exercises in this lesson are designed to 
familiarize you with the Fusion page 
interface and some of its fundamental 
operations such as merging nodes, creating 
rolling credits, tracking clips, and keying 
green/blue screen. 

Lesson 8

Creating Graphics 
in Fusion
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Navigating the Fusion Page Interface
To begin creating custom graphics and composites in Resolve, all you need to do is click 
the Fusion page icon at the bottom of the interface. This quick exercise will take you 
through the Fusion interface and identify the layout and functionality of its panels.

The project used for the exercises in this lesson will be based on a series of shots from the 
short sci-fi film Sync.

1	 In the Project Manager, right-click, and choose Restore Project Archive. Navigate to 
R16 Editing Lessons > Lesson 08 VFX. 

2	 In the lesson 08 folder, select R15 Editing Lesson 08 VFX.dra, and choose Open. 

3	 Open the project and select the Edit page, if necessary.

4	 On the Edit page, ensure that 01 Fusion timeline is open, and the playhead is on the 
first clip. 

To work on a specific clip in Fusion, the playhead must be placed over it on the Edit 
page timeline. With multiple video tracks, the top-most clip will be sent to Fusion for 
compositing.

5	 Click the Fusion page icon at the bottom of the interface, or press Shift-5 to launch Fusion.

Viewer 1

Work Area Toolbar Inspector

Viewer 2

Fusion is divided into four main sections. The two viewers at the top can be used to 
show the output of any node in the pipeline. Directly under the viewers is a time ruler 
with playhead controls. In the middle of the page is the toolbar, where you can access 
the most commonly used tools and effects. The large work area at the bottom is used 
to construct and animate composites via the Node, Keyframe, and Spline editors. 
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The Inspector on the right side of the page contains the adjustable parameters for any 
selected node.

6	 The main work area currently displays the Node editor. The Keyframe and Spline 
editors can be activated in the work area by clicking their respective buttons in the 
Interface Toolbar at the top of the page.

To move around the work area, hold down the middle mouse button and drag inside 
the panel.

TIP  To zoom in and out of the work area editors, hold down the Cmd key 
(macOS) or the Ctrl key (Windows) and scroll the middle mouse wheel.

7	 Underneath the viewers, drag the red playhead line to scrub through the clip.

Note the green lines that appear under the frames of the time ruler. These represent 
the portions of the video that are cached. To see a composite in real time, you must 
first play the video through until all frames are cached. Once the time ruler is solid 
green, it will playback in real time. 

TIP  You can allocate more RAM to the Fusion page using the Fusion memory 
cache setting located in Preferences >System>Configuration.

The yellow lines on either side of the time ruler define the render range. This is the 
duration that will be used for playback, caching, previews, and final rendering. In longer 
takes, you might want to drag the yellow bars to shorten the render range and focus 
only on the composited areas for faster preview. 

TIP  Press the Left and Right Bracket keys to navigate up and down the 
timeline by one frame. Move the playhead to the start and end of the render 
range by pressing Option-[ or ] (macOS) or Alt-[ or ] (Windows).

Now that you are familiar the time ruler and can navigate in the node editor, you can 
begin adding nodes to the pipeline.
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Understanding the Node Editor
As with all node-based compositing interfaces (including the node editor in the Color Page 
of DaVinci Resolve), the order and placement of the nodes in the pipeline has great 
significance. The RGB signal flows through the various media and image processing 
operations in the node editor before it reaches a final output node.

This method of compositing requires some practice to fully grasp, but is ultimately more 
processor efficient and versatile than layer-based systems.

The next set of exercises will familiarize you with the signal pipeline and the impact that 
node order has on it.

Assigning Media Nodes to the Viewer
You can change the behavior of the viewers in the Fusion page based on the stage of your 
workflow that you want to focus on. In this exercise, you will assign viewers to different 
nodes for preview.

1	 Any clip or image file that you bring into the Fusion page is represented by a MediaIn 
node. In the current node editor, the MediaIn1 node is connected to the source video 
file of clip 1 in the timeline. 

The MediaOut node is the final output of the signal flow and represents how the image 
will look upon delivery.

Select MediaIn1 and press 1 on your keyboard to send the signal of the source video 
to viewer 1.

The two dots under the nodes represent which node is being shown in which viewer. 
To change what the viewers display, click any node in a pipeline and press 1 or 2 on 
your keyboard, or click directly on the dots underneath the nodes.
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TIP  When using a third display, such as a full screen broadcast monitor 
connected via a Blackmagic Design UltraStudio or DeckLink card, you will see 
three dots under the nodes. Pressing 3 will display the node in full screen in the 
grading monitor. 

2	 To maintain order and ease navigation within the node editor, you can rename your 
nodes. Right-click MediaIn1 and choose Rename or press F2 to reveal the rename tool.

3	 Enter the name SYNC_SHOT.

TIP  Spaces are not displayed in the node labels of the Fusion page. 
Create separation between words with capital letters or an underscore.

4	 Rename MediaOut1 as OUTPUT.

With the media assigned and labelled, you can start to add additional nodes 
between them. 

Adding a New Node
Nodes are essential to manipulating the image in the Fusion page. There are a wide variety 
of node types—some alter the pixel data of the image, some control its movement and 
behavior, and others generate RGB data that is added to the existing image. 

NOTE  In Fusion, nodes that affect the behavior of a signal are also referred to as 
tools. In these exercises, both terms will be used based on function. 

There are several ways in which tools and nodes can be accessed and added to a 
composite. One way is to use the Effects Library panel in which the tools are clearly 
labelled and categorized. 

In this exercise, you will transform and warp the first shot in the timeline to reframe it.

1	 Open the Effects Library panel.
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2	 Expand the Tools folder, and enter the Transform category. 

3	 Drag the Transform tool onto the connection between SYNC_SHOT and OUTPUT 
in the Node editor.

4	 Click the Effects Library button again to hide the panel and make more room for 
the viewers.

At the moment, the scene in the viewer is building tension by showing the growing line 
of these sync surveillance machines. They take up the majority of the frame, and are 
presented as an imposing group. 

In this quick exercise, you will change the narrative of the scene by resizing and 
reframing the shot. The aim will be to get the audience to connect with the character 
in the middle.

5	 Select the Transform node. 

6	 In the Inspector, increase the Size to about 1.2.

7	 Use the onscreen controls in viewer 2 to push the video to the left. Your goal is to move 
the central character to the left third of the screen to create a stronger screen presence.
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Note that only viewer 2 shows you the result of this change. This is because viewer 1 
is currently set to show you the state of the SYNC_SHOT source, which is not being 
affected by the Transform node.

The final image has a significant gap on the right side of the screen. You can fill this 
gap by stretching the RGB data on the right side of the shot. Doing so is advisable only 
in shots that have no moving elements, and the data is either out of focus, or a solid/
gradient color.

8	 Open the Effects Library.

9	 Expand Tools > Warp and click Grid Warp. 

Doing so adds the Grid Warp tool directly after the Transform node.

10	 You can use the grid warp to stretch pixel data in the viewer. At the moment, you have 
too many divisions to stretch the data to a satisfactory degree. In the Inspector, change 
the X Grid Size to 2.

This change will decrease the divisions down to two columns which will allow you to 
use the entirety of the data on the right-hand side of the shot.
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11	 Hold down the Cmd key (macOS) or the Ctrl key (Windows) and scroll the middle 
mouse wheel to zoom out of viewer 2. 

12	 Hold down the Cmd key (macOS) or the Ctrl key (Windows) and drag across the side of 
the grid to select all the points in the right-most column.

13	 Hold Shift-Alt on your keyboard and press the Right Arrow key to move the edge of the 
column off the screen.

Doing so will stretch the pixel data on the right side of the image. Continue to stretch 
the grid until the gap on the right is completely filled up.

The scene now has a different feel to it—the audience is now connecting much more 
strongly with the central character. 

This reframed shot is now ready to be viewed back in the timeline of the Edit page. 

14	 Click the Edit page icon at the bottom of the interface, or press Shift-4.

Note that the changes you have made have been immediately applied to the clip. 
No rendering or exporting was required. 
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A symbol in the lower-right corner of the clip indicates that it has been composited in 
the Fusion page. 

15	 Return to the Fusion page.

You can use warp tools to create dramatic results, but they are also capable of more subtle 
application, like when realistically extending the edge of a frame.

Using Text and Merge Nodes
Nodes that act as tools can be connected directly to the node pipeline. When you want to 
introduce additional media layers to a composite, or add nodes that are generators of RGB 
data (such as text nodes or solid backgrounds), you will need to use merge nodes.

Switching Between Clips
For the next exercise, you will first need to switch to a new clip on the timeline. You saw at 
the start of the lesson that you could accomplish this by placing your playhead over the 
relevant clip in the timeline on the Edit page. But you can also switch between clips in the 
Fusion page.

1	 Click the Clips button at the top of the page to open the thumbnail timeline. 

2	 Select clip 2.

The Fusion page will load the new clip, and display a blank composition pipeline 
consisting of just the MediaIn and MediaOut nodes.

Notice that you can right-click on any thumbnail in the timeline to reveal new 
composition controls. Use these controls when you want to attempt a new version of 
a composite, but do not want to lose your previous work.

3	 Click the Clips button again to hide the timeline and make more room for the Node 
editor and viewers.

With the relevant clip selected, you can now begin to composite the opening title 
graphics over it.
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Adding Text to a Composition
When adding additional media to a pipeline, you need to specify how it will relate to the 
existing composite in terms of its layer structure. Merge nodes allow you to combine the RGB 
data of multiple media streams, with dedicated inputs for foreground and background elements.

In this exercise, you will design the opening text graphic for the film Sync.

1	 Open the Effects Library, and locate Tools > Generator.

2	 Drag the Text+ tool into an empty part of the Node editor above MediaIn1.

The Text+ node appears in the graph, but does not yet have a relationship with the 
connection line between the MediaIn and MediaOut nodes, and will not have an 
impact on the image in viewer 2.

To layer the background over the video, you will need to use a Merge node.

Although the Effects Library includes the full range of tools, you can access the most 
common tools in the toolbar above the Node editor. The toolbar is divided into six 
categories. From left to right the categories are: Generators, Color, Transforms, Masks, 
Particles, and 3D.

Generators Color Transforms Masks Particles 3D

Clicking any tool in the toolbar inserts it directly after the selected node. This behavior 
makes it very easy to add nodes precisely where you need them without the need to 
manually connect them.

TIP  Hover your mouse pointer over the icons in the toolbar to see the names 
of the tools. 

3	 With the MediaIn1 node selected in the Node editor, click the merge tool in the toolbar.
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The Merge1 node appears in the editor. It has three color-coded inputs: background 
(orange triangle), foreground (green triangle), effect mask (blue triangle), and one 
output (white square).

Foreground Input

Output
Background 

Input

Effect Mask Input

4	 Click the output of the Text1 node and drag it to the Merge1 node to connect them.

With the Text1 node selected, you can now enter and customize the text that appears 
over the video clip.

NOTE  The merge node is one of the most essential and frequently used 
tools in the Fusion page. In each merge node, the orange connector always 
represents one background layer and the green connector is always a 
foreground. Every time you want to add additional layers to a composite, 
you need to create a new merge node and link the respective foreground 
and background layers along the node pipeline.

5	 In the Inspector, enter the film title SYNC into the Styled Text field.

6	 Use the pop-up menu to set the font to Open Sans and give it a Regular weight.

7	 Increase the size of the text slightly (0.125) to make it easier to read on the screen.

TIP  The small gray dot under any parameter shows the default position of that 
slider. Clicking the gray dot resets the slider to the default position.
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8	 Increase the tracking (1.100) to space the letters farther apart.

9	 Use the onscreen controls to move the position of the text into the lower right. Placing 
it over the building in the foreground will give it a good amount of contrast and make 
the text pop.

At the moment, the text is plain white. You can use the swatch under the Font field 
to change the text to a different solid color. For more advanced controls of the text 
appearance, including adding outlines and shadows, you will need to use the Shading 
tab in the Inspector.

Using Shading Elements to Customize Text
Visual configurations of text nodes are known as shading elements. By default, when 
you create a new text node, only one shading element will define the fill type and color 
of the text.

1	 Click the Shading tab button at the top of the Inspector.

2	 Under the Properties heading, change the fill type to Gradient.

You can now use the shading gradient bar to specify which colors will appear in the 
gradient fill of the text. The default setting is a black-to-white gradient.

3	 Click the triangle on the left side of the gradient bar, and then use the color picker 
underneath to set its color to dark gray.
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4	 Click the gradient bar itself to add a new swatch triangle on the left half of the gradient. 

5	 Use the color picker to set the middle gradient color to white.

The resulting gradient should look like brushed metal.

To make the text stand out against the background a bit more, you can also add a 
soft shadow. To accomplish this, you will need to create a new shading element and 
designate it as a shadow.

6	 Click the Select Element pop-up menu, and choose 2.

7	 Click Enabled to open the shading element controls.

Shading elements can be modified in a multitude of ways. You can use the Appearance 
controls in the Properties segment to specify a starting point such as Text Fill, Text 
Outline, Border Fill, or Border Outline.

However, the numbered elements also have some default behaviors. As you can see, 
element 2 begins as a red outline. To save time, you can activate shading element 3, 
which always starts off as a drop shadow.

8	 Unselect Enabled to disable shading element 2.

9	 Select element 3 and click Enabled to display the default text shadow.

10	 Lower the Opacity to 0.5 to make the shadow softer against the background.

To better blend the text into the scene behind it, you can activate a composite mode 
in the merge node.

NOTE  Composite or blend modes refer to processes in which two layers are 
combined using an algorithm that adds, subtracts, multiplies or divides their 
respective luminance or chrominance pixel values. Blend modes are often 
used in graphic design, or for light/shadow-based visual effects. 

11	 Select the Merge node.
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12	 Change Apply Mode to Hard Light.

The darker elements of the foreground (the edges of the gradient) now blend, while 
retaining the brightness of the lighter elements.

With the text in place, you can now start animating its parameters to make its appearance 
on screen more dramatic.

Keyframing Parameters
You can change the value of a parameter over time by using the keyframe controls in the 
inspector. In this exercise, you will change the opacity and scale of the text as it appears, 
and then refine the gradient to give it a dynamic shine. You will then use the keyframe 
editor to refine your animations. 

1	 When animating motion graphics, it’s often a good idea to start at the end, where your 
graphics are set to their final positions.

On the time ruler, move the playhead to frame 75.

One of the most common animations for text is to change the opacity, creating a 
fade-in effect.

2	 With the merge node still selected, click the keyframe icon next to the Blend parameter.

Doing so will lock the value of the blend parameter to that moment in time.

3	 Drag the playhead to the beginning of the clip (frame 58).

4	 Change the Blend parameter to 0.0.

The text disappears from the screen.

5	 Drag the playhead across the time ruler to see the text slowly fade in.

You can also animate physical properties of the text such as size or rotation. Any 
parameter with the keyframe icon next to it is capable of animation.

6	 Select the Text node.

7	 In the Inspector, enter the Transform tab.

At the bottom, the individual X and Y size parameters allow you to stretch or compress 
the text on a vertical or horizontal scale. You are going to animate the X Size parameter 
to expand the individual characters into their final positions.
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8	 Move the playhead to frame 75.

9	 Click the keyframe next to the X Size parameter.

10	 Drag the playhead to the beginning of the clip.

11	 Change the X Size value to 0.0.

12	 Drag the playhead across the time ruler to check the animation. The characters now 
fade in, as well as scaling horizontally.

Finally, you can also animate color values. You will adjust the behavior of the gradient 
to give the illusion of a white highlight travelling down the letters.

13	 Enter the Shading tab.

14	 Move the playhead to the end of the clip (frame 92).

15	 Click the keyframe next to the ShadingGradient bar.

16	 Drag the playhead to the beginning of the clip.

17	 Drag the center of the gradient (the white triangle swatch) to the right side of the gradient.

Playing back the animation, the highlight will appear to react to the “spinning” effect of 
the letters. However, the speed of the opacity fade and the rotation appears too slow. 
Let’s refine the speed of these two parameters.

18	 Click the Keyframes button in the interface toolbar.

TIP  Press Cmd-F (macOS) or Ctrl-F (Windows) to expand the size of the 
Keyframes or Splines editors to accommodate all the node animations.

19	 Expand the Merge1 and Text1 headers to view all the parameters you have animated 
and their respective keyframes.

20	 Drag the first keyframes (white horizontal lines) of the Blend and CharacterSizeX 
parameters to start on frame 65 of the time ruler.
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When you play the animation now, you’ll see a pause before the letters start to fade in. 
The speed of both the rotation and opacity is increased because the keyframes are 
closer together. 

As you can see, you can perform most keyframing directly in the Inspector using the 
time ruler as a reference for placement of keyframes. To make refinements or to ease 
the speed of animation, you can access the Keyframe and Spline editors to gain more 
control over the behavior of the keyframes.

Adding Effect Nodes to the Pipeline
In this exercise, you will add a lighting effect to the gradient and a simple blur tool to imitate 
a shallow depth of field. An important question to ask yourself when adding new tools is 
where in the pipeline the node should be placed to give you the result you need.

1	 Open the Effects Library.

2	 Expand OpenFX, and select ResolveFX Light. You will add an effect to the text to 
enhance the travelling gradient, turning it into a shard of light.

For this to work, the effect needs to be placed directly after the text node.

3	 Drag the Aperture Diffraction effect onto the connection between the text and 
merge nodes.

4	 At first, the light will look distorted. You need to refine the effect parameters to 
correctly impact the gradient values.

5	 Increase the Result Gamma (3.0) to concentrate the brightness to the text 
gradient highlight.

6	 Reduce the Result Scale (0.400) to limit the diffraction to a smaller area.

7	 Reduce the Brightness (0.11) in the Compositing Controls to make the reflection 
more realistic.
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To further enhance the text composite, you’ll blur the image in the background to 
imitate shallow depth of field. Review your node pipeline and think about where the 
blur tool needs to be placed. 

	� If it is placed after the merge node, both the text and image will be blurred. 

	� If it is placed after the Aperture Diffraction, only the text will be blurred.

	� The blur tool needs to be placed after MediaIn1 to only affect the background video.

8	 Select MediaIn1.

9	 Click the Blur tool button in the toolbar—it is the last button in the Color category.

10	 Increase the Blur Size (10.0) until the image appears out of focus.

The text now stands out, but too much interesting information was removed by the blur. 
Ideally, you’d still want the audience to see the spaceship in the background.

In the next exercise, you will use a mask to define which area of the image will be 
affected by the blur tool, and which area will be left in focus.

When adding new nodes to a pipeline, you will occasionally need to pause and think 
about how various stages of the signal will be impacted. Occasionally, some 
experimentation may be necessary to review how the node impacts the final 
composite. Over time, this workflow becomes more intuitive and the placement of 
nodes more apparent.

Using Masks to Target Effects
With the effect in place, you can now use a mask node to isolate which region of the image 
the tool affects. You can make mask nodes based on preset shapes (rectangles, ellipses), 
custom drawn shapes (polygons, b-splines), animated objects, or even luma/chroma data.



236
Le

ss
o

n
 8

 
C

re
at

in
g

 G
ra

p
h

ic
s 

in
 F

u
si

o
n

1	 With the blur node still selected, click the Ellipse mask in the toolbar. 

The blur effect is contained within a circle in the viewer. To create the effect of soft 
focus, you will need to invert the circle, and then soften its edges.

2	 Select the Invert checkbox in the Inspector.

3	 Increase the Soft Edge (0.18) setting to blur the circumference.

4	 Scrub through the time ruler to check the position of the spaceship. 

5	 Use the controls in the viewer to adjust the position and size of the circle mask to keep 
the spaceship in focus throughout the shot.

Masks have a wide range of applications when it comes to compositing. They are 
frequently employed in motion graphic design to achieve specific shapes and animations, 
and combined with chroma key workflows to eliminate unusable parts of a green screen. 
They are also used for rotoscoping workflows, in which a subject is carefully traced to allow 
another image or video layer to be placed behind them.
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Creating Rolling Credits
With an understanding of node pipeline construction, you can now look at more dedicated 
industry motion graphic workflows. For example, depending on production scale and 
budget, it is frequently the role of the editor to create rolling credits at the end of a film. 
This can be easily accomplished in the Fusion page with the help of a text node, 
a keyframed transform node, and some dedicated text parameters.

Generating a Blank Fusion Composition
First, you will need to create a blank Fusion composition to act as the foundation for your 
credit roll animation. 

1	 Click the Edit page icon at the bottom of the interface, or press Shift-4.

2	 Open the Effects Library from the interface toolbar at the top of the page.

3	 Expand the Toolbox and select Effects.

4	 Drag the Fusion Composition effect to the end of the 01 Fusion timeline.

5	 To adjust the duration, right-click the Fusion composition clip on the timeline, and 
select Change Clip Duration.

6	 Change the clip duration to 00:00:15:00.

Doing so will extend the blank Fusion composition to 15 seconds.
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7	 With the playhead on the Fusion composition, enter the Fusion page.

This time, the Node editor will have only a single MediaOut1 node. Unlike in previous 
exercises, no associated source media is present in the Fusion composition.

8	 Drag the text tool from the toolbar onto an empty area of the Node editor.

9	 Connect the text tool output to the MediaOut1 input.

10	 Enter the film title Sync into the Styled Text box of the Inspector.

11	 Press the Enter key two times and type Written and Directed by Hasraf Dulull.

12	 Leave the font as Open Sans, but change the weight to Regular.

13	 Reduce the font Size to 0.05.

These are the two lines of text that you will want to keep centered. All the following 
credits listing the actors and their roles must be placed into columns. 

Using Tab Spacing to Align Columns
Traditional rolling credits tend to appear as two columns of text aligned at the center. 
A parameter in the text node inspector allows you to quickly define and align columns of 
text within a single node.

1	 Press the Enter key two times under the director’s line in the Styled Text box.

2	 Type Martin Batchelor Sync.
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3	 Press Enter and type Dean S. Jagger FBI Agent Jenkins.

At the moment, the two actors’ lines appear centered and difficult to read. Tab spacing 
will allow you to define the alignment of their names and roles. You can use the Tab key 
on your keyboard (usually above the Caps Lock) to define multiple columns in your text.

4	 Click in front of Martin Batchelor’s name in the Styled Text box, and press the Tab key.

5	 Click in front of Dean’s name, and press the Tab key.

To define the second column in the credits, you will need to click in front of the roles 
and press the Tab key again.

6	 Click in front of the word “Sync,” and press the Tab key.

7	 Click in front of “FBI,” and press the Tab key.

You’ve defined the columns, but the text appears to look worse in the viewer because 
you have not specified the position or alignment of the columns.

8	 At the bottom of the Inspector, expand the Tab Spacing category.

9	 Under Tab 1, change the Position to -0.03.

10	 Drag the Alignment all the way to the right (1.0) to line up the names.

11	 In the pop-up menu next to Tab, select 2 to adjust the second tab column.

12	 Change the position to 0.03.
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13	 Drag the Alignment all the way to the left (-1.0) to line up the roles.

The actors’ names now have a right alignment against the roles’ left alignment. You can 
copy the rest of the names for this short film from a text document.

14	 Open a Finder in macOS or a Windows Explorer window and locate the R16 Editing 
Lessons > Lesson 08 VFX folder.

15	 In the Lesson 08 VFX folder, open the Sync Credits.rtf document in Windows Notepad 
or the macOS Text app.

16	 Copy the remainder of the cast list and paste it into the Styled Text box under the two 
lines you have already entered.

The tab information from the text document should travel across and automatically 
place the actors and roles into their respective columns. If it does not, use the Tab key 
to define the columns in the Styled Text box.

When preparing credits for a film, you can preemptively start defining the columns by 
pressing Tab in front of names and roles. Tab information will carry across from most 
text editors and can immediately be used to define the position of credit columns.
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Adding a Logo to a Credit Roll
As a finishing touch, you will merge a logo to the end of the credits sequence and use a 
transform node to scroll it together with the text layer.

1	 Open the Media Pool.

2	 From the media bin, drag Blackmagic_Design_alpha_logo.png into the Node editor.

3	 Drag the output of the logo node to the output of the text node.

When connecting the output of one node to another, you automatically generate a 
merge node that will treat the first node as the foreground layer.

4	 Rename MediaIn1 as LOGO.

The logo is too big and is overwriting the credits. You can use a transform node to 
resize and reposition the logo.

5	 With the LOGO node selected, click the Transform node in the toolbar.

6	 In the inspector, decrease the Size to 0.60.

7	 To make it easier to see where you are placing the logo, zoom out in the viewer until 
you can see the gray area around it.
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8	 Drag the Center Y parameter in the Inspector, or use the onscreen controls to lower 
the logo under the credits.

With all the elements in place, you can now animate the credit scroll. The best place 
to do so will be in a transform node added after the merge that will treat the credit 
and logo as a single combined layer. 

9	 Add a Transform tool after the merge node.

10	 Drag the playhead to the first frame (0.0) of the composition.

11	 Lower the Center Y value until the top of the credits are beneath the bottom of 
the viewer.

12	 Click the keyframe next to Center Y to activate keyframing.

13	 Drag the playhead to the last frame (359.0) of the composition.

14	 Raise the Center Y value until both the credits and logo are offscreen at the top of 
the viewer.

15	 Play the animation to check your credit scroll.

You can combine credits and logos in numerous configurations using multiple merge 
nodes and a universal transform control. 
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Tracking a Scene
Tracking refers to a process in which the software detects the motion of a camera or subject 
based on the changing pixel values in a video clip. Once tracking data is extracted, it can 
be applied to other layers to create the illusion of those elements being part of the scene.

Tracking is a vital component of all compositing workflows that feature moving footage 
whether you are inserting a 3D character, putting up a poster, replacing a screen, or 
removing film equipment from a scene. 

Creating a Fusion Clip in the Edit Page
When editing media that is intended for compositing—for example green screen and 
backplate footage—it is usually the role of the editor to define the cut points of both media 
clips. This tends to be easiest to do on the timeline of the Edit page.

Once the clip lengths are determined, they can be transformed into a Fusion clip in which 
they will appear merged and ready for compositing on the Fusion page. 

1	 Click the Edit page icon at the bottom of the interface, or press Shift-4.

The third clip in the timeline features a video of a presenter on stage with a robot 
graphic on the video track above it it. You’ll begin by rescaling and repositioning the 
graphic before proceeding to the Fusion page. 

2	 Select the robot graphic clip.

3	 Open the Inspector in the Edit page.

4	 Lower the Opacity to 50.00 to see through to the background image.

5	 Click the Transform button in the lower-left corner of the viewer.
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6	 Use the onscreen transform controls to resize and reposition the robot on the stage.

7	 Set the Opacity back to 100.00.

8	 Select both the robot graphic and clip 3 on the timeline.

9	 Right-click and choose New Fusion Clip.

10	 Enter the Fusion page.

The two clips now appear merged in the newly created Fusion clip.

11	 Rename the clips as BACKPLATE and ROBOT.

To remove the black background from the robot graphic, you will use a blending mode 
that subtracts dark areas from a foreground layer.

12	 Click the merge tool, and set the Apply Mode to Screen.

With the clips merged in the Fusion page, you can now proceed to track the backplate 
and apply the data to the foreground graphic.
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Using the Tracker Node
The tracker tool allows you to define a specific area in the frame that is a reliable reference 
for the movement of the camera, or to a visible item in the shot. Ideally, you want to specify 
an area that is always in the shot and located on the same plane as the object you want to 
add to the scene.

1	 Drag the playhead to the first frame of the clip in the time ruler. Doing so will make 
it easier to perform a track because you will need to analyze the footage in only 
one direction.

2	 Select BACKPLATE to indicate the media you wish to track.

3	 In the Effects Library, locate the Tracking folder, and click the Tracker tool node.

Tracker1 appears between the BACKPLATE and merge nodes. A green tracker outline 
appears in viewer 2.

Hovering your mouse pointer over the tracker in the viewer displays two boxes. The 
inner box defines the pattern that the program will search for in every frame of the clip. 
The outer box is the search area within which the program will search for that pattern. If 
the pattern travels beyond the confines of the search area from one frame to the next, 
the track will be unsuccessful.

When performing pattern selection, aim to pick an area with high contrast, sharp focus, 
and reliable movement in relation to the scene. The search area must also be reshaped 
to match the projected movement of the clip (that is, a larger search area is necessary 
for a clip with rapid movement). In both cases, the larger the box, the longer the 
analysis will take to perform.

4	 Click the upper-left corner of the tracker, and drag it down to the lower-right corner of 
the projection screen in the shot. The dark geometric shapes against the white surface 
make an ideal tracking pattern.
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5	 Drag the lower-right corner of both boxes to expand the size of the pattern and elongate 
the search box in preparation for the panning camera motion.

6	 At the top of the Inspector, click the Track Forward button.

Keep an eye on the pattern as the track is performed. If the tracker loses its place 
at any point, it’s best to terminate the action instead of continuing with an unusable 
track analysis.

7	 A pop-up window will verify if you want to stop the render. Click Yes to confirm.

TIP  Double-clicking an empty gray space in the Node editor will temporarily 
hide onscreen controls. Select the tracker node to return the onscreen controls 
to the viewer.

Next, you will apply the gathered tracking data to the robot to match its movement 
to the motion in the background.

8	 Click the Operation tab at the top of the inspector.

9	 Change Operation to Match Move.

10	 Change the Merge option to “FG over BG.” Doing so specifies to the tracker that any 
foreground element will be match moved to the motion tracked in the background.

At the moment, the tracker node does not have a foreground signal.
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11	 Drag the output of the ROBOT node to the green foreground input of the tracker.

12	 Like the merge node, the tracker node also offers blending mode options. Change the 
Apply Mode in the inspector to Screen to blend the robot graphic into the backplate.

Because the tracker is now performing the function of merging and blending the 
graphic, the merge node has become redundant.

13	 Delete the merge node.

14	 Drag the playhead through the time ruler to verify that the track was successful.

15	 To better blend the graphic into the background, add a blur node after the ROBOT 
node, and leave the gentle default blur size at 1.0.

16	 Drag the Color Corrector tool from the toolbox and attach it to the connection after 
the blur node.

17	 In the Inspector, drag the Master wheel toward cyan to make the graphic a greener 
shade of blue.

You can also add another transform tool to the ROBOT connection line to make changes 
to the scale or positioning of the graphic.

Match moving is the central principle behind placing artificial elements into a scene with 
camera movement. Its most popular applications include sky replacement, sign removal, 
cover-up and paint work, compositing of 3D characters and vehicles, and much, much more.
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Keying and Compositing
Chroma keying refers to any process in which a portion of the frame is targeted based on 
its color properties. Most frequently, this is associated with removing blue or green screen 
to leave the foreground subjects on a transparent background. These subjects can then be 
placed over any other layer, giving filmmakers complete control over their environment.

Pulling a Key
In this exercise, you will key a subject from a portable blue screen and place it into a new 
environment. 

1	 Go to the Edit page.

2	 Select Blue Key clip and Clip 4 on the timeline, then right-click and choose New 
Fusion Clip.

3	 Rename MediaIn1 as BACKPLATE and press 1 to view it in the left viewer.

4	 Rename MediaIn2 as BLUESCREEN and press 2 to view it in the right viewer.

As you can see, the BACKPLATE node features an interior background onto which you 
want to composite the character. The BLUESCREEN node features the shot of the 
character in front of a portable chroma blue screen. The first step in this composite 
will be to key out the blue screen. 

5	 Select the merge node and press 2 to view it in the right viewer.

6	 Select the BLUESCREEN node.

So far, you have been adding new tools and nodes using the Effects Library and 
the toolbar. You can use is a third way to quickly add nodes to pipeline with the help of 
a simple shortcut.

7	 Press Shift-Spacebar to open the Select Tool dialogue window.



249

K
ey

in
g

 a
n

d
 C

o
m

p
o

si
ti

n
g

8	 Type delta into the search bar at the bottom.

The Select tool will filter any tools that contain a search term as you type. This is one of 
the quickest ways to add nodes to the editor, provided you already know their names.

9	 Select Delta Keyer (DK), and click Add.

10	 To extract the blue screen, click and hold the eyedropper tool next to the Background 
Color swatch in the inspector, and drag your mouse across to viewer 2. 
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11	 Release your mouse over the blue screen to grab a chroma sample.

You will immediately see the result of extracting the selected blue hue. However, this is 
just the first step of the keying process. You now need to review the quality of the key 
and clean it up.

12	 Select the delta keyer node and press 1.

13	 In viewer 1, in the Color pop-up menu, choose Alpha to see the alpha channel of 
the key.
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A good key should be black and white with black representing transparency and white 
representing full opacity. At the moment, the matte has too many gray areas, which will 
result in semi-transparency in the top layer.

14	 To clean up the matte, enter the Matte tab in the Inspector.

15	 Drag the Low Threshold slider to the right until you no longer see gray areas in the 
black background.

16	 Drag the High Threshold slider to the left until the character in the foreground turns 
a solid white.

17	 Drag the Clean Foreground slider to the right until the reflection on the helmet 
is reduced.

The matte looks much cleaner now. However, looking at the merged image, it is 
obvious that there is still a lot of unnecessary information that needs to be removed 
from the edges of the foreground layer.
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Creating a Garbage Matte
In a previous exercise, you used a matte to define which area of the frame should be 
impacted by an effect node. In this exercise, you will use a polygon matte to refine what you 
want to keep visible in the foreground layer. This type of mask is known as a garbage matte.

1	 Drag the polygon tool from the toolbar onto an empty part of the Node editor.

2	 Drag the playhead to the first frame of the clip.

3	 Click around the character in viewer 2. If necessary, zoom out of the viewer to make it 
easier to click outside the frame.

When creating custom polygon, your final click must be on the first point you made to 
close the shape loop.

Next, you will need to animate the polygon shape as the camera pushes in. By default, 
all polygon shapes will automatically animate as you make changes to them on 
different frames on the time ruler.

4	 Drag the playhead to the last frame of the clip.
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5	 Adjust the polygon corners to fit the new frame.

6	 Move to the center of the time ruler, and adjust the points further, if necessary.

Keep making changes up and down the time ruler until the polygon moves smoothly 
with the character.

With the garbage matte completed, you can now connect it to the delta keyer node. 
The delta keyer has several dedicated inputs based on your workflow, supporting 
clean plates and solid mattes.

TIP  The Status bar in the lower-left corner of the interface shows basic 
metadata about any node you hover your mouse pointer over.

7	 Option-drag (macOS) or Alt-drag (Windows) the polygon output to the delta keyer node.

You will see a pop-up menu prompting you to indicate the input you would like to use. 
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8	 Choose GarbageMatte.

The edges of the frame disappear from the foreground layer revealing a clean 
extraction of the subject.

Compositing Layers using Color Correction
The two layers can now be clearly seen, but do not match due to their different filming 
conditions and color spaces. You will use a color corrector node to match the foreground 
to the background, and then add an additional color corrector at the end of the pipeline to 
create a single look for the scene.

1	 Select the delta keyer node.

2	 Press Shift-Spacebar and type corr.

3	 Select the Color Corrector tool, and click Add.

To better match the appearance of the foreground layer to the background, you will 
need to substantially darken the image.

4	 Drag Lift to the left to darken the shadows (-0.5).

The foreground character becomes darker, but the background is affected too! This is 
occurring because the color correction tool is applied to the full frame of the video with 
no regard for the mask (or alpha channel) of the BLUESCREEN layer.

When adjusting the brightness or color of a node with transparency, you will need to 
specify to the color correction tool to affect only the areas defined (or premultiplied) 
by the alpha channel.

5	 To fix the issue caused by premultiplication, open the Options tab of the color corrector.

6	 Choose Pre-Divide/Post-Multiply.

The grade is now limited to the foreground character layer.
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7	 Return to the Correction tab to continue grading.

8	 Drag Gamma to the left to darken the midtones (0.75).

9	 Drag Contrast to the left to reduce the contrast and bring the highlights closer to the 
shadows (0.70).

10	 Drag the center of the color wheel slightly toward magenta to undo the green tint in the 
midtones of the image.

11	 The highlights of the image are also very warm. At the top of the inspector, change the 
Range to Highlights.

12	 Drag the center of the color wheel toward blue/cyan.

With the layers matched, you can now apply a uniform look to the clip.

13	 Add a new color corrector node after the merge node.

You’ll aim for a cold, futuristic look.

14	 First, lower the gamma and increase the gain to increase contrast in the image.

15	 Drag the Master color wheel toward cyan/blue to make the image cooler.



256
Le

ss
o

n
 8

 
C

re
at

in
g

 G
ra

p
h

ic
s 

in
 F

u
si

o
n

16	 Switch the Range to Highlights.

17	 Drag the Highlights color wheel toward magenta to bring a slight tint to the lights in the 
ceiling and the reflections on the suit.

18	 Switch the Range to Shadows.

19	 Drag the Shadows color wheel toward green to give the overall look a more “techy” feel.

The final grading node was effective in compositing the two layers together, thereby 
helping to sell the look of the overall environment. In clips with a change of lighting 
conditions (such as the light going out at the end of this scene), you can also use 
keyframing to animate colors and luminance values over time.

Fusion is used for professional-grade visual effects work in film and television. Its tools 
offer a wide breadth of functionality ranging from subtle coverup work, motion graphic 
design and animation, to eye-catching particle generators, 3D assets, green screen keying, 
and set extension.

Due to this impressive variety of tools and their parameters, it might take some time to 
discover and master all of them. The DaVinci Resolve Reference Manual includes more 
in-depth explanations of all the Fusion features and the The Visual Effects Guide to DaVinci 
Resolve 16 is a good follow-up to this training manual.
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Lesson Review
1	 True or False? It is possible to have more than one MediaIn node in a composition.

2	 What type of node do you need to combine media and generator nodes (such as text) 
into a single pipeline?

3	 Which Inspector tab should you use when you want to add a drop shadow to text? 

4	 Which of the following would be inappropriate to use as a tracking point when 
performing a match move?

a)	 Corner of a building

b)	 Stickers on a desk surface

c)	 Leaf on a tree

d)	 Pen mark on actor’s face

5	 True or False? You can animate color correction effects.
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Answers
1	 True. MediaIn nodes are a link to the source media in the Media Pool. When 

compositing multiple layers, a dedicated MediaIn node will be available for each 
image and/or video source.

2	 The merge layer. It has a foreground and background input to indicate the layer order 
of media/generator nodes. A new merge node is required for every additional layer.

3	 The shading tab. In this tab, you will find advanced controls for the text fill, outline 
and shadows.

4	 c) Leaf on a tree. In all other scenarios, the tracking point will behave in a predictable 
manner. (In the case of the actor, it’s assumed you are adding/removing something 
from his face.) Leaves tend to move with the wind which makes them unreliable 
tracking points.

5	 True. Any parameter with a keyframe icon next to it can be animated. This includes 
transform controls, text parameters, effects, and color values.
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Your project’s soundtrack is an essential 
part of the overall audience experience. 
Fortunately, while the Fairlight page in 
DaVinci Resolve is designed to create big 
Hollywood soundtracks, you’ll find it familiar 
enough for you to use as an editor. 

In this lesson, you’ll explore techniques for 
audio editing, sound design, and final 
mixing, including “sweetening” your 
soundtrack as you apply professional 
equalization, dynamic controls, panning, 
and automation to your tracks. 

The goal of mixing and mastering is to 
balance the levels coming from each track 
so they sound good as a whole. Fortu-
nately, the Fairlight page includes 
everything you need to make sure the 
levels are right on target.

Lesson 9

Building and Mixing 
the Soundtrack 
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Preparing the Project
Before you start, let’s take a moment to open the project and get acquainted with the bins 
and timelines that you’ll be using throughout this lesson. Also, because you’ll be working in 
a new interface page, it’s a good idea to reset the DaVinci Resolve user interface (UI) so 
your interface will match the screenshots and descriptions in this book. Then, you can 
customize your workspace, as needed, while you work your way through the lesson.

TIP  Ideally, you’ll want to have a good set of speakers or headphones connected 
to your computer for this lesson to appreciate the audible subtleties.

1	 In the Project Manager, right-click and choose Restore Project Archive. Navigate to the 
R16 Editing Lessons folder, and open the Lesson 09 Audio.dra.

2	 Open the project from the Project Manager, and make sure you are on the Edit page.

In the Media Pool, you can see a series of bins that contain the elements of your scene 
with the Doctor and the FBI Agents. 

3	 Right-click the Master bin, and choose Sort By > Name to organize the bins by ascending 
alphabetical order.
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4	 Select the Timelines bin, and if necessary, switch to list view.

This bin contains seven timelines for the exercises in this lesson.

5	 Click the File Name column header to sort the bin in ascending order.

6	 Double-click the 01 AUDIO EDITING timeline to open it.

7	 Play through the timeline to reacquaint yourself with the scene.

For all intents and purposes, this process of enhancing the sound of your audio tracks 
could be called audio correction. You enhance, or sweeten, each track’s four fundamental 
elements—equalization, dynamics, pan, and volume level—so your tracks complement 
each other in the final mix.

DaVinci Resolve’s controls enable you to manipulate all four of these elements on every 
track without additional plug-ins or patching. Keep in mind that each of these controls could 
fill an entire lesson on their own, or even a book; however, for the purpose of this advanced 
editing instruction, you’ll gain a basic understanding of how these controls work and when 
you might need to apply them to your projects.

Setting up the Fairlight Page
Moving a project from picture edit to audio post has never been easier than it is in DaVinci 
Resolve. That’s because Resolve is the only professional editing system that also includes 
the Fairlight page, which is a fully functional digital audio workstation (DAW). As you work 
your way through the following exercises, you’ll find that many Fairlight page features function 
similarly or identically as in the Edit page.
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1	 At the bottom of the Resolve window, click the Fairlight button to go to the Fairlight page. 

2	 Choose Workspace > Reset UI Layout.

The default Fairlight layout shows only the audio tracks, toolbar, and transport controls. 
Also, the Fairlight timeline appears with plenty of room allotted for working on additional 
audio tracks. Let’s resize the current tracks to better fit the available workspace. 

3	 Press Shift-Z to fit the timeline clips horizontally, if necessary. 

4	 Fit the audio tracks vertically in the timeline window by holding down Shift and scrolling 
your middle mouse wheel.

TIP  On a trackpad, scrolling up zooms in and scrolling down zooms out. 
Keep in mind that when zooming a Fairlight timeline, the focus remains on the 
playhead followed by the selected track.

The default Fairlight workspace focuses entirely on the audio tracks in the timeline and 
the audio clips in the Media Pool. However, you can use the buttons at the top of the 
window to show or hide additional interface panels, as needed.
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5	 At the upper-left of the Resolve window, click the Media Pool button to show the Media 
Pool, including the Fairlight Page’s Media Pool preview player. Click the Timelines bin, if 
necessary, and switch to list view.

TIP  By default, the Media Pool in the Fairlight page displays only audio clips 
or clips that have audio. You can choose to change this behavior in the Media 
Pool options menu in the upper-right corner. 

6	 At the upper-right of the Resolve window, click the Meters button to open the 
monitoring panel. 

In the monitoring panel, you can monitor all of the audio and video contents of the 
current timeline. 
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NOTE  If you are using Blackmagic Design hardware to output the video from 
your Resolve workstation to a client monitor, you don’t necessarily need to use 
the preview viewer because the video output will still be maintained when 
working in the Fairlight page.

You can also view the clips on your video tracks in the Fairlight Page.

7	 Click the Timeline View Options button, and select the video tracks option.

The video tracks in your timeline are now viewable, but not editable. They will be 
useful to see where the clips start and stop.

Now, you are ready to start your first audio post-production role!
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Editing in the Fairlight Page
When you begin to think about sound effects, the first step is to just watch a scene without 
any audio. That’s right, totally silent. By watching a scene with the audio muted, your 
imagination can fill in the blanks and allow you to think about all the scene audio you 
might expect to hear or would like to hear.

1	 In the audio monitoring controls, click the mute button.

The mute button turns red to indicate that audio playback is muted.

NOTE  The slider to the right of the mute button allows you to change the level 
you are using to monitor the audio playback from Resolve while the DIM button 
is used to lower the playback volume to allow you to chat with your client, 
while keeping half an ear on the mix.

2	 Play the timeline from the beginning.

During playback, make mental notes as to what sounds (other than dialogue) should be 
included to make the scene seem real to the audience. Also, think about moments in 
the scene that might benefit from the addition of music, sound effects, or something 
extra to elevate the moment.

3	 Click the mute button to unmute playback.

4	 Play the timeline again from the beginning. During playback think about which sound 
elements are still needed to enhance the scene.

TIP  You may want to add markers to remind yourself of the different sounds that 
may be needed to enhance this scene. Feel free to add any you may think of, so 
you can later refer to the markers tab in the Index to easily locate these sections.

Chances are, the soundtrack elements that you imagined will seem even more necessary 
during this playback. First, you need to add some background to this scene to make it 
feel as though the room is full of people.
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5	 In the Media Pool, in the Audio bin, select the Foley bin.

6	 Select the Atmosphere wild sound clip.

You can play this clip in the Media Pool preview player in a similar manner to the source 
viewer in the Edit page, including adding in and out points, as necessary.

7	 In the timeline, right-click in the track headers and choose Add Track > Mono.
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8	 Rename the track WALLA 1, right-click its track header, and choose Change Track 
Color > Chocolate.

TIP  A “walla” track is a background track that consists of the general murmur 
of people talking without any actual discernable conversation.

9	 Drag the Atmosphere wild sound from the Media Pool player to the WALLA 1 track, 
starting at the first line from the Doctor on A1.

The audio clip inherits the same color as the track, but it’s a little too long for this scene.
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10	 Trim the end of the clip to the end of the last dialogue clip from the FBI Agent on A2.

11	 Drag the fade handles at the start and end of this clip to fade the background sound 
in and out of the scene.

12	 Press Home, and play the scene to hear how the sound effect fits.

Building up Sound Effects
One common sound design trick used in both music production and soundtracks is to 
double a track to thicken, or fatten, the sound. Sound is cumulative, so more tracks equals 
more sound.

For example, if you had a recording of 10 people in a room murmuring to each other like 
party guests, it would sound like ten people in a room no matter how loudly you played the 
track in the mix. However, if you were to copy (double) the track, place the same audio clip 
on a duplicate track, and offset it slightly so it didn’t play in sync with its duplicate, the result 
would sound more like a roomful of people. As it happens, this scene’s party track sounds 
like a handful of people (probably the ones you see in the background). To really “sell” that 
an auditorium full of people are at the gathering, you’ll want to double-up (or possibly even 
triple-up) the walla track.

You’ll need to duplicate the clip and offset it just slightly so that it sounds like more people 
and not just an echo. Then, you’ll apply a couple of tricks to further differentiate it from the 
first track. 

1	 Right-click the WALLA 1 track header, and choose Add Track > Mono. Rename this track 
WALLA 2. Right-click the track’s header, and choose Change Track Color > Chocolate.

2	 Select the clip on the WALLA 1 track, and choose Edit > Copy, or press Cmd-C (macOS) 
or Ctrl-C (Windows).
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3	 Click the track header for the WALLA 2 track to select that track.

You will see a semi-transparent version of the copied clip in the selected timeline.

4	 Choose Edit > Paste, or press Cmd-V (macOS) or Ctrl-V (Windows) to paste the copied 
clip into the new track.

5	 Play the scene to preview the changes.

So far, this still sounds like a small group of people murmuring and clinking glasses 
every now and then. When the two tracks play together, the only audible difference is 
an increase in the volume level. 

To offset the clips, you could just drag the copy to the left or right. However, a more 
sophisticated way to offset clips is to find a recognizable sound in one and make sure 
that it isn’t too close to the same sound in the other. In this case, you’ll use the sound 
of clinking glasses to track the clip offset. Luckily, that sound also happens to be the 
highest level peak in the clip, so it is easy to locate. 

6	 Press the JKL keys to play the highest peak in the WALLA tracks. Then, place the 
playhead just before the peak.

7	 Using the timeline ruler as a guide, trim the beginning of the duplicate clip to around 
00:00:06:00. 

8	 Select the clip on the WALLA 2 track, and press Cmd-X (macOS) or Ctrl-X (Windows) 
to cut the selected clip. 

The clip’s opacity lowers, just as it did with the copied clip; but this time, instead of 
creating a copy, you want to move the original.
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9	 Press the J key to move the transparent duplicate to the left until the beginning of 
the clip aligns with the beginning of the clip on the A6 track. Press Cmd-V (macOS) 
or Ctrl-V (Windows) to paste the clip. 

Notice that throughout the move, the playhead maintained its position on the selected 
clip. Don’t worry about extending the duplicate clip because you’ll be changing its 
speed shortly. You’ll change its duration, as well. 

TIP  You can also simply pick the clip up and move it as you would in the 
Edit page.

10	 Play the beginning of the WALLA tracks to hear how the offset clips suggest a larger 
number of guests in the room. Unsolo and then solo one of the WALLA tracks during 
playback to compare the sounds of one track with the offset-doubled tracks. When you 
are finished, unsolo the tracks.

Of course, because audio levels are cumulative, the background tracks are now too 
loud. So, before moving on, this is a good time to lower the walla clips’ playback levels. 

11	 Choose Fairlight > View Clip Info Display, and in the Clip info Display box, select 
Volume. Click OK.

The current gain level for each clip appears at the head of each clip in the timeline.
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12	 Play the scene with the WALLA tracks, and lower their clip volume curves. Trust your 
ears and set them to suit yourself. If you aren’t sure of a satisfactory level, set each clip 
to around -2.80 dB. 

TIP  You can also adjust the clip volume of the selected clip or clips in 
the  Inspector.

You’ve just increased the number of party guests without hiring extras, reshooting a 
scene, or even recording audio with more guests. Best of all, you learned a cool audio 
trick for doubling tracks. Audio post-production often involves precisely moving a lot 
of clips, so those common keyboard shortcuts to cut, copy, move, and paste will be 
real-time savers.

Applying Speed Changes to Audio
In this exercise, you’ll apply the power of audio speed changes in the Edit page to enhance 
this scene. The three variables to consider are duration, pitch, and sync.

1	 Go to the Edit page.

The first thing you should notice is that all the editing you’ve been doing in the Fairlight 
page has instantly updated in the Edit page because the two pages display exactly the 
same timeline, albeit in two different ways.
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2	 In the timeline, scroll down to the A7 WALLA 2 track, and select its audio clip. Right-
click the selected clip, and choose Change Clip Speed.

The Change Clip Speed dialog appears with a Speed field for changing speed, as well 
as the Pitch Correction checkbox. Your goal is to lower the pitch of the walla clip to 
differentiate its sound from the first WALLA track. Doing so will enhance the fuller 
crowd sound that you created previously.

3	 In the Change Clip Speed dialog, deselect the Pitch Correction checkbox which will 
produce a deeper, slower sound. 

4	 In the Speed Data field, type 90. Click Change, or press Return.

You won’t see a difference in the timeline, but you will hear it, eventually. First, let’s trim 
the clip in the WALLA 2 track to match the length of the clip in the A6 track.
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5	 Drag the right edge of the clip to extend it. When you are finished, deselect the clip. 

6	 Solo the A6 and A7 tracks. Play them together, and then play each soloed to hear the 
difference in pitch between the original and the modified clips. When you are finished, 
unsolo both tracks.

As you can hear, speed changes are as useful in sound design as they are on your video 
tracks. Those walla tracks now really sound like a roomful of people.

Panning Tracks in Acoustic Space
Pan controls place a track’s audio within a panoramic sound field. They enable you to 
compose the spatial arrangement of audio elements just as a cinematographer composes 
the visuals of a shot. Mono tracks can be precisely located to sound as if they come from 
an off-screen source, or somewhere within the frame. Resolve includes advanced pan 
controls in both the Edit and Fairlight pages that support both 2D (stereo) and 3D (surround) 
audio placement.

In this exercise, you’ll use the pan controls to widen the walla tracks so they don’t “crowd” 
the dialogue tracks.

NOTE  If you are working in a quiet room with a good set of stereo audio monitors, 
you should be good to go. If you have been using your built-in computer speakers 
or an inexpensive single speaker, you are well advised to use headphones for this 
panning exercise. 

1	 Return to the Fairlight page.

2	 Start playback, and listen carefully. Can you pinpoint where the dialogue or walla is 
coming from? 

Your eyes tell you their locations; but when you close your eyes, the sound from all 
of these tracks are playing equally from both speakers, which makes them sound 
centered within the sound environment.

Let’s pan the walla tracks to the far left and right to hear what happens.
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3	 Click the Mixer button. 

4	 Using the Mixer’s Pan controls, drag the blue handle for the A6 WALLA to the upper-
left corner of the panning control in the control strip. Drag the A7 WALLA 2 blue 
panning handle to the upper-right corner of the control on the A7 channel strip. 

5	 Play the timeline from the beginning to hear the walla tracks panned to the far left 
and right of the acoustic space.

Can you hear the change? In just a matter of seconds, you filled the far reaches of the 
acoustic space with the walla sound, making the crowd seem to spread out within a 
much larger room. Additionally, you moved their sound away from the actors’ audio 
tracks, thereby making it easier to hear the all-important dialogue. 

Let’s take a closer look at the Pan controls.

6	 In the Mixer, in the A6 track, double-click the Pan controls to open the Audio Pan window. 
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The Pan controls can work with either 2D (stereo) or 3D (surround) panning depending 
on your setup and project. The center of the graph represents the acoustic center from 
the audience’s perspective. The small letters F, R, B, and L—positioned clockwise 
around the space in the top, right, bottom, and left positions—represent the Front, 
Right, Back, and Left positions in the panoramic field, respectively.

Where you place audio tracks within the panoramic space will reflect where the 
audience will locate each audio source. The Spread control is for linked sources. 
Divergence determines the spread of the audio signal to additional speakers in a 
surround mix, and Boom determines how much of a track’s sound is sent to the 
low-frequency effect (LFE) speaker.

Look carefully to see that the A6 WALLA track is currently panned to the front-left 
position. Let’s relocate it to the back-left position to hear the difference.

NOTE  You may or may not hear the sound change from front to back when 
you are listening through stereo speakers or headphones. Also, if you are 
monitoring audio through an audio interface and mixer that outputs only left 
and right channels, then you may not hear any output that is not panned to the 
front left, front center, or front right.

7	 Unsolo all the tracks, except for the A6 WALLA track.

8	 Start playback, and drag the blue Pan handle to the lower-left corner of the pan area. 
Pan the track to the center, and then to the right. Return the control to the back left. 

Could you hear the crowd move around the room as you panned? As the sound 
designer and re-recording mixer for this scene, you can choose where to place 
the crowd.

9	 Use the Pan controls in the A6 and A7 tracks to place the walla tracks wherever you’d 
like in the panoramic field. If you aren’t sure of their placements, try putting them in the 
far-left and far-right between the back and center locations. 

When you are finished panning tracks to compose the acoustic space within your scene, 
you can move on to finessing the levels of those tracks. In audio post-production, volume 
control is an ongoing process right up until you output the final mix.

Normalizing Clip Levels
Ensuring that your dialogue levels are consistent is one of the main issues you’ll be facing, 
whether you are responsible for a dialogue scene such as this, or a timeline with interviews, 
voiceover, or any kind of speech. Thankfully, DaVinci Resolve can help out, so you can 
spend time finessing your levels in other ways.

1	 In the Media Pool, select the Timelines bin, and double-click the 02 LEVELS timeline 
to open it.
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2	 Play through this timeline and listen carefully to the dialogue.

The dialogue is generally clear throughout, but you do need to sort out some of 
the levels.

3	 Select all the clips along the three dialogue tracks: A1, A2, and A3.

4	 Right-click any of the selected clips, and choose Normalize Audio Levels.

The Normalize Audio Levels box appears asking you to set a peak level and how you 
want to apply normalization across the selected clips.

5	 Set the Sample Peak Level to -10 dbFS and the Set Level option to Independent.

NOTE  -10 dbFS is a good sample peak level for these clips. The level that you 
will choose to normalize your peaks may differ depending on your audio delivery 
requirements. By changing the Set Level to Independent, you are letting Resolve 
normalize the levels of each clip relative to its individual peak, rather than 
normalizing the clips by the same amount based on the highest peak level.

6	 Play through the timeline to listen to the change.

The level of each clip is now adjusted to the highest peak reached, -10dbFS. But the 
Doctor’s third clip level is now a little high.
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7	 Using the volume curve, lower the level of the third clip on the DOCTOR track to 
around 4 db.

Working with Clip Equalization
Equalization (EQ) manipulates specific frequencies to enhance the overall sound. The 
primary function of equalization is to lower frequencies that detract from dialogue and 
boost certain frequencies to improve the overall sound clarity. The Fairlight page includes a 
four-band equalizer for each clip in the Inspector, and a six-band parametric equalizer on 
each track in the Mixer. 

Creating a Two-way Radio Effect with EQ
To better understand the power of frequency equalization, let’s use it in an extreme context 
to transform a recording so it sounds more like a two-way radio. You will systematically 
eliminate frequencies in the clip to emulate the limited frequency response of a CB radio. 
Along the way, you’ll also alter various voice frequencies to determine which ones enhance 
and detract from this recorded voice. 

1	 In the Media Pool, in the Timelines bin, open the 03 EQ AND COMPRESSION timeline.

This is a version of your scene with a couple extra tracks of ambience added.

2	 Solo the A8 RADIO track and play the clips in the timeline. 
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As is, the voice sounds normal. Let’s take a closer look at the radio dispatcher clips 
in the Inspector, focusing on the second and fifth clips that contain the actual voice, 
not the bookend radio clicking sounds on either side. 

3	 Zoom horizontally until you can clearly see both clips in the A8 track. 

4	 In the toolbar, click the Inspector button.

5	 Select the second clip in the A8 track to see it in the Inspector.

6	 Click the enable button to turn on the Clip Equalizer.

Before making any changes, take a quick look at the controls.

Frequency

G
ai

n

Graphical EQ controls

Band enable button

Band filter type

Numeric controls

In the graphical EQ controls area, you can see and manipulate the frequency graph. 
The numerical controls at the bottom of the equalizer give you more precise control 
over the frequencies and gain of each band.

Looking more closely at the blue graph, you can see that the default setting resembles 
a clip with fade handles applied to the head and tail. The steep slope at the left edge 
of the curve is actually a high-pass filter that allows high frequencies to be heard while 
it eliminates the lowest frequencies. The slope on the right side of the curve is a 
low-pass filter that allows lower frequencies to be heard while eliminating the highest 
frequencies. In the next exercise, you’ll work with both the high- and low-pass filters to 
alter the recorded voice in the clip.
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Common Frequencies for Dialogue EQ

Audio frequencies are measured in either Hertz (Hz) or thousands of Hertz, or 
kilohertz (kHz). 

Low numbers represent low frequencies and high numbers represent high frequencies.

When you change the amount of gain in a frequency range, you either boost 
(increase) or attenuate (reduce) the volume level of the frequencies within that 
range. Filtering out a specific frequency or a narrow range of frequencies is 
referred to as cutting. 

The audible frequency range for the average human is between 20 Hz and 20 kHz 
(or 20,000 Hz).

Sweeping Frequencies to Target Changes
Dragging the graphical controls left or right through the EQ graph during playback is 
referred to as sweeping and is the most effective way to hear changes and identify areas 
that need work. For this exercise, you’ll sweep a midrange frequency bell curve in Band 3 
to boost or attenuate frequencies during playback and isolate the talent’s voice. Then, 
you’ll adjust the high- and low-pass filters in Bands 1 and 4 to observe how these filters 
change the clip’s audio. Let’s start by turning off all the bands except for Band 3. Then, 
you’ll sweep the bell curve to evaluate the radio dispatcher’s recorded voice. 

1	 In the transport controls, turn on loop playback, and press R to choose the range 
selection tool. 

2	 Using the range selection tool, select the second clip in the A8 track. Click the clip 
a second time to show it in the Inspector. 
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3	 In the Clip Equalizer controls in the Inspector, click the red-colored band enable 
buttons for Bands 1, 2, and 4 to turn them off. This enables you to focus your attention 
on Band 3.

4	 Click the band filter type drop down menu below the Band 3 button to see the types of 
frequency filters available for Bands 2 and 3.

High shelf

Bell curve

Notch

Low shelf

High and low-shelf filters are similar to high- and low-pass filters, but the shelf filters 
attenuate (lower) unwanted frequencies, whereas the pass filters completely block 
unwanted frequencies. You can apply bell curves to boost or attenuate frequencies 
anywhere on the graph and their range of influence can be narrowed or widened as 
needed using the Q control. A notch filter is used for completely removing, or cutting, 
specific frequencies. 
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TIP  A common rule of thumb when adjusting dialogue EQ is to cut narrow and 
boost wide. Also, a little EQ goes a long way, so make subtle changes, just as 
you would when refining an edit, or adjusting hue on the color wheels.

Basic frequency ranges for the human voice

Men	 80–160 Hz	 Bass	 50–250 Hz

Women	 165–255 Hz	 Mid-Range  250–2300 Hz

Children  250–300 Hz	 High	 2500–20,000 Hz

Human female voices tend to fall between 165 Hz and 255 Hz. As you sweep the 
frequency graph, this is a good chance to find the fundamental frequencies for this 
particular voice. You can sweep the Band 3 bell curve by dragging its corresponding 
numbered handle on the graph. If you drag the bell curve up, you will boost the current 
frequencies, whereas dragging down will attenuate them.

5	 Press Option-/ (slash) in MacOS or Alt-/ (slash) in Windows to start looped playback of 
the marked range.

6	 During looped playback, drag the Band 3 bell curve handle up, and sweep left and 
right through the graph to hear the boosted frequencies. Then, drag the bell curve 
down, and sweep to hear how attenuating certain frequencies can affect the voice. 
When you are finished, press the Spacebar to stop playback.
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As you can hear, sweeping frequencies can really help you pinpoint the best and worst 
frequencies in a vocal. Because this exercise is focused on transforming the voice to 
sound as if it is coming from a two-way radio, you’ll need to eliminate most of the high 
and low frequencies, and boost the remaining frequencies using the bell curve.

7	 Click Band 3 to disable it, and click Bands 1 and 4. 

You can sweep the high-pass filter (Band 1) by dragging its corresponding numbered 
handle on the graph. Keep in mind that this is a frequency filter that allows only those 
frequencies higher than the shaded part of the curve to pass through.

8	 If necessary, press Option-/ (slash) in macOS or Alt-/ (slash) in Windows to restart 
looped playback.
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9	 During looped playback, drag the Band 1 EQ handle to the right on the graph, and 
listen to the change in the voice as you slowly eliminate the low and midrange 
frequencies. Sweep right as far as 4 kHz and sweep back to the left to around 550 Hz.

10	 Continue with looped playback, and sweep the Band 4 EQ handle to the left as far as 
you can without lowering the curve in Band 1. Then, sweep back to the right to around 
2 kHz. When you are finished, stop playback.

The last step is to use the Band 3 bell curve to sweep and boost the remaining 
frequencies between the Band 1 and 4 handles. 

11	 Enable Band 3, and start looped playback. 

12	 During playback, boost Band 3, and sweep back and forth to find the best sounding 
“radio” voice. When you are finished, stop playback.
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There is no wrong choice here, so trust your ears. Any frequencies that you boost in 
the narrow frequency range that is available will successfully exaggerate the radio 
voice effect. 

The last step is to listen to the clip with and without the EQ changes to compare the 
before and after results. 

13	 Start looped playback. Click the Clip Equalizer button to toggle EQ off and on to 
compare the original audio with the EQ version. When you are finished, stop playback.

14	 Press A to go to selection mode, and select the second clip in track A8, RADIO.

15	 Press Cmd-C (macOS) or Ctrl-C (Windows) to copy the clip.

16	 Right-click the fifth clip on the A8 RADIO track, and choose Paste Attributes, or press 
Option-V (macOS) or Alt-V (Windows).

17	 In the Paste Attributes box, select EQ, and click Apply to paste the EQ settings.

18	 Deselect the Solo button for track A8 RADIO.

Using the equalizer, you’ve manipulated the frequencies to create that radio-voice effect. 
You’ll apply some dynamics controls to the track shortly to complete the effect. First, 
however, let’s apply some track EQ to improve the overall clarity of Agent Jenkins’ voice.
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Frequency level troubleshooting

100 Hz - 300 Hz 	 Too low sounds thin, too high loses clarity

200 Hz - 500 Hz	 Just right sounds warm, too high can sound boxy

250 Hz - 750 Hz 	 Potentially muddy if too high

600 Hz -1.1 kHz 	 Potentially nasal/honky if too high

1 kHz - 3 kHz 	 Adjust for intelligibility

3 kHz - 6 kHz 	 Add presence 

5 kHz - 8 kHz 	 Adjusts sibilance (esses)

9 kHz - 15 kHz 	 Adjusts sheen/sparkle

10 kHz - 20 kHz 	 Adjusts Breathiness/Airiness

Sweetening Dialogue with EQ
As you’ve just proven, sweeping frequencies and stripping out the high and low end of a 
voice is pretty easy. In contrast, actively listening, delicately cutting, and selectively 
boosting frequencies to improve a voice takes patience and practice. In this exercise, you’ll 
apply three different bell curves to the AGENT J track to find and reduce detracting 
frequencies, and then selectively boost frequencies to enhance the voice.

TIP  You should first find and cut, or attenuate, the detracting frequencies. Then 
boost the positive frequencies to sweeten the voice.

1	 Press Shift-Z to fit all the clips horizontally in the visible timeline.

2	 Solo the A2 AGENT J track. Then, using the range selection tool, drag across the first 
group of clips on the A2 track to select a range for looped playback.
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3	 In the Mixer, double-click the EQ box for track A2 AGENT J to open the Track 
Equalizer window.

You can start sweeping for unwanted frequencies. The main issue with Agent Jenkins’ 
voice is that it is a bit boomy or boxy sounding which can compromise its clarity, 
especially in the final mix with all the other tracks. His fundamental vocal frequencies 
fall between 80-160 Hz. The boxy frequencies are somewhere between 200-500 Hz. 
Let’s start by sweeping the Band 3 bell curve in the mid/low range (ML) to identify the 
offending frequencies. 

4	 Start looped playback. Drag the Band 3 handle up to around +10 to +15 dB and sweep 
back and forth between 200-500 Hz. Listen carefully to the agent’s voice as you 
sweep the frequencies. Notice which frequency range improves the voice and which 
amplifies its irritating qualities. When you are finished, stop playback.
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Chances are you found that boosting the frequencies near 200 Hz improved his voice, 
while boosting around 450 Hz made his voice sound less pleasant, as if he were 
talking into a cardboard box.

TIP  Training your ears to recognize subtle dialogue differences, both positive 
and negative, takes time, much the way colorists must train their eyes to see 
subtle nuances in flesh tones and shadows.

5	 Restart looped playback, and drag the Band 3 bell curve handle to around 450 Hz. 
Then, drag it below the 0 dB line to attenuate the frequencies by about -3 dB.

Next, you’ll sweep the Band 4 bell curve to find the sweet spot that enhances clarity. 
You’ve already noticed that the agent’s voice improves with a boost around 200 Hz. 
Now you can pinpoint a more precise range that provides the most improvement and 
boost it by approximately 3 dB. One more thing, try improving his voice while the other 
tracks are playing.
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6	 Unsolo the A2 track. Start looped playback, if necessary. Sweep the Band 4 bell curve 
between 120-300 Hz. Identify the frequency range that most improves the clarity of his 
voice, and raise it slightly to boost these frequencies.

Trust your instincts and your ears. However, if you aren’t sure, try using +3 dB at 
around 130 Hz.

The last adjustment to the agent’s voice is to boost its intelligibility between 1-3 kHz.

7	 Change the Band 5 filter type to a bell curve. Drag the Band 5 bell curve up to see the 
shape of the curve. 

The default curve is too wide for this change. You can narrow the frequency range 
with the Q Factor controls.

8	 At the bottom of the Band 5 controls, drag the Q Factor control to the right until the 
frequency range (curve) resembles the +2.3 curve in Bands 3 and 4.



289

C
o

n
tr

o
lli

n
g

 D
yn

am
ic

 R
an

g
e

9	 Start playback, and sweep between 1-3kHz. Identify which frequencies improve the 
intelligibility of his voice, and boost the frequencies between 1-3 dB.

10	 Continue looped playback, and toggle the Equalizer button off and on a few times to 
hear the agent’s voice with and without the EQ. When you are finished, stop playback.

11	 Close the Equalizer - AGENT J window, and deselect the clips in the A2 track.

Though subtle, the improvement to Agent J’s voice EQ is significant. This is another reason 
to separate each character on its own track during dialogue editing so that you can not 
only balance volume levels, but also apply equalization to the entire track, as needed. 

Controlling Dynamic Range 
The difference between the loudest and quietest levels in a track is its dynamic range. 
A track’s dynamic range is very similar to contrast within a shot. A track with a high dynamic 
range has very loud and quiet elements within the track, such as a character whispering 
and then screaming in the same scene. A low dynamic range is fairly flat, such as in a 
commercial voiceover in which the volume level of the talent is very even from start to 
finish. If you have ever worked with a waveform or Parade scope in the Color page, 
controlling a track’s dynamics is very similar to adjusting the white and black levels of 
a clip. Just think of white as the loudest and black as the quietest. 

The Fairlight page Mixer includes the four most common dynamics controls in one easy-to-
use panel.
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1	 Solo the A8 Radio track, and with the range selection tool, select the second clip in 
the track to mark your looped playback range. 

2	 In the Mixer, on the A8 Channel strip, double-click the Dynamics area to open the 
Dynamics window.

The Fairlight page Dynamics controls include four tools for modifying a track’s 
dynamic range.

The compressor is the most common control and is used to narrow the dynamic range 
by lowering the highest peaks and bringing them closer to the lowest peaks. It’s a 
great tool for bringing out some of the quieter spoken words, while simultaneously 
lowering the level of the loudest words.
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The expander, in contrast, enlarges the dynamic range to increase the difference 
between the loudest and quietest peaks.

The limiter and gate both work as acoustic “barriers” to limit sound from exceeding 
a target level (limiter), and to prevent sounds lower than a set threshold from being 
heard (gate).

In this exercise, you’ll apply heavy compression and boost the overall gain in the Radio 
track to further emulate the radio sound. Adjusting the frequencies was just the first 
step. Compressing the dynamic range will further modify the radio voice to emulate 
the under-the-hood vocal processing in two-way radios.

TIP  Many devices, including smart phones, intercom systems, and two-way 
radios use heavy compression to limit the dynamic range so that each spoken 
word can be heard. Obviously, the results don’t follow natural volume 
fluctuations in vocal patterns but are a convenient enhancement to the voice 
amplification process.

3	 In the Dynamics - RADIO window, click the Compressor button to enable the 
Compressor controls. 
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The default Compressor settings include a Threshold of -15 dB and a Ratio of 2.0:1. 
The Threshold indicates where in the dynamic range you want to start compression. 
So, in this example, any peaks over a Threshold value of -15 dB will be compressed by 
a 2:1 Ratio, which means that with every two decibels increase over -15 dB, only a one 
decibel increase will be permitted. When a track has a wide dynamic range, you can 
apply a higher Ratio value such as 5:1 so that for every five decibels of level increase 
over -15 dB only a 1 dB increase will be permitted. The heavier the compression, the 
more likely you will start to hear it in the quality of the sound. However, because you’re 
emulating a low-quality radio speaker in this scene, the more compression, the merrier.

4	 Start looped playback. In the Dynamics window or the A8 channel strip in the Mixer, 
watch the Output meter, to see the average volume level of the soloed range.

The current average volume is around -23 dB, which is lower than the current Threshold.

5	 Drag the Threshold knob to the left to lower it to around -24 dB. Then, drag the 
Ratio knob to the right to raise it to an 8.0:1 ratio. Listen to the change as you apply 
the compression.

With this much compression applied at -24 dB, notice that the graph of the upper end 
of the decibel curve (light green) is nearly horizontal, as are the peaks.
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Let’s boost the gain to more clearly hear the heavy compression. The Make Up gain fader 
lets you raise the overall level sound coming from the track’s compressor. You can still 
adjust the track’s overall output level independently using the track fader in the Mixer.

6	 Drag the Make Up gain fader up to around +10 to raise the Output level of the track 
to -12 dB.

Now you can really hear the compression in the track. Don’t worry, you’ll be able to 
lower the level of the Radio track in the Mixer and still maintain the distorted, over-
compressed effect.

7	 Toggle the Compressor button off and on to compare the voice with and without the 
compression applied. When you are finished, close the Dynamics window, unsolo the 
A8 RADIO track, and deselect the clip.

8	 Play the timeline to hear the finished radio effect with the other tracks. 

Another successful exercise in acoustic manipulation. Although this is an extreme example 
of compression and EQ, it should pave your way to experiment with these controls in your 
own projects. You can start by applying a small amount of compression to the Doctor’s and 
Agent Jenkins’ dialogue tracks to help give them a little more punch in the mix.
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Automating Track Changes
Adjusting faders, panning, and other controls during a mix is part of your job. You could 
try making all of the changes on-the-fly during your final mix, or alternatively record the 
parameter changes as automation. In this exercise, you’ll use DaVinci Resolve’s automation 
controls on the Fairlight page to record panning control changes over time. 

At the top of the Fairlight page, you’ll find the automation button to the right of the 
transport controls. 

1	 In the Media Pool’s Timelines bin, open the 04 MIXING timeline.

2	 Click the automation button to open the Automation toolbar. 

The Automation toolbar includes buttons for every available option to set up and 
record automation for your mix. The buttons are organized in groups from left to right.

You can record automation data in write or trim modes. Write mode records absolute 
changes to controls, whereas trim mode records relative changes that either increase 
or decrease levels that are already recorded.

The other important settings for automation include:

	� Touch determines what will happen when you begin automation. If the touch mode is 
turned off, no automation is recorded.

	� Latch begins recording as soon as you touch a control that is set for automation and 
continues to record automation after you release the control.

	� Snap begins recording automation when you touch a control and stops when you 
release the control.

Your goal in this exercise is to start with the radio track panned left and then automate 
panning to the right after the doctor’s first look so the second radio call sounds as if it 
is coming from a radio on Agent Jenkins. Use the doctor’s eyeline in her second look 
as a guide.

TIP  Before recording automation, it’s always a good idea to practice recording 
at least once. 
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3	 Make sure that the Touch automation menu is set to Off.

TIP  When you are working with automation, it’s a good idea to set the touch 
mode to Off any time that you aren’t actively recording. Otherwise, you could 
accidentally record or overwrite automation during playback. Also, you can 
click the Automation button to the left of the Automation toolbar to disable or 
enable all automation that is applied to a timeline. 

4	 In the Automation toolbar, click the Pan button.

5	 In the A8 RADIO channel strip, double-click the Pan controls to open the Audio 
Pan window. 

6	 Start playback, and practice the panning maneuver once. 

7	 When you are ready to record, set the initial pan to be on the left speaker.

8	 In the Touch section of the toolbar, choose Latch.

9	 Click play, and record the panning automation. When you are finished, set Touch to Off.

TIP  Automating pan controls on your mono FX tracks is a great way to track 
sounds to objects that move in the frame. 

10	 In the Automation toolbar, click the Pan button to deselect pan automation. Close the 
Audio Pan window.

11	 Playback the timeline to hear the automation. 

As the timeline plays back over the automation, you should hear the pan change and 
also see the pan control update on its own accord.
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Adjusting Recorded Automation Changes
After you have recorded automation for a particular control, you can view the automation 
graph directly in the timeline track.

1	 In the track header for Track A8 RADIO, right-click, and choose Lock Track Height To > 
Large, or manually resize the track. 

So long as your automation controls are visible, an additional set of controls appear 
in the header of each track.

2	 Click the pop-up menu, and choose L/R Pan.
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The track updates to display the pan changes you recorded in the previous exercise.

If you want to adjust this recorded automation data, you have a couple of options. First, 
you could try re-recording the change. Place the playhead before the automation starts 
and play the timeline while adjusting the controls, as necessary. Alternatively, you could 
use the pencil tool to redraw the automation graph.

3	 Select the pencil tool.

4	 Position the pencil tool to the left of the automation data you want to adjust.

5	 Drag the pencil tool across the automation data to redraw the graph.

TIP  To adjust a group of automation keyframes simultaneously, use the Select 
Range tool to the right of the pencil tool. Drag out a range across a group of 
automation keyframes, and then move them horizontally and/or vertically within 
the automation graph, or press the Delete (backspace) key to remove them.

When you are working on a slower computer or laptop, automation may affect the 
quality of video playback. To streamline your workflow during the remaining exercises, 
you can temporarily disable automation by hiding the automation toolbar. Later, you 
can turn on automation for your final output.
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NOTE  The pencil and select range tools are visible only when you the 
automation tools are active.

6	 Click the automation button to hide the automation toolbar.

Now that you’ve had a taste of automating track controls, you can start applying automation 
to your own projects.

Simplifying Mixing using Buses
You already know how to balance individual clip levels; but if you have numerous similar 
tracks that have already been balanced, such as dialogue, atmosphere tracks, or music, 
you can combine them and send the output signal from each of the tracks through a bus to 
create a submix. As the name suggests, a submix lets you independently mix a subset of 
the tracks. 

Submix buses are signal paths that send the signal from multiple tracks to a new channel 
strip where the sum of their signals can be controlled like a single track, in a similar way 
that you used compound clips in Lesson 6.

In this exercise, you’ll create submix buses for the dialogue, music, and background FX tracks. 

Once again, before you begin, let’s reconfigure the Resolve interface to more effectively 
support your upcoming workflow.

1	 In the Media Pool’s Timelines bin, open the 05 BUSSES AND MAINS timeline.

2	 In the toolbar at the top of the Fairlight page, click the Meters button to show the 
monitoring panel if it is not currently showing.

3	 In the Fairlight page, choose Fairlight > Bus Format to open the Bus Format window.
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In the Bus Format window, you can assign tracks to one of four types of buses. 
The project currently contains one bus, the default main bus named Main 1. The Format 
and Channels columns indicate that this main bus is in stereo. 

4	 Click the Sub button three times to add three new submix buses to the list. 

The three new sub buses (submixes) appear below Main 1 in the Bus Format pane.

Notice that three sub buses—labeled S1, S2, and S3—are to the right of the Mixer, 
as well as on the monitoring panel. 

Let’s name the sub buses and change their formats and colors based on the tracks 
they will contain.

5	 In the User Name column, double-click the Bus 1 name, and enter DIAL. Then change 
the name of Sub 2 to MUSIC and Sub 3 to BG FX. 
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6	 In the Format column, change the format of the MUSIC and BG FX subs to Stereo. 
Leave the DIAL sub set to Mono. 

Finally, let’s change the colors of each submix to correspond to the tracks in the timeline. 

7	 In the Color column, change the Sub 1 DIAL color drop down menu to Yellow, the Sub 2 
bus color to Navy, and the Sub 3 bus color to Chocolate.

8	 Click OK to close the Bus Format window.

The new sub bus names and colors also appear in the Mixer and the Meters.

 

You are all set up with submixes. The next step is to route the appropriate tracks into 
those submixes. 
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Assigning Tracks to Submix Buses
You must now assign the tracks that you want to send to each bus. 

1	 Choose Fairlight > Bus Assign to open the Bus Assign window. 

The Bus Assign window has two sections. At the top of the window is a list of all the 
buses. The rest of the window shows the available tracks. In the Available Tracks area, 
initials under each track name indicate the current assignments for each track. Below 
each track name, you’ll see an M1 to indicate that the track is assigned to the Main 1 
output. Tracks with B1, B2, or B3 initials below the name are assigned to those 
corresponding buses (in this case, the DIAL, MUSIC and BG FX submixes respectively). 

To better understand the bus and main architecture, let’s clear all of the current track 
assignments and reassign them from scratch. To do so, you’ll select each bus 
individually, and click the Un-Assign All button. 

2	 In the Buses area in the Bus Assign window, click the M1:Main 1 button. 

The name of the selected bus highlights to indicate it is selected.
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3	 In the Available Tracks area, click the Un-Assign All button.

All of the tracks are removed from the M1:Main 1 output bus. Remember that only tracks 
assigned to a Main output are audible. So, you’ll eventually need to reassign these tracks.

All the tracks and buses are successfully unassigned. Now you can manually select 
each bus and assign tracks to them. 

4	 In the Buses area, select the S1:DIAL bus. In the Available Tracks area, select the DOCTOR 
K, AGENT J, and ASSISTANT tracks as these are all the tracks containing dialogue.
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TIP  The dispatch radio track includes recognizable words in spoken English, 
so like all other dialogue tracks, it would usually be omitted in a Music and 
Effects-only (M&E) mix intended for foreign distribution. However, in this case, 
the purpose of these submixes is to control the primary dialogue tracks. 
Similarly, for this scene, the source music is more a part of the background 
ambience than a musical score, so you’ll assign it to the BG FX submix rather 
than the MUSIC submix. In this scene, the purpose of your submixes is 
primarily to finesse the levels between the dialogue, music, and background 
FX tracks in the second half of the scene.

5	 Select the S2:MUSIC bus, and then select the STING, BEAT, BED, and SCORE tracks 
to assign them to that bus.

6	 Select the B3:BG FX bus, and assign the STAGE FX, WALLA, WALLA 2, and SC MUSIC 
tracks to it.

Next, you’ll assign the as-yet unassigned tracks to the M1:Main 1 output. They represent 
sounds that are heard for a short time and their tracks levels can be adjusted 
independently using the standard faders in the Mixer. You’ll also need to assign each 
of the three submix buses to the M1:Main 1 bus so that the audio of those buses will be 
audible through the main output. 
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7	 Select the M1:Main 1 bus, and assign each of the unassigned tracks to it, as well as the 
DIAL MUSIC and BG FX buses.

8	 In the Bus Assign window, click the Save button. 

All the tracks are assigned to the main output or a sub bus, so you can see and hear 
them in action in the Mixer.

Working with Buses in the Mixer
The middle section of the Mixer always shows your main and submix buses, and the 
current signal flow of each track so you know where it is assigned. In this exercise, you’ll 
play through the timeline to verify that all your tracks and submixes are playing properly. 
Then you’ll try out your new submix faders. 

TIP  You can expand or compact the Mixer at any time by dragging its left edge. 
The buses are always visible to the right of the Mixer.
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1	 Drag the left edge of the Mixer to the left to expand it, if necessary.

2	 Press Shift-Z to fit all the timeline clips horizontally in the visible timeline.

3	 Play the project from the beginning, and listen to the current mix. 

The mix should still sound pretty good. You haven’t actually changed any of the levels, 
just altered the way that you will control them. You can continue to balance clip level 
curves and individual faders as usual. 

The background FX tracks seem a little distracting. Let’s emphasize the dialogue by 
lowering some of the background sounds. 

4	 Start playback, watch the scene, and move the S3 fader down to where it sounds less 
distracting (about -5dB). 

Now you know why submixes are a mixer’s best friend. It is much easier to move one 
fader that lowers three tracks than to manually lower three separate faders on-the-fly.

TIP  Re-recording mixers working with large mixing consoles are used to 
moving hardware faders during playback and can maneuver their hands 
around the controls like a musician playing a church organ. When you are 
working in a software-only environment, you must do the best you can using 
a mouse or track pad. You can always record automation to your tracks or 
submix buses to help simplify the final mix. Also, numerous hardware mixing 
consoles are compatible with DaVinci Resolve and its Fairlight page. You can 
find a list of compatible mixing hardware at www.blackmagicdesign.com. 

Creating Additional Output Buses
Every audio signal in the timeline flows from the track to the main output. Whether you are 
listening to speakers or headphones at your workstation, you are hearing the main output 
every time you play your timeline.

The current timeline has one main output, three submix buses, and sixteen individual 
tracks. However, depending on the delivery requirements for your final project, you may 
need to create additional main output buses in multiple formats. In fact, most professional 
projects require several versions of your mix, such as for stereo and surround.

Furthermore, if dubbing a program into another language, you need to provide an M&E 
version of the mix that is devoid of all intelligible on-screen dialogue so that it can be 
replaced by actors speaking another language.

You can create and assign main buses just as you created submix buses in the Bus Format 
and Bus Assign windows. 
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In this exercise, you’ll create a three-channel DCP main output and an M&E main output 
based on the current mix. Since the M&E mix will be identical to the Main 1 mix without 
dialogue, you can simply duplicate the Main 1 with all tracks and subs identically patched then 
make any changes from there. As for the DCP main output, you’ll create that one from scratch.

1	 In the Fairlight page, choose Fairlight > Bus Format.

2	 In the Bus Format window, select Main 1, and click the Duplicate button.

The duplicate main appears below Main 1 with the bus assignment of Main 2 and the 
username Main 2. 
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3	 Click the Main button to create a new main output bus for the DCP main.

The two new mains (Main 2 and Main 3) appear below Main 1 in the Bus Format pane.

4	 Name the Main 2 bus M&E and the Main 3 bus DCP.

Although the default setting for the Main 1 output format is stereo, you can change it to 
a different format at any time, or create multiple mains for each of your delivery formats. 
Digital Cinema Projection (DCP) delivery, for example, requires a minimum of three 
channels (LCR) or a maximum of 16 audio channels for multichannel surround sound.

Because you probably are not doing this lesson with a surround sound set up, let’s use 
the minimum requirement of three channels and set them to LCR (Left, Center, Right). 
LCR is a common format, sometimes referred to as the “poor man’s surround sound,” 
in which all the tracks are mapped to three front speakers. In LCR mixing, the music 
and effects are mapped to the left and right channels and the dialogue is locked to the 
center channel. This is similar to multi-speaker surround sound formats because they 
also place dialogue in the center channel, but also include additional side or back 
speakers and a subwoofer for low frequency effects (LFE). 

5	 Change the Format of the DCP bus to LCR.
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You now have three Main outputs to the right of the Mixer and on the monitoring 
panel—labeled M1, M2, and M3. 

6	 In the Bus Format window, click OK. 

7	 Choose Fairlight > Bus Assign. 

Now you’ll assign tracks to these main outputs. Let’s start with the M3:DCP bus. Later, 
you can set up the M2 bus on your own.

8	 In the Buses area of the Bus Assign window, select the M3:DCP bus. In the Available 
Tracks area, select the DIAL, MUSIC, and BG FX buses. Finally, select each of the 
tracks that are mapped directly to the M1 output to also route these to the M3 output: 
ROOM, APPLAUSE, RADIO, END FX, SC FX 1, and SC FX 2. 

9	 Click Save to save and close the Bus Assign window.

Excellent. Your new DCP output bus is set up. 
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Monitoring Multiple Outputs and Buses
The Control Room settings in the monitoring panel let you determine which outputs or 
submixes are audible during your mix. The default is always the Main 1 output. To monitor 
a different main output or bus, you choose from the drop down menu below the control 
room  meters. 

Let’s give it a try. In this exercise you will change the control room monitoring to the DCP 
output. Play the timeline once, then change it back to the Main output. Keep in mind, your 
control room monitoring can be changed anytime. 

1	 Below the Control Room meters, in the control room monitoring drop down menu, 
choose DCP.

2	 Play the timeline once to monitor the DCP main output. 

3	 Change the Control Room monitoring back to Main 1.

TIP  It’s a good idea to always reset the control room monitoring to the Main output 
when you are finished. 
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Assigning the Music and Effects Tracks
Now it’s up to you to think through the M&E output to make sure all of the correct tracks or 
submixes are included. 

For example, the dispatch radio sound includes spoken words. Because it is not part of the 
original script, and source is not even visible onscreen, the foreign language translators 
may choose to omit it altogether. You can include those scripted lines and reference audio 
for the distributors and let them decide.

Meanwhile, you need to make sure the spoken radio audio is not included in the M&E mix. 
The best way to do so is to create a duplicate submix for the BG FX that excludes the 
RADIO track.

Another consideration is the ROOM track. Technically, ROOM is part of your dialogue mix; 
and because all evidence of the dialogue and production sound must be removed for 
dubbing, ROOM should also be left out of the M&E mix. 

1	 In the Bus Format window, duplicate the S3 BG FX submix. 

2	 Name the S4 BG FX submix, S4 BG FX M&E.

3	 In the Bus Assign window, assign the WALLA and SC MUSIC tracks to the submix.

4	 In the Bus Assign window, select the M2:M&E bus, and assign the appropriate 
submixes and tracks. Keep in mind that no spoken dialogue should be present in the 
M&E output bus. 

5	 Save the changes in the Bus Assign window. 

6	 Choose Control Room Monitoring > M&E, and play the timeline to hear the M&E output. 
The scene should sound great but have no trace of dialogue (including the radio).

7	 If tracks are missing, or you hear dialogue in the M&E output, go back to the Bus 
Assign window, and make the necessary changes to the track assignments. 

8	 Change the Control Room monitoring back to Main 1, and save the project. 

Monitoring Loudness in your Mix
Now that you are ready for final output, you need to monitor your output levels. In the past, 
broadcast standards were based on the highest peak level in a soundtrack. As long as 
audio content did not exceed that level, it would pass quality control. That led to 
commercials that applied heavy compression to narrow their dynamic range and bring all 
voiceovers to the maximum allowable (and overbearing) level.

To even the acoustic playing field, new loudness standards were introduced that apply to 
all broadcast programs (television and radio) regardless of the length or type of program. In 
North America and parts of Asia, an integrated target of -24 LUFS (Loudness Units Full 
Scale) is the norm for broadcast content, whereas in Europe the target is -23 LUFS. 
(Theatrical films, trailers, and streaming videos have different standards.)
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Resolve includes two types of monitoring panel meters to measure such standards. Peak 
meters are traditional Root Mean Square (RMS) meters available for every track and bus 
that uses a decibel scale, and Loudness meters measure the loudness in your program 
based on the loudness unit scale (LUFS). 

You can use the Loudness meters to measure the perceived loudness over the entirety of 
your program to verify that the levels of your final mix meet the current loudness standard, 
ITU BS.1770.  

The Fairlight page Loudness meters include a numeric display that outputs a variety of 
useful loudness measurements with the most important being the Integrated level. 

M measures 
loudness unit 

average per audio 
channel.

Maximum LU measures maximum 
loudness unit value during playback

Short measures the average LU 
level over a 30-second window 
following the playhead.

Short Max displays the maximum 
level over the same 30 second 
window. 

Range measures the dynamic range 
of the Loudness of your mix

Integrated measures the LUFS 
value of the range you’ve played. 
This analysis is required by most 
broadcast specifications.
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	� M displays the loudness unit for each channel of audio in the selected Control 
room output.

	� The loudness units meter displays the sum of all channels for the duration of playback. 
The numeric value at the top is the max LU value over that range. 

	� Short displays loudness over a 30-second range.

	� Short Max displays the played range’s maximum true peak level.

	� Range displays the dynamic range of loudness in the entire program.

	� Integrated displays the average loudness for the entire played range. This is the value 
that targets either -23 LUFS or -24 LUFS as required by broadcasters and is configured 
in your Project settings.

In this exercise, you’ll monitor the integrated loudness display to ensure it comes within 
+/- 0.5 of the target -23 LUFS.

1	 At the bottom of the Loudness meters, click the Reset button to clear all current 
measurements.

2	 Move the playhead to the beginning of the scene.

3	 Under the Loudness meters, click the Start button to enable the analysis. 

4	 Press the Spacebar to play the timeline. Watch the integrated loudness display during 
playback to see how close to 0 on the loudness scale (-23 LUFS) your program measures.

The Loudness meter is a solid blue color that measures from -18 to +9, unlike decibel 
meters that show from -50 dbFS to 0 dbFS across their green, yellow, and red ranges. 
The Loudness meter is designed in this manner because -23 LUFS is equal to 0 on the 
Loudness meter scale. When you monitor levels with a Loudness meter, your goal is to 
keep the level near to 0. 

TIP  If you are delivering content for a region that requires an integrated 
loudness level other than -23, you can change the target loudness level in 
the Project Setting’s Fairlight options.

Although they analyze and measure audio differently, Loudness Units and Decibels 
have a 1-to-1 relationship which makes it easy to adjust faders when targeting the 
integrated loudness level. For instance, if the integrated loudness display shows +2 
LUFS after you play through your program, you can use the master fader to lower the 
decibels by -2 dB and reach the targeted 0 in the Integrated display.

5	 Raise or lower the master fader as necessary (a boost of about 1.5db should work here) 
to get the integrated level closest to 0 (-23 LUFS).

6	 Reset the meter, click Pause, and play the timeline again. 

Don’t worry if your levels aren’t perfect. Just be aware of the Loudness meters and the 
Integrated loudness goals before you finally output your project.

7	 Save your progress.
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NOTE  To listen to a version of this timeline completely mixed, feel free to open 
and play the 07 FINAL OUTPUT timeline. Do not alter this timeline because you will 
use it in the next lesson.

Lesson Review
8	 What steps do you need to perform in the Edit page to prepare your timeline for audio 

mixing in the Fairlight page?

a)	 Export your timeline as an XML file, and open this file in the Fairlight page.

b)	 Choose File > Send to Fairlight.

c)	 Click the Fairlight page button.

9	 Which Mixer control would you use to play one audio track from either the left speaker, 
the right speaker, or any surround speaker attached to your system?

a)	 Pan

b)	 Dynamics

c)	 EQ

10	 Which control would you use to make dialogue sound a little less bass-heavy?

a)	 Pan

b)	 Dynamics

c)	 EQ

11	 Where would you set up a set of submixes for your dialogue, effects, and music tracks?

a)	 Fairlight > Bus Format

b)	 Fairlight > Bus Assign

c)	 Fairlight Patch Input/Output

12	 How do you change the Target Loudness level from the default value of -23 LUFS?

a)	 You cannot change the Target Loudness level.

b)	 In Project settings

c)	 In User Preferences
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Answers
1	 c) Switch to the Fairlight page and continue working. You can switch between the 

Edit page and the Fairlight page at any time.

2	 a) The Pan controls.

3	 c) The EQ controls.

4	 a) Submixes and mains are setup in Fairlight > Bus Format. Individual tracks and 
submixes can then routed appropriately using Fairlight > Bus Assign, or by using 
the Main and Submix buttons in the Mixer.

5	 b) The Target Loudness level is set in the Audio Metering section of the Fairlight panel 
in Project settings.



Time

This lesson takes approximately 
30 minutes to complete.

Goals

Working with Subtitles	 316

Rendering Movies with Subtitles	 327
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Rendering and Editing Jobs 
from Multiple Projects	 331

Lesson Review	 333

When you’re ready to export a project—
whether at the end of a workflow, at an 
intermediate point, or when generating 
dailies—the render settings and final output 
are configured in the Deliver page of 
DaVinci Resolve.

The aim of this lesson is to shed some light 
on how to add, format, and include subtitles 
and audio submixes for your final output.

Lesson 10

Delivering Projects 
with Subtitles
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Working with Subtitles
DaVinci Resolve allows you to add subtitles to your timelines in several ways. You can 
manually create all your subtitles for your project, or you can import a supported subtitle 
.srt file. This lesson will use a new project for Lesson 10 but reuse the media from 
Lesson 09. You’ll import the new project and then relink to Lesson 09 media.

1	 In the Project Manager, right click in an empty area and choose Import Project. Then 
navigate to the lesson 10 Deliver folder and import the Lesson 10 Deliver.drp.

2	 With the new project open, right click over the Master bin and choose Relink Clips for 
Selected Bins.

3	 Navigate to the lesson 09 Audio folder and select the Media Files folder, then 
click open.

This project contains a finished version of the scene between the doctor and the FBI 
agents. Take a few minutes to reacquaint yourself with the scene and how the audio 
is mixed. All that’s left for you to do is add subtitles before outputting the final files 
for delivery.

4	 On the Edit page, open the Effects Library.
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5	 In the Effects Library, in the Titles group, locate the Subtitles section.

6	 Drag the Subtitle generator to the timeline in the space above the video tracks, and 
snap it to the beginning of the timeline.

A new track appears in the Timeline labelled “ST1 Subtitle 1,” and the subtitle text 
appears in the timeline viewer.

TIP  You can show and hide existing subtitle tracks in the Timeline View 
Options menu.
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7	 In the timeline, select the subtitle, and open the Inspector.

The Inspector includes the controls for the individual subtitle captions and for the entire 
subtitle track.

8	 In the Caption field, highlight the word “Subtitle,” and type Applause.

NOTE  Settings for the maximum number of characters per line and the 
minimum duration for each of your captions is set in the Subtitles panel of 
the Project Settings window.



319

W
o

rk
in

g
 w

it
h

 S
u

b
ti

tl
es

9	 Place the timeline playhead at the start of the second clip in the timeline, 
02_Dr_Sarah_Close Up.mov, and in the Inspector, click the Add New button.

A new subtitle is overwritten into the timeline at the current playhead position.

10	 Select the new Subtitle generator, and in the Inspector, type the dialogue from the 
doctor, “Oh, thank you. I’m so glad you really liked it.”

11	 Trim the end of the second Subtitle generator to the end of the second clip on V1, 
02_Dr_Sarah_Close Up.mov.

You can edit and trim Subtitle generators, just like any other clip on your timeline.

Importing Subtitle Files
You can continue working through this timeline, adding subtitles for the lines of dialogue. 
However, it’s usually much more efficient and accurate to have someone transcribe the 
dialogue for you, and create a .srt file that you can import directly into Resolve.
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1	 In the Media Pool, press Shift-Cmd-N (macOS) or Shift-Ctrl-N (Windows) to create a 
new bin. Change the name to Subtitles.

2	 Choose File > Import File > Import Subtitle.

3	 Navigate to R16 Editing Lessons > Lesson 10 Delivery, and select the file Lesson 10 
Subtitles US.srt.

4	 Click Open.

The .srt file is added to the selected bin as a subtitle clip.

5	 Select the subtitle file. Lesson 10 Subtitles US, and drag it into the timeline so it starts 
at the location of the red timeline marker.

All the subtitles in the .srt file are added to the Subtitle 1 track in the timeline.
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Adjusting Subtitles
Subtitles clips behave just like any clip in the Resolve timeline, so you can easily adjust 
their timings, as necessary.

1	 Type 1814 to navigate to the point before the doctor says, “That wouldn’t be possible.” 
Play the timeline from this point to review the dialogue and subtitles.

The subtitles appear onscreen too late for the doctor’s line of dialogue. You’ll need 
to adjust the subtitle timing to sync it correctly.

2	 Press T to enter trim edit mode.

3	 In the timeline, select the lower portion of subtitle, “That wouldn’t be possible,” so the 
mouse pointer changes to a slide icon.

4	 Slide the subtitle back to the left by about 17 frames, or until it snaps to the beginning 
of the doctor’s audio clip on A1.

5	 When you have finished sliding the subtitle into the correct position, press / (slash) 
to review the change.

6	 Press A to return to Selection mode.

You can also ripple and roll trim each of the subtitle generators, as well as cut each 
subtitle into shorter clips using the razor edit mode and keyboard shortcuts. Be aware that 
auto select controls for the subtitle track work the same as they do across all the other 
tracks in the timeline.
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Maintaining Subtitle Sync 
If you want to further ensure that your subtitles remain synced to the appropriate audio 
clips, you can link the clips. By doing so, if you inadvertently change the timeline and knock 
the subtitles out of sync, red clip sync indicator will show how far out of sync they are. 

1	 In the timeline, select the second subtitle clip with the text, “Oh thank you, I’m so glad 
you really liked it.”

It makes sense to link this subtitle with the audio clip on A1.

2	 Select the second subtitle clip, and in A1, Cmd-click (macOS) or Ctrl-click (Windows) 
the orange audio clip.

3	 With both clips selected, right-click either of them, and at the bottom of the shortcut menu, 
choose Link Clips, or press Opt-Cmd-L (macOS) or Alt-Ctrl-L (Windows) to link these clips.

You can also link multiple subtitles to multiple video and audio clips.

4	 In the timeline, select the next three subtitle clips along with the two yellow audio 
clips on A2.

5	 Press Opt-Cmd-L (macOS) or Alt-Ctrl-L (Windows) to link these clips.

These clips are now linked and will display the red out-of-sync indicators if they 
lose sync.
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Styling Subtitles
Just as with any other title generator in Resolve, subtitle generators have many parameters 
that you can change to adjust the style and position of your subtitles and closed captions. 
One common style applied to subtitles is a semi-transparent box behind the text to help it 
stand out against video with a similar brightness.

1	 Move your playhead over the last subtitle in your timeline.

The end of the line appears a little obscured against this final shot and isn’t easy to read.

2	 In the timeline, select the subtitle, and in the Inspector, click the Track Style tab.

3	 Scroll down to the Background options, and click the switch to enable the 
Background settings.
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4	 Adjust the Width and Height settings so that the box extends behind the white text and 
helps it stand out from the similarly light video background.

Because you have added this track style, all the subtitles in this track are updated with 
the change. This behavior is particularly useful when you need to modify style settings 
for all the subtitles in a track.

You can, however, override those track-wide settings for any individual subtitle when 
you need to adjust the color, font, or position of one or more subtitles, but not all.

5	 In the timeline, move the playhead to the first subtitle.

This subtitle indicates a sound effect rather than detailing spoken dialogue. As such, 
the director would like you to adjust it to appear a little more obvious.

6	 In the timeline, select the subtitle, and in the Inspector, select the Captions tab.

7	 Deselect Use Track Style.

A set of additional controls appear for this caption.
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8	 Change the “Font face” to Italic to distinguish this caption from the other captions. 
The subtitle updates to reflect the change in style.

Adding Additional Subtitle Tracks
You can add multiple subtitle tracks, which is particularly useful when you have to supply 
subtitles in more than one language.

1	 In the Edit page, right-click any one of the timeline track headers, and choose Add 
Subtitle Track.

An additional subtitle track is added to the timeline.
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2	 In the Media Pool’s Subtitles bin, right-click, and choose Import Subtitle.

3	 Navigate to R16 Editing Lessons > Lesson 10 Delivery, and select the Lesson 10 
Subtitles FR.webvtt file. Click Open.

4	 Edit this new subtitle file into the empty subtitle track you just created, starting at the 
beginning of the timeline.

This subtitle file includes French subtitles. You can rename subtitle tracks to reflect the 
language used, making it easier to identify the different tracks. 

NOTE  This subtitle has none of the styling included with the previous subtitle 
you worked with; however, because the WebVTT format has support for basic 
text formatting, the first subtitle is italicized.

5	 Double-click the Subtitle 1 track name, and type en_US to identify this subtitle as 
English for a US audience.
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6	 Double-click the Subtitle 2 track name, and type fr_FR to identify this subtitle as French 
for a French audience.

TIP  To choose the subtitle track visible in the timeline viewer, in the head of 
the track you wish to view, click the eye icon. You can display only one subtitle 
track at a time.

More Info
Depending on your workflow and delivery specifications, you may be required to use 
standardized two- or three-letter abbreviations for each language as dictated by the 
International Organization for Standardization. 

See the website at www.loc.gov/standards/iso639-2/php/code_list.php for more details.

Rendering Movies with Subtitles
When it comes to delivering subtitles with your finished program, a number of options are 
open to you. Depending on your delivery format, you can include subtitles as burned-in 
graphics, embedded text in a supported media file, or as a separate file.

In this next exercise, you will output a file suitable for web delivery together with the 
necessary separate subtitle files.

1	 On the Deliver page, in the Render Settings window, choose the custom preset, and 
set the render to single clip to export a single movie file.

2	 Set the Format pop-up menu to Quicktime and the Codec to H.264.

3	 Scroll to the bottom of the video tab, expand the option for Subtitle Settings, and 
choose to Export Subtitle.

4	 Set the Format options to “As a separate file”.

If you chose the “Burn into video” option, Resolve would burn the currently active 
subtitles (with their styles) into the final rendered video file, so the subtitles would be 
permanently included as part of the video content. Choosing “As embedded captions” 
will output the currently active subtitle track as an embedded metadata layer within 
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those media formats that support it. Currently, DaVinci Resolve has support for CEA-
608 and text captions within MXF OP1A and QuickTime containers.

5	 In the Export As pop-up menu, choose WebVTT and select both the “en_US” and 
“fr_FR” subtitle tracks to include them in the export.

6	 At the top of the render settings, click the Location Browse button, and navigate to R16 
Editing Lessons > Lesson 10 Delivery > Output folder to choose the destination for your 
exported content. Click ok.

7	 Click the File tab, enter the custom name SYNC SCENE STEREO, and in the “File 
subfolder” field, type Web.

This takes care of the video and file settings. Now, let’s look at to output different 
submixes and mains created in the Fairlight page.

Outputting Mains and Submixes 
If you are finishing your audio in the Fairlight page, your output is already set up using the 
main stereo bus, by default. In this project, you set up an LCR Main bus in Lesson 9. You 
also have a few sub mixes. You can use any main or submix created in the Fairlight page in 
the output from the Deliver page. Doing so makes it incredibly easy to export a final movie 
with stereo, surround, or an M&E mix for international dubbing. 
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1	 In the render settings, click the audio tab.

Let’s leave the default audio codec and bit rate settings as they are, but output 
different mixes.

2	 From the output track 1 pop-up menu, ensure that Stereo Main (Stereo) is selected.

3	 At the bottom of the render settings, click Add to Render Queue.

One of the benefits of using Fairlight to mix your audio, other than the fact somewhat 
format agnostic. So, you can mix audio content once and output it to several formats. 
For example, you could easily create another version of your movie that maintains 
dialogue, music, and effects as separate stems. 

TIP  Stems are typically stereo submixes of multiple individual tracks, such as 
all of your dialogue tracks or all of the sound effect tracks.

4	 Click the File tab.

5	 Change the custom name to Sync Scene with stems.

6	 Click the Audio tab, and in the output track 1 drop down menu, choose DIALOGUE (Mono).
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To include additional tracks or submixes in the final output movie, you can click a + 
(plus) button to the right of the output track menu and add additional tracks.

7	 Click the + (plus) button to the right of the Output Track 1 pop-up menu.

8	 From the Output Track 2 pop-up menu, choose FX (Stereo) 

9	 Click the + (plus) button to the right of the Output track 2 pop-up menu, and choose 
MUSIC (Stereo) for the Output track 3 menu.

10	 At the bottom of the render settings, click Add to Render Queue.

Two render jobs are loaded into the render queue. You can choose to render the two 
jobs, edit them to make changes to the movies, or switch to another project and later 
render all render queue jobs at once, regardless of which project you have open. 

Understanding Data Levels

In the Advanced Settings, Data Levels specifies the data range of an image based 
on its source. The default Auto setting renders media at a data level that is 
appropriate for the selected codec. Video refers to YCbCr formats that constrain to 
pixel data values between 64-940 on a 10-bit system in formats using a Rec.709 
video standard. Full expands the range to the film standard of 4-1024 values, which 
is utilized in digital film formats such as DPX. In general, the best choice is to leave 
this setting unchanged and let DaVinci Resolve choose the data level automatically. 
However, if you find that your final video looks substantially darker or lighter than it 
appears on your calibrated monitor, it is possible that the data levels are being 
incorrectly distributed. In that rare case, you may want to manually set the Data 
levels correctly for your intended distribution.
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Rendering and Editing Jobs 
from Multiple Projects
The Render Queue can show jobs from the current project or from all projects in your 
database. If you split longer projects into reels, or you are working on different projects for 
the same client, you might need to access all of the jobs in the queue instead of waiting for 
one batch to render before outputting other projects.

1	 Verify that the Deliver page is open.

2	 In the Render Queue options menu, choose Show All Projects.

Any jobs added to the Render Queue in any project currently in the database are 
displayed for you to select and render.

Even after you add jobs to the Render Queue, you can update their settings or 
remove them from the queue entirely.

3	 In the Render Queue options menu, choose Show Job Details.

The specific settings for each job are displayed, including resolutions, codec, 
and framerate.

4	 In the Render Queue, click the pencil icon on Job 1.
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The presence of additional Update Job and Cancel buttons at the bottom of the 
Render Settings indicates that a job is currently being edited.

Let’s make a small change to update the job

5	 In the Audio tab, change the output track to DCP (LCR). In the File tab, change the 
custom name to Sync Scene LCR.

6	 Click Update Job.

The change updates the original job settings with the new setting as is reflected in the 
displayed job details in the Render Queue. 

TIP  To delete a job, click the X in the upper-right corner of the job in the 
Render Queue.

7	 Finally, verify that neither of the jobs are selected in the Render Queue, and then click 
the Start Render button to create the output files.

Remote Rendering

DaVinci Resolve Studio allows you to offload rendering to another Resolve 
workstation. Remote rendering requires that all workstations have a copy of 
DaVinci Resolve 16 Studio installed, a shared Postgres database, and access to all 
necessary media files using the same file name path. With one computer acting as 
a render station, all other Resolve stations can continue to be used for further 
editing and grading.

Utilizing the correct render settings is vital to delivering an aesthetically correct and 
technically functional video project. Understanding these settings has even greater 
benefits. It elevates your skillset as an editor and imbues confidence that your 
projects are delivered at their optimal quality and adhere to industry standards.
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This book has covered a range of editing workflows and tools, while making frequent 
references to craft techniques. However, it is important to remember that even when 
following common guidelines within the craft, each editor has a high degree of leeway in 
the workflows he or she chooses. 

As with any technical and creative skill, editing takes practice and experimentation to 
master. In the early stages of your career, you will experience times of uncertainty and 
self-doubt when cutting a scene. So, it is important to utilize your tools wisely, and 
approach each editing challenge with the intention to produce the clearest possible story.

If you have done well with the review questions at the end of each chapter, take the online 
exam to get certified! To take the 1 hour online exam go to the blackmagic design web site: 
www.blackmagicdesign.com/products/davinciresolve/training

Lesson Review
1	 Depending on the format you choose, what options might you see when choosing to 

output subtitles with your final video file?

a)	 Burn into video

b)	 As embedded captions

c)	 As a separate file

2	 What are acceptable formats for importing subtitles?

a)	 SRT and WebVTT

b)	 Only English and French

c)	 Any RTF text document.

3	 True or False? You can adjust the settings of a job that’s already been submitted to the 
Render Queue.

4	 Where do you find the subtitle effect?

5	 True or False? You can access jobs submitted to the Render Queue from other projects 
in your database in the Project Manager?
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Answers
1	 a), b), and c) Subtitles can be output as burned in captions, as separate files, or as 

embedded captions (Text or CEA-608) for QuickTime or MXF OP1A containers.

2	 SRT and WebVTT

3	 True. Click the pencil icon for any job that’s currently in the Render Queue. You can 
then update the current settings in the Render Settings before clicking Update Job.

4	 In the title section of the effects library.

5	 False. To access jobs submitted to the Render Queue from different projects, click the 
Render Queue options menu, and choose Show All Projects.

Congratulations!
Congratulations! You just completed some some of the most advanced editing features in 
any non-linear editing software. Hopefully this book has opened your eyes to the powerful 
and incredibly useful editing, audio and effects tools in DaVinci Resolve. Now it’s time to 
see how well you retained the information. Try taking the free online proficiency exam. 
Follow the link to the DaVini Resolve training web page: https://www.blackmagicdesign​
.com/products/davinciresolve/training


